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Rozdziat 1 Przygotowanie "warsztatu pracy" 7

Po co ta ksiazka zostata napisana?

Bo zawsze chciatem stworzy¢é model samolotu w komputerze. A gdy juz to zrobitem — stwierdzitem, Ze to dobra
zabawa, i ze warto tym do$wiadczeniem podzieli¢ sie z innymi.

Dawno temu bytem zwyklym modelarzem i robitem redukcyjne modele samolotéw. To hobby dos¢ specyficzne.
Sleczymy miesigcami nad naszym dzietem, starajgc sie nanie$¢ na kawatek materiatlu malenkie nity, ztgcza
blach, czy drobne detale tablic przyrzagdoéw. Sgdze, ze postronnym obserwatorom zajecia wedkarzy wydadzg w
poréwnaniu z modelarzami mniej meczgce, cho¢ podobnie monotonne. W dodatku, zamiast tworzy¢ tadne,
btyszczace miniaturki, nanosimy na ich powierzchnie (o zgrozo!) zabrudzenia i przetarcia, jakie powstawaty
podczas intensywnego uzywania. Szpecimy je, aby wygladaty jak rzeczywiste, zuzyte i gdzieniegdzie pordze-
wiate maszyny. Catg naszg nagrodg jest pokazanie naszych dziet komus, kto potrafi doceni¢ ich finezje. Zdarza
sie to raz na jaki$ czas. Mowigc szczerze, dziwnym trafem sg to zazwyczaj inni modelarze. A moze ukrytg na-
grodg jest mozliwo$¢ nawigzania dyskusji na tak ezoteryczne tematy, jak wyzszos¢ Spitfire’a IX nad FW 190
A47? Albo palgca kwestia, jak byt pomalowany P-40, na ktérym Witold Urbanowicz latat nad Chinami w 1943r?

Ot6z chciatbym teraz zaoferowac¢ kolegom modelarzom (i nielicznych kolezankom — jako$ tak sie te proporcje
ukfadajg) zupetnie nowy materiat i narzedzia. Zamiast wtasnego, czasami nieco pobrudzonego aerografem
biurka — okno na inny Swiat, w gtebi ekranu.

Jest tu niezwykle plastyczny materiat, ktéry mozna "wyttacza¢" w dowolne powioki, bez obawy ze go zabraknie.
Sa tu farby, dla ktérych mozna doktadnie ustali¢ odcien i zasady naktadania. Jest tu mozliwa do osiggniecia
doktadnos¢, ktorej nie uzyskasz nigdzie indziej, ani w skali 1:24, ani w 1:18. Tu, gdy stwierdzisz, ze okapotowa-
nie silnika samolotu, ktéry zrobite$ rok temu, powinno miec¢ inny ksztatt, zawsze mozesz ten btgd poprawic. | to
nie raz! Tu nigdy Twéj model nie obrodnie kurzem. Nie bedziesz wystuchiwat narzekan domownikéw na to, ze
nie ma juz gdzie zmiesci¢ Twojej kolekcji. Mozesz tu powieli¢ swoje dzieto — chocéby po to, by odwzorowac je w
kilku réoznych wersjach malowania. | mozesz przesta¢ swéj model innym hobbystom, takim jak Ty, bez obawy ze
co$ sie z nim stanie podczas transportu. Z obiektéw, ktére w ten sposob stworzysz, mozna szybko budowac
cate sceny.

Jedyne, do czego trzeba sie przyzwyczaic, to to, ze niczego w tym $wiecie nie mozna dotkng¢. Mozesz tylko
patrzec, i tapaé¢ wszystko myszka. Przynajmniej na obecnym etapie rozwoju technologii, urzgdzenia dotykowe
(ang. haptic devices) sg nadal drogie i prymitywne. Nie ma co liczy¢, ze pojawig sie w sklepie za rogiem. Na
pocieszenie moge powiedzie¢, ze ich obecne modele pozwolityby Ci dotkngé wszystkiego tylko jedny m punk-
tem — koncoéwka takiego ,niby-dtugopisu”.

Ten $wiat wirtualnego modelarstwa stat niepostrzezenie dostepny. W istocie kazdy komputer, kupiony po 2005r,
to silna stacja graficzna, o ktérej w latach 90-tych mozna byto tylko pomarzy¢. Okoto 10 lat temu ,ruszyt z miej-
sca” nowy model matematyczny, stuzgcy do odwzorowania powierzchni. Mam na mysli powierzchnie podziato-
we (ang. subdivision surfaces). Pozwolity stworzy¢é Shreka i dziesigtki innych postaci z filméw animowanych za
pomoca komputera. Ten nowy model matematyczny skierowat do lamusa powierzchnie NURBS, wykorzystywa-
ne od lat 70-tych. Powierzchnie podziatowe pozwalajg fatwo uzyskiwaé naprawde ztozone ksztatty. W miare
dobrze radzg sobie ze zmorg NURBS — otworami i wycieciami.

Co wiecej — odpowiednie programy, ktére potrafig to wszystko wykorzystaé, staty sie dostepne za darmo! Stwo-
rzyly je dziesiagtki programistéw Open Source. Ludzie ci chcg pokazaé, ze sta¢ ich co najmniej na to samo, co
tworcow najlepszych programéw komercyjnych. | to zaczeto im sie udawac! By¢ moze, troche w tym zdrowej
ambicji (,ja to zrobie lepiej!”), oraz innego rytmu powstawania takich produktéw. Podczas pracy nad nimi nie ma,
typowego dla komercyjnych projektéw pospiechu, zwigzanego z napietymi terminami. (A pospiech rodzi btedy).
W efekcie pracy odpowiednio duzej grupy entuzjastéw powstaje dobry, stabilny program.

Copyright Witold Jaworski, 2009 - 2012.



8 Budowa modelu

Podsumowujgc — kupujgc do domu komputer do gier, kupite$ wszystko, co potrzeba do wejscia w Swiat wirtual-
nego modelarstwa. Nie bede oszukiwat, ze nie ma tu tego, co jest nieodtgczng cechg pracy kazdego modelarza:
wielotygodniowego wysitku. Mam jednak nadzieje, Zze ta ksigzka ufatwi Ci, drogi Czytelniku, jak najszybsze
osiggniecie pozadanych rezultatéw. Potem mozesz péjs¢ dalej i zrobi¢ to samo jeszcze lepiej, niz tu proponuije.
Przeczytanie dalszych stron, oszczedzi Ci duzo czasu i — niekiedy — frustracji. Ta ostatnia bywa nieodtgcznym
skfadnikiem pracy z ,tg glupig maszyng” — komputerem. Postaram sie nie zanudzaé i pokazywaé duzo obraz-
kéw, wiec mam nadzieje, ze "Wirtualne modelarstwo" Cie zainteresuje.

Witold Jaworski

Wirtualne modelarstwo — wersja 2.0 www.samoloty3d.pl



Rozdziat 1 Przygotowanie "warsztatu pracy" 9

Co zawiera ta publikacja?

»Wirtualne Modelarstwo” uczy ,od zera”, jak tworzy¢ takie modele samolotéw, jak pokazany na oktadce. Aby
szybciej udostepnia¢ Czytelnikom uaktualnione fragmenty tej ksigzki, zdecydowatem sie stworzy¢ i opublikowaé
wyciagi z jej tekstu, zwigzane z okre$long dziedzing. Sg to: ,Wyciag I: Przygotowania”, ,Wyciag Il: Modelowa-
nie”, ,Wyciag lll: Materialy i tekstury”, oraz ,Wyciag IV: Detale i renderowanie”. Przebieg pracy prezentuje na
przyktadzie modelu mysliwca Curtiss P-40B. Maszyna ta zawiera klasyczne rozwigzania, stosowane w wigk-
szosci samolotéw tego okresu. Z catym rozmystem nie wybratem Spitfire, Mustanga, Thunerbolta, Focke-Wulfa
czy Messerschmita. Nie chciatem zabiera¢ Ci przyjemnosci samodzielnego odwzorowania tych stynnych samo-
lotow.

e Mozesz tworzy¢ model kazdego mysliwca z okresu Il wojny éwiatowej1, czytajgc jednoczesnie kolejne
rozdziaty z tej ksigzki. To wcale nie musi by¢ P-40. Wszystkie te samoloty wykonuje sie podobnie. W trak-
cie tej pracy na pewno zetkniesz sie ze wszystkimi zagadnieniami, ktére sg tu opisane.

Ta ksigzka ma stuzyé zaréwno tym, ktérzy dopiero zaczynajg swojg przygode ,w 3D”, jak i tym, ktérzy majg juz
w tej dziedzinie pewne doswiadczenie. W zwigzku z tym zdecydowatem sie jg podzieli¢ na dwie czesci:
- czesc¢ pierwsza ("Budowa modelu”) to tekst podstawowy, ktéry koncentruje sie na tym, co trzeba zrobig¢;
- czes¢ druga ("Szczegodty obstugi programéw") to szczegotowe opisy, jak postuzyé sie odpowiednim
programem, by osiggna¢ efekt, pokazany w czesci pierwsze;.

Caty tekst ma duzo stron, z czego "Szczegdty obstugi programow"” zajmujg ok. 40%. Uktad tej czesci przypomi-
na tekst systemu pomocy (Help) do programu. To krétkie (na jedng lub dwie strony), nie zawierajgce wiecej niz
kilka ilustracji, opisy pojedynczych polecen.

Dzielgc materiat na cze$¢ podstawowsg i ,szczegétowq”, staratem sie unikngé niepotrzebnych, wydtuzajacych
niezmiernie tekst, wskazéwek w rodzaju "kliknij tu, a potem nacisnij tamto". W odpowiednich miejscach czesci
pierwszej umiescitem odnosniki do czeéci drugiej. Jezeli nie znasz programu, o ktérym akurat pisze, korzystaj z
tych odnosnikéw i czytaj umieszczone w nich informacje szczegétowe?. Przygotowatem je tak, abys nauczyt sie
postugiwa¢ wszystkimi narzedziami "od zera", w trakcie czytania gtéwnego tekstu. Gdy juz bedziesz wiedziat,
jak zrobi¢ to, co opisuje — po prostu przestaniesz do nich zaglgdaé.

Ksigzka zawiera jeszcze jedng cze$¢: "Dodatki". To materiaty, ktére mogg by¢ ciekawe dla co dociekliwszych
Czytelnikow. Tematyka "Dodatkéw" przypomina troche "groch z kapustg": od pewnych zagadnien optyki (defor-
macja obrazu na fotografii), do odwzorowania profili lotniczych. A oprécz tego: metody zaawansowanej weryfi-
kacja rysunkéw samolotu (na poziomie tworzenia planéw modelarskich), oraz szczegotowy opis wiasciwosci
powierzchni podziatowych. Nie musisz do ,Dodatkéw” zaglgdac¢, cho¢ sgdze, ze niektérzy moga w tych materia-
tach znalez¢ dla siebie co$ interesujgcego.

' No, moze tych z silnikami rzedowymi. Nie opisatem tu, jak modelowa¢ widoczne z zewnatrz elementy chtodzonych powietrzem silnikow
gwiazdowych — cylindry, popychacze, karter, przewody. Moze w kolejnym wydaniu ksigzki podjatbym sie modelu P-367?

% Zaktadam, ze korzystanie z czesci drugiej bedzie zawsze wyrywkowe. Stad wiekszo$¢ z zagadnien, ktére tam sie znajduja, jest omdéwione
bez dalszych odnosnikéw. Takie podejscie powoduje, ze np. opis skalowania w edytorze siatki Blendera jest niemal dostowng kopig opisu z
edytora obiektdw. Roznig sie tylko ilustracjami i paroma zdaniami. Po prostu nie wiem, ktory z tych tematéw otworzysz jako pierwszy, a w
kazdym chciatbym dostarczy¢ petng informacje.

Copyright Witold Jaworski, 2009 - 2012.




10 Budowa modelu

Konwencje zapisu

Wskazdéwki dotyczgce klawiatury i myszki opartem na zatozeniu, ze masz standardowe:

e klawiature — w normalnym ukfadzie amerykanskim, 102 klawisze (dodam takze pare uwag o kla-
wiaturze notebooka, bo sam na takiej pracuje);

e myszke — wyposazong w dwa przyciski i kotko przewijania (ktore daje sie takze naciskac: wtedy
dziata jak trzeci, srodkowy przycisk).

Wywotanie polecenia programu bede zaznaczat nastepujgco:

Menu 2>Polecenie - taki zapis oznacza wywofanie z menu ,Menu” polecenia ,Polecenie”. W przypadku
bardziej zagniezdZzonych menu moze wystapic¢ wiecej strzatek!
Panel:Przycisk - taki zapis oznacza nacisniecie w oknie dialogowym lub panelu "Panel" przycisku

.Przycisk”. Czasami moge takze w ten sposéb napisa¢ o przetgczniku lub liscie rozwi-
jalnej. ("Panel" to pojecie zwigzane z ekranem Blendera, wyjasnienia — patrz ,Wyciag
II: Modelowanie”)

Nacisniecie klawisza na klawiaturze:
-El - my$lnik pomiedzy znakami klawiszy oznacza jednoczesne naci$niecie obydwu klawi-

szy na klawiaturze. W tym przyktadzie trzymajgc wcisniety , naciskasz E;
El, - przecinek pomiedzy znakami klawiszy oznacza, Ze je naciskasz (i zwalniasz!) po kolei.

W tym przyktadzie najpierw [G], a potem [X] (tak, jak gdybys chciat napisa¢ wyraz ,gx").

Nacisniecie klawisza myszki:
- lewy przycisk myszy
- prawy przycisk myszy

- srodkowy przycisk myszy (nacisniete kotko przewijania)

HEEE

- kotko przewijania (petni te role, gdy jest obracane)

Na koniec — ,w kwestii formalnej”: jak mam sie do Ciebie zwraca¢? Zazwyczaj w poradnikach uzywa sie formy
bezosobowej (,teraz nalezy zrobi¢”). To jednak, méwigc szczerze, czyni czytany tekst mniej zrozumiatym. Aby ta
ksigzka byta jak najbardziej czytelna, zwracam sie do Czytelnika w krétkiej, drugiej osobie (,teraz zréb”). Cza-
sami uzywam takze osoby pierwszej (,teraz zrobitem”, ,teraz zrobimy”). Tak jest mi tatwiej. Podczas pracy nad
modelem traktowatem nas — czyli Ciebie, drogi Czytelniku, i siebie, piszacego te stowa — jako jeden zespot.
Moze troche wyimaginowany, ale w jaki$ sposob prawdziwy. Przeciez piszac te ksigzke ja takze wiele sie uczy-
tem, bo wiedziatem, ze kazde zagadnienie mam Ci porzgdnie przedstawic!

Wirtualne modelarstwo — wersja 2.0 www.samoloty3d.pl
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Jak czytaé te ksiazke?

Starajac sie, by ta publikacja elektroniczna byta bardziej czytelna niz typowe ,papierowe” poradniki, przeniostem
tu wiekszos¢ szczegotowych opiséw z gtdwnego tekstu do pozdozdziatéw. W ich miejscu pozostawitem odsyta-
cze (,linki”, takie same jak w stemach podpowiedzi czy stronach internetowych). Aby nie ,zasmiecac” tekstu nie
wyrozniatem specjalnie w tych miejsc kolorem lub podkresleniem. Mozesz je jednak rozpoznac¢ na podstawie
kontekstu (,por. str. ...”) a takze po zmianie ksztattu kursor myszki na ,wskazujgca dto’” (Rysunek 1.1.1):

Przyciski Previous/Next —
jak na stronie internetowej

EEX

File Edit Wiew Document Tools ‘Window Help

B & & e

E Struktura ksigzki: czesci,

rozdziaty, sekcje
g - " &

E Po co ta ksigzka zostata = 1 412 istr 1
"‘r napisana? 1 ul - poprawnie uloyly sie na modelu.
. (.13 przedstawia probny render ze zmisniona tekstura colarpng i uzupeiniong teksturg decals.png:

| Ustaw ,ciagte” wyswietlanie stron |

| ¥

. Powrot z
hiperteksto\‘vego
,skoku”
===
1

Rozdzizd 4 Teksturcwanie modeiu 195

[ cozawiera ta publikacja?

|ﬂ kKomwencje zapisu

K 1ak czytal te ksigzke?
= pudowa modelu

|[| Fozdziat 1.
Przygotoveanie
"warsztatu pracy”

— 6] Rozdziat 2. Kompaz

Zwrod uwage, Ze uzylem teraz inneg

41012 i str( 1%3? Rysunek 4.3.21)

5'_|,|f|weﬂ{i “ania '%p[aﬂm Wazne: hipertekstowe odsytacze.
Kursor myszki zmienia si¢ nad nimi

| T S we ,wskazujgca dion”. :

Rysunek 1.1.1 Czytanie ksigzki w przegladarce (Adobe Reader)

Gdy klikniesz w taki skrét, przejdziesz na strone, na ktérg odsyta Cie tekst. Aby powréci¢ w poprzednie miejsce
ksiazki, wykorzystaj przycisk Previous umieszczony u gory ekranu (Rysunek 1.1.1). Dziatajg tak samo, jak w
przegladarce internetowej. Aby podziat stron nie stanowit przeszkody w czytaniu, mozesz dodatkowo przetgczyé
wyswietlanie w tryb ,ciggty” (Rysunek 1.1.1). Wydaje mi sig, ze tak wygodniej jest czyta¢ ,online”.

Aby ten dokument PDF mozna bylo poprawnie odczyta¢ na ré6znych urzadzeniach, jest zapisany w standardzie
PDF/A. Jezeli przegladasz go za pomocg popularnego programu Adobe Acrobat, zwr6¢ uwage ze domysinie

wszystkie hipertekstowe odsytacze sg w nim wytgczone (Rysunek 1.1.2):

—

B Wirtualne modelarstwo (materiaty i tekstury) - Adobe Reader

Fle Edit Wew Document Tools ‘Window Help

BY G esFEime

la You are wiswing this docurment in PDF/A mode.

E Bookmarks
W tym trybie odsylacze sg nieaktywne!
“-b' + Kursor myszy ma ksztat pionowej kreski,
jak w edytorze tekstu.

E Po co ta ksigzka zostata
napisana?

[ cozawiera ta publikacja?

Zwrot uwage f£e uzylem teraz innego rozwiniecie UV powierzchni
4.10.12 i st Rysunek 4.3.21). To altenatywna mapa UV D
sylwetki ;aniofkow” poprawnie utozyly sie na modelu.

E kKomwencje zapisu
] 3ak czytac te ksigske?

Rysunek 1.1.2 Neaktywne odsytacze w trybie PDF/A (Adobe Reader)
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12 Budowa modelu

Aby uaktywni¢ hipertekstowe odsytacze w dokumencie PDF/A, musisz zmieni¢ pewien domysiny szczegot w
konfiguracji Adobe Acrobat (Rysunek 1.1.3):

W\-‘iew Docurent  Tools  ‘Window  Help

-k :| i Preferences
Cakegaries: Open Sektings
Documents 1 [CIRestare last view settings when reopening documents
Full Scree Cpen cross-document links in same window
General

Page Display Allow laver state to be set by user information

Allow documents to hide the menu bar, toolbars, and window co

3D & Multimedia

Documents in recently used lisk: |3 :

Accessibility
Select Al Chrl+a Acrohat.com
Dieseleck all Shift+-Chel+-a Farms 2. Wybierz
Identity kategorie
Check Spelling 4 International Documents s
Ink k
JI;\:Sn:ript [#] Automatically save document chd 3. Wylacz tryb wyswietla-
Find CHIAF Measuring (2D} N nia PDF/A, wybierajac tu
- Sawve As optimizes For Fast Web | Never:
Search . 73 Oftworz okno Measuring (3070
references Measuring (Geo) ’
POFEA A Miod
Search Resulks Multimedia (legacy) I8 View Mode *
| Preferences. .., g N CrlHE r:ulti;edia Trust {legacy) Yiew documents in PDFIA mode: -
=ading
Search

Rysunek 1.1.3 Uaktywnienie wewnetrznych odsytaczy dla dokumentéw PDF/A (Adobe Reader, wersja 9.0)

Z menu Edit otworz okno dialogowe Preferences. Z listy kategorii wybierz Documents. Spowoduje to pojawie-
nie sie po prawej stronie okna kontrolek, jak na ilustracji (Rysunek 1.1.3). Wytacz tryb PDF/A View Mode wybie-
rajac Never z jego listy rozwijalnej.

Kolejne wersje Adobe Acrobat mogg sie od siebie rozni¢. Na przyktad pasek narzedzi moze sie pojawic¢ u dotu
ekranu (jak to sie przydarzyto wersji 8.0). Co wiecej, w domys$inej konfiguracji przyciski Previous/Next, przydat-
ne podczas postugiwania sie odsytaczami, mogg by¢ ukryte (Rysunek 1.1.4):

- Czasami tu moze brakowac
B2 WM-HD. pdf (SECURED) - Adobe Reader, przyciskéw Previous/Next!

File Edit ‘iew Document Tools ‘Window Help

B S e
1. Kiknj [Z20] na

pasku narzedzi, by
otworzy¢ jego menu
kontekstowe

Lock Toolbars More Tools
\A Button Labels b =] Page Mavigation Toolbar

[I& First Page
Mate Toals... % HD [Z]4 Previous Page
[#]¥ Hext Pags

I LastPage
Page Mumnber

- - " 3. Wigcz widocznosé
2. Wybierz polecenie . Mext View [—| Previouas/Next View:
More Tools... ——— = :
1
I
1
IFiIe Edit Wiew Document Tools Window Help *
B 6 #$(=liqe e e
Przyciski sg widoczne Click to return to the previous page \riew|

Rysunek 1.1.4 Dodanie do paska narzedzi przyciskéw Previous/Next (Adobe Reader, wersja 9.0)

Cho¢ zawsze mozna uzy¢ skrotéw klawiszowych (Previous: -, Next: - ) , to jakos razniej jest miec
te przyciski ,pod reka”. Kliknij |:[ na pasku narzedzi, i z menu kontekstowego wywotaj polecenie More

Tools.... Znajdz i zaznacz w oknie More Tools polecenia Previous View i Next View (Rysunek 1.1.4).
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W tej ksigzce bardzo wazne s3 ilustracje — wypetniajg prawie kazdg strone. (Wtasciwie to mozna ten poradnik
okresli¢ jako ,potkomiks”). Niestety, takie obrazy istotnie zwiekszajg rozmiar pliku PDF. Aby nie byt zbyt duzy,
musiatem poddac ilustracje kompresji, ktéra pogarsza ich jakos¢. To, co widzisz, to wynik kompromisu pomie-
dzy rozmiarem publikacji a ostroscig detali obrazéw. W przypadku przegladarki Adobe Acrobat chciatbym za-
sugerowac przestawienie paru parametrow, ktére mogg poprawi¢ doktadnosé wyswietlania ilustracji. Nie sg to
ustawienia domys$ine, wiec powinienes je teraz zmieni¢ tak, jak pokazuje to Rysunek 1.1.5:

Cateqgaries: Defaulk Layout and Zoom

Documents Page Layout: | Automatic h Opcjonalnie:  przetgcz

Full Screen sig¢ na rozdzielczo$¢
Wybierz te General Feaalilin systemu
kategorie... Ml

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

30 & Multimedia Wybierz tu swdj typ

Accessibility Rendering / wyswietlacza

Acrobat.com

Forms Srmooth Text: | | For Laptop/LCD screens VT

Identity ¢ Ta opcja sprawdza sig dla wigkszo-
International [¥] Smocth line art [¥] smooth images Sai ilustracji. Jezeli jednak chciatbys

Inkernet

o zobaczy¢ obraz na okladce bez
v v
Javascript el use local fonts ElEnhance thin Ines drobnych ,pofalowan” krawedzi —
Measuring (200 Use page cache sprobuj j_a1 wyl_ac_zyé, i sam ocen, czy
Measuring (30} tak bedzie lepie;j...

Rysunek 1.1.5 Parametry programu Adobe Reader (wersji 9.0), odpowiednie dla ilustracji w tej ksiazce

Z listy kategorii okna Preferences wybierz Page Display. Spowoduje to pojawienie sie po prawej stronie okna
kontrolek, jak na ilustracji. W sekcji Resolution przetgcz sie na opcje Use system settings. (Domysinie jest
wybrana ta druga — a to moze pogarszac jako$¢ wyswietlania obrazéw. W razie czego nie przejmuj sie, jezeli
zobaczysz przy ustawieniach systemowych inng liczbe piks/cal niz ta, ktérg pokazuje Rysunek 1.1.5 — to zale-
zy od tego, jak sobie ustawite$ rozmiar tekstéw w systemie Windows).

Oprocz tego, mozesz zmienic¢ jeszcze dwa, mniegj istotne ustawienia. Pierwsze z nich to metoda wygtadzania
tekstu (lista rozwijalna Smooth Text) . Acrobat ma domysinie wybrany tryb Monitor. Zapewne uzywasz jakiegos
,cienkiego” ekranu LCD — wtedy warto jg zmieni¢ na For Laptop/LCD screens. | wreszcie przetgczniki
Smooth images i Enhance thin lines. W wiekszosci przypadkéw lepiej jest, gdy pozostang wigczone (usta-
wienie domysine). Jezeli jednak samolot na oktadce tej ksigzki ma lekko pofalowane krawedzie skrzydet, to
mozesz sprobowac wytgczy¢ wygtadzanie obrazéw. Sam ocen, czy bez tej opcji wyglada lepiej, czy nie.

* * *

Zawsze mozesz wydrukowac egzemplarz ,Wirtualnego modelarstwa” dla swoich potrzeb1. Mozesz go takze nie
drukowac i czyta¢ podczas pracy nad modelem wprost z ekranu. Oszczedzisz w tym przypadku troche papieru
— zawsze to o skrawek lasu wiecej. Co wiecej, mozesz wtedy korzystaé z hipertekstowych odsytaczy i widzie¢
ilustracje w petnym kolorze. Oczywiscie, jezeli wolisz czeste kartkowanie prawdziwego papieru — drukuj catosé.
Nawet jezeli Twoja drukarka obstuguje wydruk dwustronny, zuzyjesz catg ryze A4! Zapewniam, Ze nie byto to
moim celem ©.

' Nie chciatem w tej elektronicznej ksigzce rezygnowac z kolorowych ilustracji. W zwigzku z tym wiele z nich na wydruku wydaje sie by¢
mato kontrastowa. Aby temu w jakim$ stopniu zaradzi¢, na niektérych ilustracjach zmieniatem kolory odnosnikéw (na ciemniejsze lub ja-
$niejsze). Dzieki temu na wydruku sg w miare czytelne.

Copyright Witold Jaworski, 2009 - 2012.
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Budowa modelu

W tej czesci stworzymy model P-40B. Zaktadam, ze dla wielu Czytelnikow bedzie to wprowadzenie w Swiat
grafiki komputerowej. Nie znaczy to jednak, ze nasz samolot bedzie jaki$ uproszczony! (Choé, przyznam, gdy
zaczynatem pisanie tej ksigzki, chciatem pare zagadnieh poming¢). Wykonamy go ,w petnej wersji’: z chowa-
nym podwoziem i wiekszoscig detali kabiny pilota. W trakcie pracy postaram sie przekaza¢ Wam calg wiedze,
jaka do tej pory na ten temat zgromadzitem.
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Rozdziat 1. Przygotowanie "warsztatu pracy”

W tym rozdziale omoéwimy pokroétce instalacje oprogramowania, z ktérego bedziemy korzysta¢. Sa to:
- GIMP: pomocniczy, do edycji obrazéw rastrowych;
- Inkscape: pomocniczy, do edycji obrazéw wektorowych;

Wszystkie sg udostepniane w ramach licencji GPL. Oznacza to m.in., ze nie mozna pobiera¢ za nie zadnych
optat. (Oczywiscie, jezeli masz gest, a program Ci sie bardzo spodoba, mozesz wspoméc tworcow dotacjg —
ale na zasadzie zupetnej dobrowolnosci. Szczegdtowy opis, jak to zrobi¢, znajdziesz na stronie internetowej
kazdego z tych projektéw.)

Przypuszczam, ze wiekszos$¢ czytelnikdow tej ksigzki uzywa komputera z Windows. Podczas opisu instalacji
koncentruje sie wylgcznie na tym srodowisku. Sam go uzywam. Nie mam zadnych doswiadczen z Linuksem,
ani z Mac OS, wiec nie bede pisat o instalacjach, ktérych nie wykonatem. Jezeli uzywasz systemow innych niz
Windows — poszukaj wskazéwek na stronach tych programoéw (podam ich adresy w kolejnych sekcjach roz-
dziatu).

Nastepujagce pliki sg wazng czescig ksigzki:

- source.zip: zawiera skrypty Pythona, plany P-40B, udostepnione przez producenta fragmenty rysun-
kow technicznych (P-40E), i inne pomocnicze materiaty;

e Pobierz powyzsze pliki ze strony: http://[samoloty3d.pl/wm2_p.xml. Utrzymuje tam ich aktualne wersje1.

Rozpakuj wszystkiepobrane pliki *.zip do tego samego folderu. W trakcie ich rozpakowania stworzg odpowied-
nie podkatalogi (pliki nie wymienione powyzej nlezg do innych czesci tej publikaciji):

i < Rozpakuj wszystkie pobrane pliki
CI mOJ_foIder - w tym folderze. Stworzy to odpo-
wiednie podkatalogi:
CI model
CI —] Ia5 ””””””” < | Zawartosé pliku fa5.zip

| < |Zawartoéé pliku p40.zip |

[gaI=s--EEIEEEmIIIEEEs Zawartos$¢ plikow textures1.zip i
1C| textures & textures2.zip
CI optional ! <—|Zawartoéé pliku optional.zip |
1C| source | ——— |Zawartoéé pliku source.zip |

! Oprocz tego bede tam umieszczat odpowiedzi na najczestsze pytania od Czytelnikow tej ksigzki, tak jak sie bedg pojawia¢ po jej opubli-
kowaniu

Copyright Witold Jaworski, 2009 - 2012.
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1.1 Instalacja GIMP

Aby zainstalowa¢ GIMP, zajrzyj na strone tego projektu — http://www.gimp.org. W chwili, gdy pisze ten rozdziat,
plik do pobrania jest dostepny pod adresem: http.//www.gimp.org/downloads (Rysunek 1.1 .1)1:

GNU Image Manipulation Program

TMake a Donation |

h,
Pobierz stad plik

nd above

Rysunek 1.1.1 Strona, z ktérej mozna pobraé¢ program instalacyjny GIMP

Jak wynika z opisu, GIMP jest programem Open Source w kazdym calu: wymaga, by uzytkownik sam pobrat
zrodto programu i je skompilowal! Na szczescie znalazta sie dobra dusza (Jernej Simoncic), ktéra to zrobita za
nas. W dodatku spakowata to wszystko w plik instalacyjny Windows. A twércy Gimpa, niby tego oficjalnie nie
popieraja, ale umiescili na tej stronie poreczny skrot...

Proces instalacji Gimpa nie zawiera zadnych "haczykow". Wystarczy, ze bedziesz naciskat wszystkie przyciski
domysine. Gdybys$ miat jakie$ watpliwosci — szczegdtowy opis instalaciji znajdziesz na str. 48.

Podczas pracy nad tg ksigzkg uzywatem GIMP v. 2.66.

! Wersje 2.66, ktérej uzywatem, mozesz takze znalez¢ pod http://www.samoloty3d.pl/downloads/wm/install/gimp/gimp-2.6.6-i686-setup.exe.
Znajdziesz tam takze pliki pomocy (po angielsku): http.//www.samoloty3d.pl/downloads/wm/install/gimp/gimp-help-2.2-eng-setup.exe

Wirtualne modelarstwo — wersja 2.0 www.samoloty3d.pl
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1.2 Instalacja Inkscape

Zajrzyj na strone projektu Inkscape — http://www.inkscape.org (Rysunek 1.2.1)":

Q INKSCAPE  brawFreely  sitosearch |

General Latest stable version: 0.46 ¥ Download Now!
Dorwenioad /
Clip Art . B

Pobierz stad plik

Documeritation

Tools

Screenshats

Shawease

Articles

Tutorials

Galleries
Community

Digcussion

Maiing Lists

Forums

Planet Inkscape

Wik

Report Bugs

Recuest Features
Developers

Project Summary

Documeritation

Roadmap

Write & specification

Send a patch

SWh

Rysunek 1.2.1 Strona projektu Inkscape

Plik instalacyjny jest bezposrednio dostepny z gtéwnej strony projektu.
Podczas instalacji Inkscape wystarczy, gdy bedziesz naciskat wszystkie przyciski domysine. Gdybys$ miat jakie$
watpliwosci — szczegodtowy opis instalacji znajdziesz na str. 80.

W tej ksigzce uzywatem Inkscape w wersji 0.47

! Wersje instalacyjng Inkscape 0.47 znajdziesz takze na http://www.samoloty3d.pl/downloads/wm/install/inkscape/Inkscape-0.47-3.exe
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Rozdziat 2. Przygotowanie rysunkow samolotu

W tym rozdziale przedstawie metode przygotowania rysunkéw samolotu, ktére wykorzystamy jako wzorzec w
Blenderze. Zrobie to tu na przyktadzie mysliwca P-40, ale tok postepowania jest taki sam dla kazdego innego
samolotu. W tym rozdziale bede sie postugiwat wytgcznie GIMP. Przy okazji mozesz sie tu nauczy¢ podstaw
jego obstugi.

Model cyfrowy powstaje na podstawie rysunkéw wzorcowych — rzutu z boku, goéry, dotu, przodu, ewentualnie
takze z tylu. Rysunki takie musza by¢ doktadne. Inaczej tylko utrudnig nam pracef.
Na szczescie mamy w Polsce co najmniej dwa dobre plany modelarskie P-40, opracowane przez dwoch roz-
nych autoréw:
- Jacka Jackiewicza — rysunki opublikowane w monografii "Curtiss P-40", wydanej w latach 2000-2001
przez AJ Press, w ramach serii "Monografie lotnicze" (zeszyty nr 64, 65, 66);
- Mariusza tukasika — rysunki opublikowane w monografii "Curtiss P-40", wydanej w latach 2008-2009
przez Kagero, w ramach serii "Monografie" (zeszyty nr 36, 40)

Jezeli chcesz samodzielnie wykona¢ model P-40, gorgco polecam zakup co najmniej jednej z podanych powy-
zej publikacji. W materiatach zataczonych do tej ksigzki nie ma rysunkéw (bytoby to naruszenie praw ich auto-
réw). Rysunki to zresztg nie wszystko - podczas pracy nieodzowne sg takze bliskie zdjecia roznych czesci sa-
molotu. Takie fotografie znajdziesz w Internecie, sg takze publikowane w specjalnych wydawnictwach dla mode-
larzy, nazywanych po angielsku "walk around". Na przyktad, na potrzeby tej pracy kupitem zeszyt "Kittyhawk
I/IA", wydawnictwa Model Detail Photo Monograph (zeszyt nr 14). Zawiera ponad 100 fotografii i szkicow frag-
mentéw P-40E. Wiasciwie im bardziej szczegétowy zamierzasz zbudowa¢ model, tym wiecej takich materiatow
powiniene$ zgromadzi¢. Na pewno sie przydadza!

Wréémy jednak do naszych rysunkow: nalezy je zamieni¢ na obrazy komputerowe, wiec muszg by¢ zeskano-
wane. W sumie jest to jedyny moment, gdy potrzebujesz skorzysta¢ ze skanera. Nie stosuj jakichs wysokich
rozdzielczosci - obraz zeskanowany w trybie 300x300 dpi jest zupetnie dobry.

Przy okazji przygotowywania rysunkow, bede sie starat doktadnie zweryfikowa¢ poprawnos¢ ksztattu samolotu.
Moze i czasami bedziemy co$ upraszczag, ale to uproszczenie ma polegaé na rezygnacji z jakiegos szczegétu.
Stad nie ma tu miejsca na jaka$ "taryfe ulgowa". Sam sie przekonasz, ile i jakiego rodzaju btedéw potrafig za-
wiera¢ nawet szczegotowe plany.

W tym rozdziale pokaze podstawowy proces przygotowania rysunkéw. Trzeba je wyprostowac, sprawdzi¢ po-
prawnos¢ proporcji i zapisa¢ w plikach o ujednoliconych wymiarach. Uzyjemy do tego Gimpa. Po zapoznaniu
sie z tymi sekcjami bedziesz w stanie sam przygotowaé zestaw rysunkow, ktérych uzyjesz w Blenderze.

Jezeli chciatby$ dowiedzie¢ sie, jak mozna doktadniej zweryfikowaé plany? — polecam Rozdziat 5
("Szczegotowa weryfikacja plandw samolotu”, str. 105). Poréwnuje tam rysunek, jaki przygotowalismy, z frag-
mentami rysunkéw fabrycznych P-40, a takze ze zdjeciami. Korekty ksztattu nanosze w Inkscape. Tam osta-
tecznie mozesz sprawdzié, na ile nasze rysunki nie ktamig! Metody, ktére stosuje, mogg by¢ wykorzystane na-
wet do opracowywania nowych planéw modelarskich.

! Gdy ptat na rysunku z goéry wypada w innym miejscu kadtuba niz na rysunku z boku - zaczyna sie problem. Podobnie, gdy na planach
statecznik lewy ma nieco inny obrys niz statecznik prawy. | ktéry jest poprawny? Takie btedy do$¢ czesto sg popetniane, nawet na planach
modelarskich. Myli¢ sig jest rzeczg ludzka, a nie darmo stare powiedzeniem kreslarzy brzmi: "papier zniesie wszystko".

2 Gratuluje — to cecha prawdziwego modelarza!
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21 Przygotowanie rzutu z lewej

Rysunki po zeskanowaniu nie nadajg sie do natychmiastowego uzycia. Zazwyczaj sg mniej lub bardziej znie-
ksztatcone - na przykiad osie samolotu nie sg idealnie poziome lub pionowe. Mogg im sie takze przytrafi¢ pro-
blemy z wzajemng prostopadtoscig. Takie rzeczy trzeba sprawdzi¢ i skorygowaé. Stworzymy w ten sposéb ich
poprawione wersje - kazdy rzut w oddzielnym pliku. Najtatwiej jest to zrobi¢ w Gimpie. (Jezeli zupetnie nie
znasz tego programu — patrz "Wprowadzenie", str. 51).

Wczytaj do Gimpa jeden z zeskanowanych arkuszy, zawierajgcy rzut z boku (szczegéty — str. 55). Zazwyczaj
najlepiej jest uzy¢é w tym celu jednego z gtéwnych arkuszy planéw. Raczej nie korzystaj z zestawienia r6znych
wersji samolotu. (Na rysunkach robionych metodg tradycyjng — w tuszu — zestawienie sylwetek wers;ji jest
zawsze narysowane mniej starannie.) W tym konkretnym przypadku — publikacji AJ-Press — byt z tym pro-
blem. Rzut z lewej znajduje sie w niej poblizu szwu zeszytu. W takim miejscu podczas skanowania kartka jest
nieco wygieta, i rzut z boku wychodzit zdeformowany. Nie chciatem rozcinac¢ stron, i w ten sposéb niszczyé mo-
jego egzemplarza monografii. Przyjrzatem sie wiec doktadnie innym arkuszom planéw. Na rysunkach Jacka
Jackiewicza zestawienie wersji samolotu wydawato sie tak samo doktadne, jak gléwny rzut. Zdecydowatem sie
wiec z nich skorzystac, bo byty najmniej znieksztatcone przez wygiecie strony.

Rysunek 2.1.1 pokazuje, jak w Gimpie moze wyglada¢ materiat "wejsciowy" — zeskanowany arkusz planow
modelarskich.

"Surowy", zeskanowany
arkusz planéw modelarskich

Clh
o

o o o e
|

"Wyciety"  fragment
obrazu, z pojedyncza
sylwetkg

o —
SN (o o S 5 File Edit Select Wiew Image Laper Colors Tools Dialogs — Filkers

= — Sl etk
e ©y 0y oy ooy o,

R R} N

Lo Yo} N

px v 13% Backgroundl P W 13% ~ [Background (26,7 MB)

Rysunek 2.1.1 Wyciecie z planéw modelarskich pojedynczego rzutu z lewej (w GIMP)

Wytnij z tego obrazu fragment, zawierajacy pojedynczy rzut z boku (szczegdty — patrz str. 56).
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Teraz sprawdzimy, czy rysunek nie jest obrécony ani przekoszony. Umiesc¢ linie pomocnicze (guides: szczegoty
— patrz str. 59) na kluczowych liniach konstrukcyjnych, o ktérych wiesz, ze powinny by¢ pionowe lub poziome
(Rysunek 2.1.2):

-y -|Linie pomocnicze
~l_"11i _E: —(guides) — uzywane
do poréwnan

Cyrtiss Tomahawk Il A P

wiersja rozpgznawcea, w kadiubie kdmera — | '\\‘

4 o ognisfowej 356 mm, maszt apieny ..: = ! —T e L
T _—..=—-='74 T L@ o8 =7 = E——
H j —— | ! — 'S

L
i s S o
1 i ]
- e = -
—

-

"Dhugi szew" : ; \

Zapewne zapytacie, skad wiem, ktére fgczenia blach na kadtubie P-40 byty pionowe lub poziome. No céz, nie
ma na to precyzyjnej odpowiedzi. Zacznijmy od poziomych. Na kazdym rysunku i wielu zdjeciach wida¢ na ka-
diubie dlugi "szew", ciggnacy sie od ogona do okapotowania silnika (Rysunek 2.1.2). Jego linia przebiega odro-
bine ponizej osi Smigta. W opisie technicznym samolotu mozna wyczyta¢, ze kadtub P-40 byt sktadany z dwdéch
potéwek: gornej i dolnej. Co wiecej, na zachowanych zdjeciach z odbudowy pewnego nowozelandzkiego P-40N
widaé, ze granica podziatu biegnie wtasnie wzdiluz tego szwu. Wydaje sie to tym bardziej prawdopodobne, ze
blachy w P-40 byly tgczone "na zaktadke". Krawedz dolnej potowki kadtuba — ta niewidoczna, schowana "pod
zaktadka" — znajduje sie jakies 2 cm powyzej szwu. Wyglada na to, ze lezy na osi $migta. To prawdopodobnie
slad po oryginalnej osi samolotu, jaka wystepowata na jego rysunkach konstrukcyjnych. Linie pionowe, ktére
sprawdzam — sg to po prostu linie gtéwnych wreg. Krawedz steru kierunku — zaktadam, Ze jest prostopadta do
osi, bo na takg wyglada. (Zazwyczaj technolodzy, gdy robig juz co$ ukosnego, to jest to pochylone o jaki$ zna-
czacy kat, a nie o utamek stopnia).

Rysunek 2.1.2 Przyktadowe rozmieszczenie linii pomocniczych

W duzym pomniejszeniu szwy na rysunku zdajg sie doskonale przylega¢ do linii pomocniczych. Czy tak jest
jednak na pewno? Trzeba to sprawdzi¢ w wigkszym zblizeniu. (Zmiana widoku w GIMP — patrz str. 60.) Przej-
rzyj rysunek fragment po fragmencie, w powiekszeniu. W strefie silnika i wokét kabiny wszystkie linie wydajg sie
by¢ w porzadku. (Nie wida¢ odchylen narysowanych linii szwéw od linii pomocniczych). Klopot zaczyna sie na
ogonie (Rysunek 2.1.3). Linia gtdwnego szwu, biegngca poziomo przez caty kadtub, w tym obszarze wyraznie
jest zagieta w doét. Nie jest to duze odchylenie, ale wykracza poza tolerancje "zamiany linii na piksele", dokony-
wanej przez skaner. Co wiecej, linia szwu biegngcego powyzej jest odchylona w podobny sposéb.

Kat zaklinowania
usterzenia poziomego
“|— + 2° Zgodne z
opisem konstrukcji

=

Odchylenia linii szwéw
od poziomu w cze$CifT ———1__
ogonowej - deforma-| 3
cja? —

““H [|Linia nitéw, biegnaca tuz powyzej,
nie jest znieksztatcona!

Rysunek 2.1.3 Szczegétowe sprawdzanie réwnolegtosci linii rysunku - odchylenia na ogonie
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To mogtoby wskazywaé na deformacje rysunku w tylnej czesci, wywotang np. nieznacznym wygieciem strony
podczas skanowania. W takim jednak przypadku wszystkie linie w tym obszarze bytyby zdeformowane w ten
sam sposob. A tak nie jest. Natozytem dodatkowsg linie pomocniczg na rzad nitéw, biegngcych tuz powyzej jed-
nej ze zdeformowanych linii. Nie ma odchylen! Zmierzytem kat zaklinowania statecznika poziomego — zgodnie
z opisem technicznym samolotu powinien wynosi¢ +2° — i tak jest! Wiec co o tym sgdzi¢?

Przyjrzyjmy sie doktadniej. Rysunek Jacka Jackiewicza, ktéry tu analizujemy, wyglada na wykonywany metodg
tradycyjng. (Kreslony najpierw otéwkiem, potem — poprzez kalke — tuszem.) Sadze tak, gdyz poszczegdlne
linie wydajg sie by¢ odrobine nieréwne. Takie odstepy pomiedzy kropkami nitéw sg rézne w réznych miejscach1.
Wyglada na to, ze odchylenia, znalezione na tym rysunku to drobna pomyitka, wynikajgca z recznego wykona-
nia. Wida¢ linijjka podczas kreslenia zostata przytozona odrobine nieréwno do kalki. Pozostaje tylko pamietacé,
podczas korzystania z rysunku, ze na ogonie dwie linie sg narysowane z drobnym btedem.

No dobrze, rzut z boku jest juz przyciety i sprawdzony. Korekty w postaci drobnego obrotu nie potrzebuje, bo
odpowiednie linie sg poziome i pionowe. Teraz pozostaje usungé¢ z niego niepotrzebne resztki innych sylwetek,
a potem zapisac na dysk jako oddzielny plik.

Do usuniecia z rysunku pozostatosci innych sylwetek uzyj "gumki" (Rysunek 2.1.4, szczegoty — str. 68):

|D||||||||||25Q||||||||5plp||||||||?5Q||||||||1Dq0||||||||12$0||||||||15q0||||||||1?$D||||||||2plp0|"||||||2250||||||

Curtiss Tomahawk Il A
wersja rozpoznaweza, w kadhubie kamera
F 24 o ogniskowej 336 mm,maszt anteny

Y

e ___________| "Gumka" (Eraser) —| : s Ll 0 N

usuwa z obrazu niepo- S~ :

trzebne elementy

X W 33% W ICIick to erase (try Shift for a straight line, Ctrl bo pick a background color)
Rysunek 2.1.4 Wymazywanie z rysunku niepotrzebnych elementow

Gdy oczyscimy obraz z "naleciatosci" - czas go zapisa¢ do oddzielnego pliku (szczegoty - patrz str. 56). Propo-
nuje nada¢ obrazowi nazwe sktadajgca sie z:

- krétkiego oznaczenia typu,

- inicjalow autora (bo bedziemy korzysta¢ z obydwu),

- nazwy rzutu ("Left", "Top", "Bottom", "Right", "Front", "Back").

Proponuje takze nada¢ mu rozszerzenie .tif. (GIMP wybiera format zapisu na podstawie rozszerzenia nazwy
pliku — ".tif" oznacza zapis w popularnym formacie TIFF).

Ostatecznie przygotowany plik bedzie nosit nazwe: P40B-JJ-Letft.tif. Bedzie tak nazywany w catej ksigzce. Przy-
znam, Ze uproscitem nieco oznaczenie tego samolotu. Scisle rzecz biorgc, to sylwetka Curtiss Tomahawk [1A
dostosowanego do celéw rozpoznania. (Posiada kamere w luku kadtuba i dodatkowg antene.) W istocie jednak
ten typ (oznaczenie fabryczne Hawk 81-A2) byt eksportowg wersjg P-40B, produkowanych réwnolegle dla
USAAC. Antene i kamere podczas tworzenia modelu P-40B zignoruje, i wszystko bedzie w porzadku.

! Poréwnaj go z rysunkiem Mariusza tukasika, ktéry - dam sobie reke ucig¢ - byt robiony na komputerze. Inaczej nie miatby tylu identycz-
nych "powtarzalnych" szczegotow, jak nity.
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Budowa modelu

Podsumowanie

Przygotowanie zestawu rysunkéw, potrzebnych do stworzenia modelu, zawsze zaczynaj od rzutu z lewej.
Ten rzut jest najczesciej najdok’fadniejszy1. Staraj sie unika¢ pobierania rzutu z lewej z mniej waznych
fragmentow plandw, np. zestawienia réznych wersji samolotu (str. 19).

Kazdy rzut kadrujemy z zeskanowanego arkusza planéw modelarskich do oddzielnego pliku (str. 19). (Za-
zwyczaj kazdy arkusz planéw zawiera wiecej niz jeden rzut).

Sprawdzamy, czy uzyskany obraz nie ma deformacji (str. 20). (Gdyby byty, nalezatoby je skorygowaé -
patrz nastepna sekcja tego rozdziatu).

Usuwamy niepotrzebne fragmenty obrazu (zazwyczaj resztki innych rysunkéw — str. 21).

Gotowy rysunek zapisujemy na dysk pod nowg nazwg. Warto tu przyjac¢ jakas zasade nazewnictwa —
utatwi nam to p6zniej prace (str. 21).

" Wynika to stad, ze najwiecej zdje¢ samolotéw to zdjecia poziome - z boku lub z przodu. Zresztg wielu kreslarzy czesto zupetnie odrucho-
wo zaczyna tworzenie rysunku wiasnie od rzutu z lewej. Uzywa pdzniej tej sylwetki jako odniesienia przy rysowaniu pozostatych rzutow
samolotu
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2.2 Przygotowanie rzutu z prawej

Przygotujmy teraz - w podobny sposaéb jak rzut z lewej - rysunek prawej strony. Zazwyczaj wybieram na ten rzut
jakas wersje z otwartym podwoziem. Podobnie jak rzut z lewej, odpowiednio jg kadrujemy (Rysunek 2.2.1):

B P40-0rg-RB.1if-5.0 (indexed, 1 layer) 2480x3437 [= |[B][X]

== *P40-0rg-RB.1if-5.0 (indexed, 1 layer) 2480x864 [= |[T][X]
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Rysunek 2.2.1 Wykadrowanie rzutu z prawej

Teraz powinnidmy rysunek obrdci¢, aby ustawi¢ sylwetke poziomo. Wczesniej dodaj poziomg linie pomochnicza.
Ustaw jg tak, by przechodzita przez czubek kotpaka $migta (Rysunek 2.2.2). (W tym punkcie umiescimy os$ ob-

rotu):

== *P4()-org-RB.tif-5.0 (indexed, 1 layer) 2480x864

File Edit 3Zelect Wiew Image Layer Colors Tools  Dialogs  Filters
o) frepoy, o oy oy OO oy PO, | 2200, ! ! | {2300, ! ! ! 2400, s
M ~
w tym miejscu
umieszcze o$ obrotu
rysunku
|| v
e 4 3|
|px v ” 150% HBackground (32,3 MEB)

Rysunek 2.2.2 Umieszczenie poziomej linii odniesienia
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24 Budowa modelu

Trzeba jeszcze zwiekszy¢ rozmiar obrazu w kierunku pionowym o jakies 70%, aby zmiescit sie w nim "wypro-
stowany" (obrotem) rzut z boku (szczegoty — str.61). Inaczej statecznik pionowy znajdzie sie poza rysunkiem.

Przygotowania do obrotu zakoriczone - linia pomocnicza jest na miejscu, rozmiar obrazu odpowiednio powiek-
szony. Rozpocznij obrét. Zacznij od przesuniecia srodka tam, gdzie linia pomocnicza przecina kotpak smigta

(Rysunek 2.2.3 — szczegoty str. 75):

| doorgRBAL50 (ndeced. 1 tayer) 20068 g
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Rysunek 2.2.3 Sylwetka samolotu przed obrotem

Podczas obracania staraj sie doprowadzi¢ do sytuacji, gdy lina pomocnicza bedzie

réwnolegta do gtéwnego

szwu kadtuba (Rysunek 2.2.4). Wartos¢, przy ktérej to osiagnelismy — 13.43° — jest niemal idealnie zgodna z

rysunkami gabarytowymi Curtiss (13.30°).
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Rysunek 2.2.4 Sylwetka samolotu po obrocie

Po zatwierdzeniu obrotu przyjrzyjmy sie kluczowym liniom rzut z prawej i podobnym liniom na opracowanym
poprzednio rzucie z lewej (Rysunek 2.1.2).Sprawdz uwaznie o$ kadtuba. W widoku z lewej strony o$ biegnie od
czubka kotpaka smigta, ale niemal dotyka gtéwnego szwu kadtuba. A na naszym rzucie (Rysunek 2.2.4), jest od
niego zdecydowanie odsunieta. Wyglada na to, ze widok z prawej ma wyzej podniesiony nos samolotu!
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Popatrzmy uwazniej na ten obszar (Rysunek 2.2.5):

=2 *P40-org-RB.tif-5.0 (indexed, 1 layer) 24B80x1300
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Rysunek 2.2.5 Znieksztatcenie nosa samolotu (rzut z prawej)

Tym razem to nie jest btad autora — wyglada na to, ze przéd samolotu jest wygiety do goéry. Przyczyng byto
najprawdopodobniej wygiecie w tym miejscu strony podczas skanowania. (Ten fragment byt niedaleko od szwu
zeszytu monografii, takie wygiecia moga sie zdarzyc¢.)

W sumie - nie wiadomo, czy rysunek nie zawiera innych, mniej rzucajgcych sie w oczy réznic. Najlepiej bytoby
natozy¢ na siebie obydwa rzuty - z prawej i lewej, i sprawdzi¢, gdzie ich linie sie "rozjezdzajg". (Takie natozenie
to bardzo wymagajacy test dla rysunkow kreslonych recznie. Cztowiek praktycznie nie jest w stanie narysowac
w sposoéb identyczny dwdch tak ztozonych ksztattéw).

GIMP umozliwia taka operacje. Dodamy rzut z lewej jako oddzielng warstwe rysunku. Nastepnie zwiekszymy
przejrzystosc¢ tej warstwy, by wida¢ byto jednoczesnie linie obydwu sylwetek.

Aby poréwna¢ rysunek z rzutem z lewej, wykonaj lustrzane odbicie aktualnego obrazu
(Image>Transform2>Filp Horizontally). (Nie martw sie, na koniec wykonamy je znowu, aby powr6ci¢ "na
wiasciwg strone").

Teraz wczytaj plik P40B-JJ-Left.tif jako nowg warstwe (File->Open as Layers), i zwieksz jej przejrzystosc
(szczegoty — str. 62). Rysunek 2.2.6 pokazuje, jak takie ztozenie moze poczatkowo wygladac:

== *P40B-JJ Right. tif-23.0 (grayscale, 2 layers) 2480x1300 =(E3
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Rysunek 2.2.6 Efekt wiaczenia przejrzystosci na gérnej warstwie obrazu
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Warstwa z wczytanym rzutem z lewej nazywa sie tak jak plik — P40B-JJ-Left.tif. Nasun jg na rysunek przeswi-
tujgcy "spod spodu” (szczegoty — str. 76). Podczas dopasowywania potozenia rzutéw najwiekszg uwage zwra-
caj na takie linie charakterystyczne, jak gtdwne szwy oraz krawedzie steréw. (Wszystko to, co jest narysowane
prostymi liniami i wyznacza wazne miejsca konstrukcyjne.) Pamietaj, ze na rysunkach kreslonych recznie rézni-
ce moga wystgpi¢ na wszelkich krzywiznach. (Na przyktad — obrysy kadtuba lub steru kierunku moga sie réz-
ni¢.) Nat6éz na siebie sylwetki tak, aby w tym samym miejscu byt sie gtéwny szew kadtuba, oraz ostatnia wrega.
Przyjrzyjmy sie rezultatom. Wyglada na to, ze srodek kadtuba jest narysowany na obydwu sylwetkach dokfadnie
tak samo. Roéznice pojawity sie z przodu (Rysunek 2.2.7) i na ogonie (Rysunek 2.2.8).

B *P40B-1J-Right.tif-23.0 (grayscale, 2 layers) 2480x1300
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Rysunek 2.2.8 Poréwnanie dwéch sylwetek z tych samych planéw - czes¢ tylna

Widoczne sg wyrazne odchylenia ksztattu statecznika i steru kierunku. Sadze, ze jest to przekoszenie. (Linie
zeber i inne linie, ktére powinny by¢ poziome, sg poziome. Linie pionowe za to sg pochylone. A to swiadczy o
tym, ze nie jest to obrot).
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i 5 . . . . . .
+ .:”E E By ! Nim zaczniemy korygowa¢ znalezione réznice, musimy
LpEE @ zmieni¢ kolejnos¢ warstw. W zakfadce sterujgcej war-
de: | . .
el m VA| stwami (okno przybornika — Rysunek 2.2.9):
Opacity: - *
Lock: [ .

1. Wigcz petng nieprzejrzysto$¢ warstwy P40B-
JJ-Left (Opacity na 100%);
2. Przesun na liscie warstwe Background tak, by

2. Zmien jej Opacity

1. Przesun warstwe ze 100 na 50. znalazta sie u samej gory;
Background w gore. ., . . L, . ,
F - jm v (8] 3. Zmien nieprzejrzystos¢ warstwy Background
(Opacity na 50%);

Rysunek 2.2.9 Zmiana kolejnosci warstw i ich "przejrzystosci”

Zaczniemy od skorygowania przekoszania ogona. Ustaw linie pomocniczg tak, by wyznaczata prawidtowe poto-
zenie koncowej krawedzi kadtuba (Rysunek 2.2.10). (Jest to jednoczes$nie miejsce, gdzie zaczyna sie ster kie-
runku). To nasz wzér, na ktérym bedziemy sprawdzac, czy krawedz steru stafa sie juz pionowa.

Zaznacz na rysunku prostokatny obszar (szczegéty — str. 68). Te deformacje poprawimy takze przekoszeniem
(Tools 2>Transform Tools ?Shear — szczegoty na str. 77), tylko w drugg strone.

File Edit Select Wew Image Layer Colors Tools Dialogs  Filkers

Bj. | I I |1 ?Dpu | I |1$w| | I |1$Dp| | I I |2DDp| L Ll |21Dp| | I |22Dp| | I |2$Dp| | I I |240p| Ll |q'
] el £ e

] ; Linia pomocnicza - |

g ' pionowa. I

7] ; « l :

o] ; ' !

! - ‘{ o

LS L. 1

1 I i i

1  |Obszar, zaznaczony / E !

I do deformacii : !

\ : i

Te dwie linie majg sig 1

. |

[__ sta¢ réwnolegte !

|

|
r |

|

L b

] N | |

ey e | I

: |- 1 | i

] \ﬁ Niewielki  przeko- - | i

1% [ “|szenie najlepiej E | !

B ¥ zmienia¢é w polu . i

iy numerycznym ! !

| |

: : i

. Shear 1 e ! {

" Background-55 (P4@R-1)-Right ki) / |

= |

Shear magnituds & | ~ Dolna granica zaznaczenia biegnie| !
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Help ] [ Reset ] [ Shear l [ Cancel ]

Rysunek 2.2.10 Prostowanie (przez przekoszenie) obszaru usterzenia

Zwro¢ uwage na wybor deformowanego obszaru (Rysunek 2.2.10). Linie pionowe sg w tej transformacji podda-
ne niewielkiemu obrotowi. Pionowe granice zaznaczonego obszaru poprowadzitem wiec przez kadtub tam,
gdzie przecinajg same poziome tgczenia blach kadtuba. Z kolei linie poziome ulegng tylko przesunieciu. Popro-
wadzitem je wiec wzdtuz linii szwu na kadtubie. W ten sposob przesuniecie tych pikseli nie zepsuje zbytnio ry-
sunku.
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Rysunek 2.2.11 przedstawia uzyskany efekt — uzgodniony obrys usterzenia pionowego.

|

Rysunek 2.2.11 Obrys statecznika po korekcie

Przy takich transformacjach, dokonywanych na obrazach rastrowych, zawsze wystgpig efekty uboczne. W oknie
gtébwnym zmien nieprzejrzysto$¢ aktualnej warstwy z powrotem na 100. Teraz zobaczymy, co nam na rysunku
sie popsuto (Rysunek 2.2.12):

Przesunigte do \
przodu trzy linie nitow AT

.|Przesunieta do dotu
linia szwu

Zanikt  $lad  po
najnizszym zebrze

Wygieta krawedz
kadtuba

O

Rysunek 2.2.12 Niedoktadnosci, o ktorych trzeba pamieta¢ (aby ich nie przeniesé na model)

Przygladajgc sie efektom, z ulgg mozna stwierdzi¢, ze defekty sg stosunkowo niewielkie (Rysunek 2.2.12):

przesunely sie trzy linie nitéw (ale, dzieki pozostatosciom u dotu, wida¢ gdzie by¢ powinny),

fragment gtéwnego szwu kadtuba jest odrobine przesuniety do dotu (ale widac¢, gdzie powinna przebie-
gac);

tylna krawedz kadtuba jest lekko wykrzywiona;

zanika najnizsze zebro steru kierunku.

Moglibysmy jeszcze raz uzy¢ narzedzi Gimpa, aby poprawi¢ te bledy. Naszym ostatecznym celem nie jest jed-
nak naprawa planéw P-40. Korygujemy rysunki tylko w takim zakresie, by wystarczyly do stworzenia jak najdo-
ktadniejszego modelu. Najwazniejszg rzecza jest zgodnos¢ ksztattu. W przypadku drobnych nieprawidtowosci w
liniach nitéw lub szwéw wystarczy pamietac, ze ten obraz byt w tym miejscu poprawiany. Podczas modelowania
zignorujemy te roéznice, traktujgc rzut z lewej jako wzér.
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Otwartg sprawg pozostaje kwestia, skad wzieta sie ta poprawiona deformacja. Przypuszczam, ze moze by¢
efektem odksztafcenia podczas druku. Inng mozliwoscig jest pomytka autora planéw. W kazdym razie takie
réznice pozwalajg nam oceni¢ granice mozliwego btedu przygotowywanych rysunkow.
Do prostowania przodu samolotu uzyjemy obrotu (Rysunek 2.2.13):

Rysunek 2.2.13 Prostowanie przodu samolotu

Ve Bl*: Rotate
{ f :ﬁ\ ! 7 Rackground-55 (P40B-11-Right ) | Stosunkowo  niewielki
[ al | 4 . _0) §°
.\ K_ y Angle: ||-D.SD ﬁ kat: -0.5
\\ --q—‘j/J S j
R — :

Obracany obszar jest'_ i

nieregularny — .

prostokgt tu  nie[~"=

pasowat T
\:,

Cerker #: 964,00 =

-~|Srodek  obrotu -
wybierz go starannie!

Center ¥: |9?6.DD |¢| e - |

(o |

Reset ] [ Rotate l I Cancel

Zwr6¢ uwage, ze linie fgczen blach pod skrzydtem sg zgodne, a kabiny, potozonej ponad nimi - nie. Tego obsza-
ru nie mozna "wybrac¢ prostokgtem®”. Zastosuj inng metode selekcji — dowolnym obrysem (szczegoty — str. 72).
Wazne jest takze takie dobranie punktu obrotu, aby wiatrochron kabiny nie unidst sie do géry. Jednoczesnie
linie taczenia blach przed wiatrochronem powinny przesunac sie do przodu. Rysunek 2.2.13 pokazuje potozenie
osi obrotu, dla ktérej efekt koncowy wydaje sie catkiem zadowalajgcy (por. Rysunek 2.2.14 - z Rysunek 2.2.7,

str. 26):

[=T=T=2
ol

Rysunek 2.2.14 Wyprostowany nos samolotu (obydwie sylwetki sa na siebie nalozone)
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W wyniku obrotu nosa obydwie sylwetki niemal idealnie sie pokryty (Rysunek 2.2.15). Jedynie celownik przed
kabing jest odrobine wyzej. Wtasciwie tylko po réznicy w pozycji odsunietej owiewki mozna poznaé, ze sg tu
natozone na siebie dwa rysunki. Niemal udato sie unikng¢ "ubocznych" deformaciji:

‘| To taczenie blach jest

:7/ T

i /,.} ml —|lekko odchylone od
i T /-
| T .
: ' T T
i | ~
i [ /ﬁ 1 &;&@-‘gﬂ'—’? -
| To taczenie blach jest a\ //
| lekko odchylone od .
l pionu S //
i Y 1
S~ LA
1 ‘_'_'_'_pﬁ—_

Rysunek 2.2.15 Niedoktadnosci, pozostate po wyprostowaniu nosa samolotu

Koncéwki $migta lezg (w zakresie akceptowalnej tolerancji) na tej samej linii pionowej. Wiekszos$¢ tgczen blach
przyjeta poprawne potozenia, za wyjatkiem dwéch (Rysunek 2.2.15). (Bedzie trzeba o nich pamietac).

Gotowy obraz przerzu¢ z powrotem w poziomie w przeciwng strone (Image >Transform >Filp Horizontally).

Na koniec usun warstwe z rzutem z lewej (szczegoty — str. 67) — nie bedziemy jej wiecej uzywac. Oczys¢ ry-
sunek z niepotrzebnych linii (str. 68) i zapisz pod nazwg P40B-JJ-Right.tif.

Podsumowanie
o W tej sekcji poznates typowe techniki wykrywania deformacji
- najpierw poréwnuj rysunek z liniami pomocniczymi (str. 25);
- potem poréwnaj z rzutem z przeciwnej strony (str. 26);
e  Gdy wykrylismy deformacje, korygowalismy je za pomocg réznych transformacji:
- obrotu (pamietaj, wazne jest potozenie srodka tej transformaciji! — str. 25);
- przekoszenia (shear — str. 27);
- przesuniecia;
- zmiany skali w jednym kierunku (zobaczysz w nastepnej sekcji);
e Podczas korygowania uzywaj linii pomocniczych, ktére pozwolg Ci w trakcie transformacji na biezaco
sprawdzac, czy osiggnates juz cel (str. 27).
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23 Przygotowanie rzutu z gory

W sylwetkach bocznych samolotu, ktére do tej pory opracowalismy, koncentrowaliSmy przede wszystkim na
odchyleniach od osi poziomej. To dlatego, ze wysokos$¢ rzutu z boku jest o wiele mniejsza od jego dtugosci.
Pewne deformacje wzdtuz osi Y, nawet jezeli istniejg, powodujg odchylenia mieszczace sie w granicach toleran-
Cji.

Zupetnie inaczej jest z rzutem z gory lub z dotu. Tutaj wazne sg obydwa kierunki, i kazdy z nich musi by¢ sta-
rannie sprawdzony. Pokaze to na przyktadzie przygotowywania rzutu z goéry z rysunkow Jacka Jackiewicza.

B P40-0rg L T.1if-3.0 (indexed, 1 layer) 2480x3437 [= |(T3)(] [ B *P40-0rg L T.1if-3.0 (indexed, 1 layer) 3437x2480 [=1[E3]
File Edit Select View Image Laver Colors Tools Dialogs  Filkers File Edit 3elect View Image Layer Colors Tools Dialogs  Filkers

_EI'I By ey oy 10O, (909, | @ o PR L1 S NN -1 S WP < 1 ST =
1]

] —/ |Srodek obrotu
4 PR q 3 q ¥ i umiescitem na
czubku kotpaka
Smigta
S

S _ S
1*&_ =l .LIJ’[JA“.I

Py

[=T=T=T%
|

[=T=T=TN
|

[=Y=T=Ta'
|

R

& i +

px W 13% W [Background (60.7 ME) px W 13% W [Background (77.5 ME)

Rysunek 2.3.1 "Wyprostowanie" rzutu z goéry, poprzez obroét catego arkusza

Rysunek 2.3.1 ilustruje przeksztatcenia, jakim nalezy podda¢ obraz po zatadowaniu:
- obroc¢ obraz o 90° (Image 2 Transform 2Rotate 90° counter-clockwise) ;
- dodaj pionowa linii pomocniczej. Umies¢ jg tak, by przechodzita przez czubek kotpaka $migta. (To dla-
tego, ze punkt ten lezy mniej wiecej w srodku rysunku, w poblizu gornej krawedzi);
- obro¢ caty obraz (Tools 2 Transform Tools 2Rotate), tak, by o$ kadtuba znalazta sie doktadnie pod linig
pomocnicza.

Po tym wstepnym "wyprostowaniu" nalezy sprawdzi¢, czy skrzydta nie sg przekoszone. (Od tej pory wszelkie
btedy obrazu bedziemy poprawiali transformacjg Shear w kierunku réwnolegtym do osi samolotu. Przyczyna jest
prosta - wszystkie linie rownolegte do osi wzdtuznej sg juz wyprostowane. Dalsze obroty mogtyby tylko cos po-
psuc).
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Zweryfikujmy, czy konce krawedzi ptata lezg w tym samym miejscu (Rysunek 2.3.2):
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Rysunek 2.3.2 Sprawdzanie deformacji ptata

Natéz na rysunek kilka poziomych linii pomocniczych, umieszczajgc je w punktach charakterystycznych lewej
koncéwki ptata. Gdyby skrzydta nie byty zdeformowane, linie powinny przej$¢ przez analogiczne punkty na pra-

wej koncowce. Tak sie jednak nie dzieje - widaé wyrazng réznice (Rysunek 2.3.2).

Skoryguj przekoszenie w kierunku osi Y (Tool>Transform Tools >Shear). Nie zaznaczaj zadnego obszaru, by
deformowany byt caty obraz. (Taka deformacja dotyczy zazwyczaj catego zeskanowanego arkusza.) GIMP sam
ustala srodek (punkt neutralny) transformacji - jest to srodek obrazu, a wiec punkt w poblizu osi podiuznej ka-
diuba. W przypadku, jaki pokazuje Rysunek 2.3.2, konieczne sie stato skorygowanie przekoszenia w kierunku
osi Y o -19 pikseli (przy rozmiarach obrazu rzedu 2400 x 2900 px).
Teraz pfat jest juz poprawny. Przy przegladaniu rysunku znajdujemy kolejng deformacje —statecznika poziome-
go (Rysunek 2.3.3):

Statecznik pionowy
byt skrecony o 2° -
to jest poprawne

p :

Usterzenie
poziome jest
przekoszone o te
réznice

Rysunek 2.3.3 Kolejny problem - wykrzywiony statecznik poziomy

Wyglada na to, ze po wyprostowaniu skrzydta powiekszyta sie deformacja usterzenia poziomego. (Stato sie

jeszcze bardziej przekoszone). Przynajmniej kadtub i skrzydto mamy juz wyprostowane.
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Tym razem musimy topoprawi¢, ograniczajgc transformacje do obszaru usterzenia. Jak pokazuje Rysunek
2.3.4, zrobitem to obszarem prostokatnym (szczegoty — str. 68):
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Rysunek 2.3.4 Prostowanie statecznika poziomego

Przy wiasciwym doborze obszaru deformaciji, mozliwe jest, w tym przypadku, unikniecie "popsucia” innych linii
na planach (Rysunek 2.3.5):

Poziomg krawedz obszaru
prowadze tam, gdzie nie ma
zadnej innej linii poziome;j

Pozostate deformacje
sg minimalne

Krawedz  statecznika ..
zostata wyprostowana "

Rysunek 2.3.5 Wyprostowane usterzenie poziome

Pomijam w tej sekcji nastepny sprawdzian - poréwnanie sylwetek rzutu z goéry z rzutem z dotu. Nalezy je po-
réownac w ten sam sposob (poprzez natozenie), w jaki porownywalisSmy rzuty z lewej i z prawej (str. 25). W tym
przypadku trudniej jest mi poradzi¢, ktory rzut jest wazniejszy. Gdy znajdziesz réznice — pozostaje poréwnanie
ze zdjeciami, aby okresli¢ kidra wersja jest blizsza rzeczywistosci. Osobiscie traktuje rzut z gory jako "wazniej-

szy".
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Na koniec pozostaje sprawdzi¢, czy rysunek ma wiasciwe proporcje. Chodzi o prostg sprawe: stosunek dtugosci
i rozpietosci powinien by¢ taki sam, jak w rzeczywistym samolocie.

Znalaziem w Internecie (http://www.p40warhawk.com) oryginalne rysunki gabarytowe P-40B/C, zaakceptowane
przez USAAC w kwietniu 1939 (Rysunek 2.3.6). Zostaty opublikowane (odtajnione) przez firme Curtiss w 1941,
ponad dwa lata po oblocie prototypu. Nie oszatamiajg doktadnoscig linii, ale zawierajg rzecz cenna: kilka dodat-
kowych wymiaréw poza rozpietoscig i dlugoscig. Zwymiarowano na nich np. trapez skrzydta (poprzez podanie
cieciwy u nasady, na koncu, i kata pochylenia krawedzi natarcia). Podano takze rozpietos¢ usterzenia poziome-
go. Wymiary, naniesione w sposoéb tak jednoznaczny przez producenta — to dobre narzedzie weryfikaciji.

§'AcT.

15"

Rysunek 2.3.6 Gabaryty P-40B/C — w stopach i calach (Curtiss, 1941)
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Zmierzmy dtugos¢ i rozpieto$¢ rysunku, uzywajgc pikseli jako jednostki. GIMP wyswietla aktualne wspétrzedne
kursora w lewym dolnym narozniku ekranu (Rysunek 2.3.7):
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Rysunek 2.3.7 Odczytywanie wspotrzednych poczatku kadtuba

Wystarczy ustawi¢ kursor myszki na poczatku kadtuba, i odczyta¢ wspétrzedng Y aktualnej pozycji. Podobnie —
ustawiajgc kursor — mozna odczyta¢ pozostate trzy wymiary, potrzebne do okreslenia diugosci i rozpietosci
rysunku. Tabela 2.3.1 pokazuje wyniki pomiaru:

Wymiar Poczatek (px) Koniec (px) Réznica (px)
Kadtub Y: 124 Y: 2476 2352
Ptat X: 328 X: 3126 2798

Tabela 2.3.1 Zmierzone wymiary rysunku (piksele — px)

Zgodnie z fabrycznymi rysunkami gabarytowymi , P-40B miat dlugos¢ 967 cm (31 stép i 8 %16 cala). Rozpietos¢
wynosita - 1137 cm (37 stop i 3 '/, cala). Daje to stosunek dtugosci do rozpietosci = 967 / 1137 = 0.85048. Jezeli
zmierzona rozpietosc¢ rysunku to 2798 px (Tabela 2.3.1), to dtugos¢ powinna wynosi¢ 2798 px * 0.85048 = 2379

pX.

Rézni sie to od wartosci zmierzonej - 2352 px. Wynikatoby z tego, ze kadtub w rzucie z géry jest za krotki o 27
pikseli. Czy na pewno? Réwnie dobrze mozna przyjg¢, ze dtugosé rysunku Jacka Jackiewicza jest poprawna, a
rozpietos¢ wymaga matego "$Scisniecia" (o 2798 - (2352 / 0.85048) = 32 piksele).

Zatézmy, ze dlugosé kadtuba jest poprawna. Daje to skale 2.43 pikseli / cal. Stosujgc te wartos¢, mozna okresli¢
inne wymiary, ktére warto sprawdzic:
- cieciwa najwiekszego zebra skrzydta (lezy w osi kadtuba) powinna mierzy¢ na rysunku 667 pikseli (wg
planéw Curtissa miata doktadnie 9 stop, czyli 108 cali);
- rozpietos¢ usterzenia poziomego powinna wynosi¢ na rysunku 949 pikseli (wg planéw Curtissa wynosi-
ta 12 stop i 9 °/s cala).

Przedtuzmy na planach Jacka Jackiewicza linie krawedzi natarcia i krawedz sptywu skrzydta (Rysunek 2.3.8).
Ich przeciecie z osig kadtuba wyznacza poczatek i koniec "zebra kadtubowego". Ten odcinek powinien miec
dtugosé¢ 667 pikseli, a ma 676 — o0 9 za duzo. Wyglada wiec na to, ze ptat jest za duzy w stosunku do kadtuba.
(Ma wieksze obydwa podstawowe wymiary: cieciwe i rozpietosé).

Podobnie za duza jest rozpietos¢ statecznika poziomego. Powinna wynosi¢ 949 pikseli, a wynosi 960 — o 11
pikseli za duzo (Rysunek 2.3.8).
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Rysunek 2.3.8 Roznice pomiedzy planami a rzeczywistymi wymiarami samolotu.

W ktérym kierunku skorygowac rysunek? Aby to ostatecznie rozstrzygnaé, sprawdzmy, jak pasuje rzut z lewej
do widoku kadtuba z goéry. Czy dtugosci poszczegodlnych elementéw sie zgadzajg? Przygotujmy rysunek do
poréwnania:
- dokonaj konwersji obrazu na odcienie szaro$ci (o ile nie zrobite§ tego wczesniej):
Image >Mode >Grayscale;
- obroc rysunek o 90° w lewo: Image 2> Transform >Rotate 90° counter-clockwise;

Zataduj jako nowg warstwe plik P40B-JJ-Left.tif (File >Open as Layers) . W przyborniku, w zakfadce Layers,
zmniejsz nieprzejrzystos¢ (Opacity) warstwy P-40-JJ-Left.tif ze 100 na 50;

Na koniec sprébuj nasung¢ rzut z lewej na kadtub rzutu z géry. Zréb to tak, aby linie kotpaka $migta jak najlepiej
sie pokryly (Rysunek 2.3.9):
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———————————————

"

Rysunek 2.3.9 Ztozenie — kadtub, rzutu z lewej i rzutu z gory
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Na pierwszy rzut oka wyglada to jak plgtanina linii. Jednak w zblizeniu na obydwu rzutach dostrzezesz wspdine
punkty charakterystyczne. Dlugos$¢ kadtuba na obu rysunkach jest idealnie zgodna. Obrys kotpaka - réwniez.
Nie mozna znalez¢ wiekszej réznicy w pozycjach poszczegdinych linii w okolicach usterzenia. (Krawedzie ste-
réw sg w tym samym miejscu).

Za to srodek kadtuba - tu mamy réznice! (Rysunek 2.3.10) KrawedzZ natarcia skrzydta w rzucie z gory jest prze-
sunieta do przodu o 12 pikseli. (W stosunku do krawedzi natarcia w rzucie z boku.) Z kolei caty obszar kabiny,
zaczynajac od przedniej krawedzi skrzydta, wydaje sie by¢ przesuniety do tytu o 4-5 pikseli.

Tymi liniami pomocniczymi oznaczytem porow-
nywane miejsca w rzucie z boku

Obszar kadtuba, ktory w rzucie z
gory jest przesunigty do tytu

il
L

Potozenie
zgodne

:
(

Krawedz

natarcia

zZa

daleko do przodu (cate
skrzydto jest o 1.5% za

duze)

f

Rysunek 2.3.10 Réznice w potozeniu szczego6téow kadtuba i skrzydta

Zatézmy (cos trzeba zatozy¢), ze rzut z lewej jest poprawny1. Bedziemy go traktowac jako wzér. W tej sytuaciji
wyglada na to, ze nalezy dokonac jeszcze nastepujacych poprawek:

1. przeskalowac¢ caty rysunek wzdiuz osi Y, aby zmniejszy¢ rozpietos¢ ptata o 32 piksele (i — proporcjo-
nalnie — usterzenia poziomego);

2. "$cisng¢" skrzydto, wraz z fragmentem kadtuba, o 9 pikseli wzdtuz osi X. (Krawedz sptywu pozostaje,
mniej wiecej, w dotychczasowym miejscu). W ten sposoéb ptat ulegnie proporcjonalnemu (przynajmniej
w przyblizeniu) zmniejszeniu.2

3. rozciggng¢ sam kadtub w kierunku osi X, od statecznika pionowego do okapotowaniu silnika. Przy oka-
potowaniu silnika powinna nastgpi¢ najwieksza deformacja — o 5 pikseli do przodu;

' Mimo pozoréw nie podejmuje tej decyzji zupetnie "w ciemno". W chwili, gdy to pisze, wykonatem juz poréwnania sylwetki bocznej ze zdje-
ciami (patrz "Szczegétowa weryfikacja planéw samolotu”, str. 105). Poréwnania rzutu z boku wyszty zadowalajgco, w odréznieniu od po-
réwnan rzutu z géry. Stad wiem, Zze na rzucie z lewej moge polegac.

2 Swiadomie zgadzam sig, ze obszar srodku kadtuba zostanie wraz ze skrzydtem "Scisniety". To jeszcze bardziej oddali jego szczegoty od
poprawnych pozycji, zgodnych z rzutem z boku. Wynika to z obserwacji deformacji kadtuba, ktérg chce wyprostowa¢ w kroku 3. Najwigksze
réznice w kierunku osi X wystepuja za kabing pilota, a przy zblizaniu sie do okapotowania silnika nieco maleja. Gdy najpierw, wraz ze
skrzydtem, "Scisne" fragment od silnika do konca kabiny, a potem "rozciggne" fragment kadtuba od usterzenia do silnika, to uzgodnie je z
rzutem z boku. Gdyby deformacja kadtuba byta inna, musiatbym poprawia¢ to innymi transformacjami.
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Nim wykonamy krok 1, przytnij obraz tak, by zawierat wytgcznie rzut z gory (szczegoty — str. 58). Zréb to tak, by

jego krawedzie — gérna i dolna — byly jak najblizej koncowek skrzydet.

Bl 1= e

Przygotowujac rysunek do poprawek,

Layer->Stack >Reverse Layer Order.

Nastepnie, zaktadce Layer:

Layers
Mode: |N0rmal v |
Opacity: - 0 =008
Lock:  [] .

.Background
@ @ P4DB-JJ-LeFt.tiF

(D) « (e )(®]) ¢« (8]

Rysunek 2.3.11 Przygotowane warstwy

(Szczegoty zarzadzania warstwami znajdziesz na str. 62.) Rysunek 2.3.11 pokazuje, jak powinno wygladac
utozenie warstw przed dalszymi transformacjami. Zwré¢é uwage, aby podswietlona (aktywna) byta warstwa

Background.

Teraz wykonaj pierwszy z zaplanowanych krokéw: zmniejsz rozmiaru catosci wzdtuz osi Y (rozpieto$¢) o 32
piksele (szczegoty — str. 78). Przeksztat¢ w ten sposob catg aktywng warstwe (tzn. nie zaznaczaj wczesniej

zadnego obszaru).

Nastepnie wykonamy krok drugi: "scisniecie" obszaru skrzydfa, wraz z kadtubem, o 9 pikseli. Obramuj skrzydto

zmien nieprzejrzystos¢ (Opacity) warstwy P40B-JJ-Left.tif na

100 (kompletnie nieprzejrzysta).

zmien nieprzejrzystos¢ (Opacity) warstwy Background ze 100

na 75;

zmien kolejnos¢ warstw:

prostokatnym obszarem selekcji (Rysunek 2.3.12), a nastepnie wybierz znéw polecenie zmiany skali.
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Rysunek 2.3.12 "Sci$niecie" skrzydta w kierunku X
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Po zakonczeniu zmiany skali znéw nalezy - podobnie jak poprzednim razem - odrobine przesung¢ przeskalo-
wany obszar. Tym razem trzeba dosung¢ go do tytu. (Gdy wpisujesz nowy rozmiar w pola Width lub Height,
Srodkiem skalowania jest w GIMP zawsze lewy gérny naroznik obszaru selekcji. W zwigzku z tym, w wyniku
zmiany skali, przesuneta sie w lewo krawedz sptywu pfata, a nie jego krawedz natarcia — por. Rysunek 2.3.13.)
Luke po skalowaniu poprawimy przesunieciem o 9 pikseli w prawo. Wywota to efekt "krotkiej kotderki" z przodu
selekcji. Luka pojawi sie teraz w obszarze okapotowania silnika, pomiedzy rurami wydechowymi a poczagtkiem
skrzydta. (Spokojnie, skorygujemy jg wykonujgc trzeci, ostatni krok zaplanowanej transformac;ji.)
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Rysunek 2.3.13 Po skalowaniu: przerwe z tylu zamieniamy na przerwe z przodu

Ostatni krok transformaciji ma polega¢ na wyciggnieciu w kierunku silnika samego kadtuba, bez skrzydta. Zadna
z metody selekciji, ktére dotychczas poznalismy, nie jest do tego odpowiednia. Zaznaczenie prostokgtem objeto-
by i przesuneto nie tylko kadtub, ale takze fragment skrzydta. Z kolei Free Select zbyt zalezy od losowych
drgniec¢ reki. Jak mozesz sie przekonaé, nie mam jej zbyt pewnej (Rysunek 2.2.14, str. 29).

Pozostaje mi skorzysta¢ z innej mozliwosci Gimpa: narysowania obszaru selekcji. Opisujgc rzecz w skrocie,
robi sie to w nastepujgcy sposob:

- tworzysz na chwile nowa, (przejrzystg) warstwe (patrz str. 66);

- rysujesz na niej ksztalt selekcji (patrz str. 68);

- wywotujesz polecenie Layer>Transparency >Alpha to Selection (por. 73);

- "sprzagtasz" po operacji: usuwasz niepotrzebng juz warstwe z ksztattem selekcji (patrz str. 67);

Nim zamienisz narysowany ksztatt w selekcje, wprowadz pewng poprawke. Wykonaj za pomocg "gumki"
(Eraser — patrz str. 70) niewielkie wgtebienia wszedzie tam, gdzie z kadtubem styka sie jakas linia skrzydta

(Rysunek 2.3.14):
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Rysunek 2.3.14 Przygotowanie obszaru selekcji — wymazanie "naddatkéw", wykonanie wgtebien

r"‘i:
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Takie wgtebienia pozwolg unikng¢ pozostatosci po transformacji w postaci brzydkich, kroétkich, poprzecznych
linii. Teraz mozesz przeksztatci¢ narysowany ksztatt na selekcje: Layer>Transparency 2Alpha to Selection.

Nastepnie przeskaluj zaznaczony obszar. Tym razem, po wywotaniu polecenia Scale, nie wpisuj wartosci w
oknie dialogowym. Zamiast tego uzyj jednego z uchwytow obszaru selekcji, by dopasowaé potozenie kabiny do
zaznaczonych na rysunku linii pomocniczych (Rysunek 2.3.15). (Linie te nanies na podstawie rzutu z lewej -
patrz Rysunek 2.3.10, str.37)

il

=il . ... az odp. krawedzie nie
Uchwyt. (Ciagnij )| / znajdy sie na liniach

pomocniczych

™ i

i
]
T
i

JAEH bl

Rysunek 2.3.15 Zmiana skali za pomoca uchwytoéw obszaru selekcji

Po przeskalowaniu nie zapomnij o wywotaniu Layer—->Anchor Layer, by zatwierdzi¢ transformacje! Rysunek
2.3.16 pokazuje efekt rozciggniecia kadtuba. Udato sie dopasowaé do rzutu z lewej linie kabiny i dalsze szwy, w
kierunku ogona.

To, co pozostato po tej transformaciji, to nieco wysuniete do przodu (w stosunku do wzoru) tgczenia blach przed
kabing. Réznice sg jednak niezbyt duze. W dodatku potozenie tych szwoéw w rzucie z goéry nie wydaje sie godne
zaufania — nawet nie sg pionowe! Wyglgda to na niedoktadnos¢ podczas kreslenia. Po oryginalnych "wgtebie-
niach" w okolicach taczenia linii skrzydta i kadtuba pozostaty teraz przesuniete przerwy (Rysunek 2.3.16). W
wykorzystaniu rysunku do naszych celéw nie bedzie to przeszkadzaé. Zapewniam, Zze to wyglada o wiele lepiej,
niz gdybysmy takich wgtebien w ksztatcie selekcji, omijajgcych przeciecia linii, nie zrobili.

Przerwa w linii,
pozostata po
przesunigtym

wgtebieniu \ = SENEE S H i
. X / [ X ..::w.w-ww—m"""""' '

Zgodne poto-
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Rysunek 2.3.16 Efekt trzeciego kroku - kadtub w rzucie z gory jest "dociagniety"” do rzutu z lewej
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Mamy wiec ostatecznie "wyprostowany" rzut z géry, uzgodniony z rzutem z boku. Na koniec:

usun wszystkie warstwy pomocnicze, pozostawiajgc tylko Background;

obrdc¢ rysunek o kolejne 90° (Image > Transform >Rotate 90° counter-clockwise - rzut z géry w Blende-
rze ma nos skierowany do dotu);

wymaz "gumkg" wszystkie niepotrzebne pozostatosci po innych fragmentach skanowanego arkusza
(Tools 2Paint Tools >Eraser);

przetgcz tryb barw z powrotem na odcienie szarosci (Image 2>Mode 2>Grayscale);

"sptaszcz" rysunek (Image 2Flatten Image — ta operacja nigdy nie zaszkodzi, gdy mamy tylko jedng
warstwe. Moze za to oszczedzié¢ stresu wywotanego komunikatem o niepowodzeniu zapisu obrazu do
formatu *.tif).

Rysunek 2.3.17 pokazuje ostateczng postaé rzutu z géry z planéw Jacka Jackiewicza. Zapisz go pod nazwg
P40B-JJ-Top.tif.

—EIFIIIT

Rysunek 2.3.17 Ostateczna posta¢ rzutu z gory
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Podsumowanie

e W rzutach z goéry i z dotu wyszukaj i popraw ewentualne przekoszenia skrzydta i statecznika poziomego
(str. 32 - 33).

e Duze korekty ksztattu (np. catego skrzydta) powodujg pojawienie sie mniejszych, lokalnych deformaciji (str.
39 - 40). Od razu stara; sie je przewidzie¢, by potem skutecznie wykona¢ odpowiednie lokalne poprawki.

e  Poréwnaj z rzutem z lewej rzuty z goéry i z dotu. Sprawdz, czy pozycje elementéw kadtuba sg na nich takie
same (str. 36).

e  Sprawdz proporcje rysunku, przede wszystkim rozpietosci do dtugosci (por. str. 34 - 36). W miare mozliwo-
Sci, nalezy sprawdzic¢ takze inne wymiary (jezeli sg znane).1 Whioski z tej weryfikacji moga prowadzi¢ do
dalszych korekt.

o Niektore z korekt — jak wydtuzenie w tej sekcji samego kadtuba, bez skrzydta — wymagajg uzycia selekc;ji
"przez narysowanie" (str. 39).

' Nie nalezy jednak bezkrytycznie wierzy¢ w kazdy podany w publikacjach wymiar. Na przyktad: w opisie technicznym P-40, opublikowanym
w monografii AJ Press (druga cze$¢ monografii P-40, zeszyt nr 65) mozna przeczytaé, ze:

- rozpietos¢ ptata P-40 wynosita 1135cm. To wyglada na jakies dziwne zaokraglenie podczas przeliczania z 37 stop i 3'/, cala. Btad
ten powtarza sie zresztg w innych zrodtach.

- rozpietos$¢ usterzenia poziomego wynosita 341cm. (Wedtug rysunkéw wymiarowych Curtiss byto to 390cm, co znajduje potwier-
dzenie w proporcjach pfata i usterzenia na zdjeciach.). Wyglada to na prosty btgd edycji, gdyz inne wymiary (np. cieciwy pfata) ta
monografia podaje poprawnie.

- dtugos¢ kadtuba P-40D/E wynosita 949cm (czyli, ze byt wyraznie krétszy od P-40B/C, ktérego kadtub mierzyt 967cm). Okazuje
sig, ze wcale tak nie bylo. (Zresztg nawet rysunki w tym samym zeszycie nie pokazujg zadnej réznicy). Nie wida¢ tego takze na
zdjeciach. Wg rysunkow Curtiss P-40D i nastepne byt tylko o /16 cala (pare milimetrow) krotszy od P-40B/C. Ten btad z diugoscia
kadtuba jest powtarzany w wielu zrédtach. Mogt sie wzig¢ stad, ze przektadnia stosowana od wersji P-40D byta faktycznie krétsza
o ponad 10 cm od tej z poprzednich wers;ji. Skrocita sie dlugo$¢ okapotowania silnika, ale konstruktorzy powiekszyli jednoczesnie
kotpak $migta — i ogdlna dtugos¢ kadtuba nie ulegta istotnej zmianie.

Czy w takim razie wymiary podane na rysunkach wymiarowych przez producenta mozna traktowac "jak wyrocznig"? W zasadzie tak to
robie, cho¢ natknatem sie na jedng sprzecznosé, ktérej nie potrafie jednoznacznie wyjasnié. Rysunki gabarytowe poprzednika P-40 —
mysliwca Hawk P-36, opublikowane przez Curtiss, réznig sie od rysunkéw P-40 w dwoéch wymiarach:

- rozpietosci usterzenia poziomego:13 stép w P-36 wobec 12 stép 9 %/s cala w P-40 — oznacza to réznice 6 cm;

- rozstawu kot podwozia: 8 stop w P-36 wobec 8 stop 1 '/5 cala w P-40) — oznacza to réznice 5 cm;

Réznice rozstawu podwozia mozna wyttumaczy¢ wiekszymi (i grubszymi) oponami uzytymi w P-40. Gorzej z usterzeniem. Staratem sie to
sprawdzi¢ na zdjeciach P-36. Rozpietos¢ usterzenia na fotografiach wychodzita mi ok. 390 cm — czyli taka sama jak w P-40. Obrys steru
wysokosci P-40 takze pasowat do zdje¢ P-36. Jednak granica toleranciji tego poréwnania (*/. 2 cm) byta zbyt duza, by jednoznacznie stwier-
dzi¢ zgodnosé. Na zdjeciach widac takze, ze ster wysokosci w P-36 miat dodatkowg kompensacje aerodynamiczng wzdtuz catej rozpietosci.
Byt przymocowany do statecznika zewnetrznymi okuciami. W P-40 zastosowano inne rozwigzanie, pozostawiajgc kompensacje tylko na
koncowce steru. Okucia jego osi ukryto wewnatrz statecznika. Niewykluczone, ze ,przy okazji” zmieniono takze kilka zeber na kohcéwce,
redukujac nieco rozpietos¢ usterzenia.
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24 Ztozenie rysunkow

Do pracy nad modelem w Blenderze potrzebne sg nastepujgce rzuty samolotu (w nawiasach podaje nazwy,
jakie nadatem odpowiednim plikom):
1. widok z lewej (P40B-JJ-Lett.tif);

2. widok z prawej (P40B-JJ-Right.tif);
3. widok z gory (P40B-JJ-Top.tif);

4. widok z dotu (P40B-JJ-Bottom.tif);
5. widok z przodu (P40B-JJ-Front.tif).

Oprocz tego, mozesz takze przygotowac dodatkowo:
6. widok z tytu (czasami sie przydaje) (P40B-JJ-Rear.tif);

W poprzednich sekcjach pokazatem, jak przygotowywaé rzuty w GIMP, uzyskujgc obrazy 1, 2, 3 (Rysunek
2.4.1). Teraz przygotuj w ten sam sposob pozostate elementy (4, 5, 6) z powyzszego zestawienia. Powiniene$
uzyskac ostatecznie sze$¢ rysunkow:

| <@ » | »|
< P |« »

Rysunek 2.4.1 Unifikacja rozmiarow i potozenia sylwetek "podkiadéow" dla Blendera

Zwro¢ uwage, ze odpowiednie wysokosci i szerokosci (wymiary A i B) poszczegoinych rysunkéw zostaty ujed-
nolicone (Rysunek 2.4.1), podobnie jak potozenie sylwetki wewnatrz obrazu (wymiary f,g,h). Rysunek 2.4.1
pokazuje rzut z dotu (4) obrécony o 90° w lewo. Ustawitem go w ten sposéb wytacznie na tej ilustracji. Chciatem
w ten sposéb pokazacé, ze dtugos¢ boku A i odstep f sg takie same, jak na rzucie z boku.
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Aby takie ujednolicenie uzyskac¢, ostatnimi krokami, ktére wykonywatem w GIMP, byty:
- zmiana rozmiaru obrazu na "standardowy" (czyli taki z wymiarem A, B);
- zaladowanie, w charakterze wzorca, poprzednio przygotowanego rysunku (do nowej warstwy);
- dopasowanie sylwetki na obrazie do rozmiaréw i potozenia sylwetki — wzorca;
- usuniecie warstwy ze wzorcem;
- zapisanie sprawdzonego w ten sposéb obrazu do pliku.

Ujednolicone wymiary rysunkow, ktére pokazatem na przyktadowym zestawieniu (Rysunek 2.4.1), wynosza: A =
2390px, B = 2827px. Nie sg to zadne "magiczne" liczby. Po prostu szeroko$¢ pierwszego rysunku — rzutu z
lewej — zdeterminowata mi wymiar A. Podobnie szerokos¢ rzutu z gory okreslita wymiar B. Potozenie osi sa-
molotu wzgledem krawedzi tych rysunkéw podyktowato mi wymiary f,g,h, do ktérych dopasowatem pozostate
sylwetki.

e Ujednolicenie potozenia sylwetek wzgledem granic obrazu nie jest konieczne. Jednak narzucenie sobie tej
reguty bardzo utatwi pézniejsze pozycjonowanie rysunkéw jako "podktadéw" w Blenderze

Do tej pory pokazywatem wszystkie operacje na przyktadzie rysunkow Jacka Jackiewicza. Na poczatku tego
rozdziatu wspomniatem, ze mamy do dyspozyciji takze drugie plany - opracowane przez Mariusza tukasika'. W
istocie obydwa opracowania nie réznig sie specjalnie. Wydaje mi sie, ze Mariusz tukasik korzystat w szerokim
zakresie z rysunkow Jacka Jackiewicza. (Nie ma w tym nic ztego, plany sg takze po to publikowane). Poréwnu-
jac te rysunki, dostrzegtem nastepujgce réznice:

- Kadtub na rysunkach M.t. jest o ok. 2% dtuzszy od rysunkéw J.J. Wyglada na to, ze zostat proporcjo-
nalnie rozciggniety wzdtuz osi X.

- Rzut z przodu na planach J.J. ma zbyt nisko narysowany kotpak i $migto, oraz zbyt waski rozstaw kot.
M.L. skorygowat te btedy. Co prawda z rozstawem kot podwozia nie do konca sie udato®. Dodatkowo li-
nie ptata w rzucie z tytu i z przodu na rysunkach M.L. nie pokrywajg sie.

- M.k zastosowat bardziej poprawny obrys steru wysokosci. (Na rysunkach J.J. krawedz sptywu steru jest
zbyt "wypukia").

Sadze, ze gdy Mariusz tukasik znalazt na rysunkach Jacka Jackiewicza niewtasciwe proporcje rozpietosci i
dtugosci, zdecydowat sie je poprawi¢ przez wydtuzenie kadtuba. (My zmniejszyliSmy skrzydta i stateczniki —
por. str. 35). Aby te sylwetki uzgodni¢, na planach M.t. wydluzytem rzut z boku i kadtub w rzucie z géry o 2%.
Natozytem tak przygotowane sylwetki na rysunki J.J. Okazato sie, ze doskonale do siebie pasujg. Mozna je
stosowac zupetnie wymiennie! Na przyktad - zamierzam wykorzystaé rzut z prawej z rysunkéw M.k, gdyz ma
"odjete" skrzydio (Rysunek 2.4.2). (Takiego ujecia nie ma na rysunkach Jacka Jackiewicza).

/, 7 .\\\:..-

Rysunek 2.4.2 Rzut z prawej — z planéw Mariusza tukasika

' Czasami, aby nie wydiuzaé zdan, bede postugiwat sie skrotami, odpowiednio: "rysunek J.J." lub "rysunek M.t.".
ZNa rysunku J.J. (1:48) kota gtéwne sg o 1.5 mm za wasko, a na planach M.t - 0 1.5 mm za szeroko. (Rozstaw podwozia wg Curtiss wyno-
sit 8 stop, 1 /s cala — por. Rysunek 2.3.6, str. 34. W skali 1:48 oznacza to 51.6 mm).
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Rozdziat 2 Przygotowanie rysunkéw samolotu 45

Rysunki Mariusza tukasika zostaty wykonane za pomocag komputera. Tu juz sie nie zdarzajg "poslizgi linijki", jak
na rysunkach robionych recznie. Majg takze bardziej jednorodne, wyrazne linie. Przygotowatem drugi zestaw
szesdciu rzutdw na podstawie tych planéw. Nadatem tym plikom nazwy zaczynajgce sie od "P40C-ML-". (Na
przyktad Rysunek 2.4.2 to P40C-ML-Right.tif).

Z rysunkami, ktére opracowaliSmy w tym rozdziale, mozna wykona¢ model P-40. Czy jednak bedzie naprawde
taki, jak oryginat? Jezeli jestes modelarzem, a nie tylko grafikiem komputerowym, zapewne bedziesz chciat to
sprawdzi¢. Zapraszam do zajrzenia do dodatkowych materiatow, na koncu tej ksigzki (Rozdziat 5, "Szczegoétowa
weryfikacja planéw samolotu”, str. 105). Dla "pobudzenia apetytu" pokazuje rezultat weryfikacji rzutu z boku
(Rysunek 2.4.3):

Inny obrys H
statecznika >

M

A I ‘ I
A B ” D L.

Nieco mniej-
sza wysoko$é

Poprawiony Krawegdz steru jest

Plytsza chtodnica profil ptata ok. 10 cm blizej

Rysunek 2.4.3 Korekty rzutu z boku, naniesione po dokfadnej weryfikacji

Czerwonymi liniami oznaczytem réznice. Jest ich sporo, nieprawdaz?

Podsumowanie

e Warto jest ujednolici¢ szerokosc¢ i wysokos$¢ poszczegodlnych rysunkow samolotu (str. 43). Takze potozenie
sylwetki samolotu wzgledem lewego gornego naroznika rysunku powinno by¢ takie samo.

e Rysunki mozna poddaé dalszej weryfikacji, polegajgcej na doktadnym poréwnaniu ksztattu ze zdjeciami
(str. 105). Nie jest to jednak niezbedne.
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Szczegébly obstugi programoéw

Zawartosc¢ tej czesci bardzo przypomina zawartos¢ plikow podpowiedzi do trzech programéw: GIMP, Inkscape i
Blendera. Sa tu zestawione opisy tych polecen, ktore zostaty wykorzystane w poprzednich cze$ciach ksigzki. Z
zatozenia bedziesz z nich korzystat wyrywkowo (por. ,Jak czytac te ksigzke?”, str. 11). Nie doszukuj sie wiec w
kolejnosci rozdziatow i sekcji tej czesci jakiejs przemyslanej metody wprowadzania w obstuge programu. Do
tego stuzy czes¢ pierwsza — ,Budowa modelu”. To tam specjalnie dobratem kolejno$é prezentowanego mate-
riatu w ten sposdb, bys mogt stopniowo poznawaé wszystkie potrzebne zagadnienia.

Gdy zdecydujesz sie wydrukowac¢ te ksigzke dla wtasnych potrzeb, proponuje pozostawi¢ tg cze$¢ w postaci

elektronicznej. W przeglgdarce PDF szybciej znajdziesz podang w czesci pierwszej strone, niz kartkujgc gruby
wydruk. (No i zuzyjesz mniej drzew z lasow...).
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Rozdziat 3. GIMP — szczegéfty obstugi

Nazwa GIMP pochodzi, jak sgdze, od pierwszych liter angielskiego Graphic Image Processor. Jest to jeden z
pierwszych, duzych i ukonczonych projektéw Open Source.
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31 Instalacja

Po uruchomieniu programu instalacyjnego pojawia sie ekran "powitalny", a nastepnie ekran z umowg licencyjng
(Rysunek 3.1.1):

18 Setup - GIMP (=3 5 Setup - GIMP A=)

. License Agreement
. L wg;‘:‘?‘e to the GIMP Setup Please read the following important information before continuing.

This will install GIMP 2.4.4 on your computer. When you are ready to continue with Setup, click Mext

It is recommended that you close all other applications befors

contiuing [GNU General Public License =

Click Next to continue, or Cancel to exit Setup. Version 2, June 1951

Copyright (C) 1989, 1991 Free Software Foundat

S HLrate Flace — sutte s30, Becton, MA 0Riiiisbr UsA

Eyeryene is permittad to cooy and distribute verbstin copies
is license document, but changing it is not allowe

Preamble

The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
|icense is intended tn auarantes vour frasdnm ta share and channe

<Back [ MNet> | [ Cancel

Rysunek 3.1.1 Instalacja GIMP — pierwsze dwa ekrany

Po nacisnieciu przycisku I Agree na ekranie License Agreement, przejdziemy do ekranu Ready to Install
(Rysunek 3.1.2). Mozna tu wybra¢ normalng, "szybkg" instalacje (Install Now) lub nietypowa (Customize):

18 Setup - GIMP

Ready to Install
Setup is now ready to begin installing GIMP on your computer.
bl

The GIMP is now ready to be installed.

Install now

Rysunek 3.1.2 Wyboér drogi instalacji

Jezeli nacisniesz przycisk Install Now, zainstalujesz program z domysinymi ustawieniami. W takim przypadku
po tym ekranie zobaczysz od razu ekran postepu i finalny (Rysunek 3.1.7).
Jezeli jednak nacisniesz przycisk Customize, pojawig sie kolejne ekrany.

Pierwsze z nich pozwalajg Ci okresli¢ folder programu i skfadniki, jakie majg by¢ wgrane na Twdj komputer
(Rysunek 3.1.3):

18 Setup - GIMP (=3 8 Setup - GIMP =]

Select Destination Location Select Components
Where should GIMP be installed? Which components should be installed?
u

Select the componants you want to install; clear the componants you do not wart to
install. Click Next when you are ready to continue.

’J Setup will install GIMP into the following folder

To continue, dlick Next. If you would like o select a diferent folder, ciick Browse [Full instalaton |
Description
[c\Progrem Fies'GIMP | [ Erowse..
M5-Windows engine for GTK= 0,1 ME
Translations 20.8ME
A least 40.2 MB of free disk space is required. Curment selection requires at least 80.9 MB of disk space
[ <Back [ Net> | [ cancel | <Back | Net> | [ Cancel

Rysunek 3.1.3 GIMP — wybér folderu i sktadnikéw programu
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Nastepny (Select file associations) pozwala wybra¢ formaty obrazéw, dla ktérych GIMP ma by¢ domysinym
programem do wyswietlania/ edycji. Zaznacz tu m.in. formaty: GIF, PCX ():

18 Setup - GIMP

Select file associations
Select file associations

Select the file types you wish to associate with GIMP
This will make selected files open in the GIMP when you double-click them in Explorer.

<l
|

GIMP image
[] Adobe Photoshopim) image

[ Compuserve GIF

[ AliasWavefront PowerAnimator

[IWgtal Imaging and Commurnications in Medicine

~

GIMP pattem

|Zaznacz format GIF |

v

Edensions: gf

Select Unused Select All

[ <Badk [ _Met> | [ Comcel |

Rysunek 3.1.4 Ustalanie domysinie obstugiwanych formatéw plikéw

Setup - GIMP

Select file associations
Select file associations

Select the file types you wish to associate with GIMP
This will make selected files open in the GIMP when you double-click them in Explorer.

[] Tagged Image File ~
TrueVision Targa Zaznacz format PCX |
i W T

E ncows syOs/2EmEs | (na koricu listy)

Wi o

1 %10 apé %11 Btmap

[  Fyfmap

D g

U
=

Exdensions: pcx

Select Unused Select Al

[ <Back [ Net> ] [ comeel ]

Wreszcie ustalane sg szczegdty reprezentacji w menu i na pulpicie (Rysunek 3.1.5):

15 Setup - GIMP

Select Start Menu Folder

Where should Setup place the program’s shertcuts?

Setup will create the program’s shorteuts in the following Start Menu folder.

To continue, click Next. f you would like to select a different folder, click Browse.

o' Setup - GIMP

| [ Browss
[[1Dent create a Start Menu folder
[ <Back J[_Met> ] [ Cancel ]

Rysunek 3.1.5 Instalacja GIMP — szczegoély reprezentaciji

Select Additional Tasks

Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing GIMP, then
click Next

Additional icons:
Create a desktop icon
[ Create a Quick Launch icon

<Back | Nex> | [ Coneel

Na zakonczenie program wyswietla podsumowanie wybranych opcji (Rysunek 3.1.6):

18! Setup - GIMP

Ready to Install
Setup is now ready to begin installing GIMP on your computer.

changs any ssttings

Click Install to continue with the installation, or click Back: if you want to review or

Destination location:
F:\Program Files\GIMP
Setup type:
Full installation
Selected components:
The GIMP
GTK+ Run-time Environment 2.12.5

M5-Windows engine for GTK+
Translations

File types to associate with the GIMP:
xcf, gih, gbr, gpb, pat, tga, wmf, pex
Start Menu folder:

[ <Back |[_Instal

] [ Cancel

Rysunek 3.1.6 Instalacja GIMP — wyliczenie wybranych opcji
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Po nacisnieciu przycisku Install rozpoczyna sie instalacja (Rysunek 3.1.7):

15 Setup - GIMP. [ l=]]

18 Setup - GIMP

Installing
Please wait while Setup installs GIMP on your computer.
|

i Completing the GIMP Setup

L Wizard

Setup has finished installing GIMP on your computer. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.

Launch The GIMP

Bdracting files...

F:\Program Files\GIMP-2.0'binticonv.dil

Rysunek 3.1.7 Instalacja GIMP - ekrany: postepu i finalny

Po zainstalowaniu GIMP, mozesz takze zainstalowac¢ rozbudowany system podpowiedzi (Help) (Rysunek 3.1.8).
Program instalacyjny moze by¢ pobrany z Internetu, (z tej samej witryny, co GIMP):

18 Setup - The GIMP. 18 Setup - The GIMP [([=1.3]

Ready to Install

Welcome to the GIMP Help Setup Setup is now ready to begin instaling The GIMP on your computer.
Wizard
This wil install GIMP Help 2:2 4.0 on your computer Ciick Installto continue with the installation, or click Back  you wart to review or

change any settings.
It is recommended that you close all other applications before
cortinuing Gimp 2 was found in-

F:\Program Files\GIMP-2.0

A Click Next to continue, or Cancel to exit Setup.

<Back J[_insial | [ Cancel

Rysunek 3.1.8 Pierwsze dwa ekrany instalacji podpowiedzi

Po nacisnieciu na ekranie Ready to Install przycisku Install, rozpoczyna sie kopiowanie plikéw (Rysunek 3.1.9):

18 Setup - The GIMP & Setup - The GIMP =

Installing .
Please wait while Setup installs The GIMF on your computer. : quml"gtlﬂg the The GIMP Setup
‘ izar

Bxracting files. Setup has finished instaling The GIMP on your computer.

Click Finish to exit Setup.

Rysunek 3.1.9 Instalacja GIMP — ekrany postepu i finalny

Instalacja systemu podpowiedzi koriczy sie ekranem finalnym (Rysunek 3.1.9).
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3.2 Wprowadzenie

tadowanie wszystkich komponentéw zajmuje Gimpowi pare sekund podczas uruchamiania. W tym czasie po-

kazywane jest "okno startowe" (Rysunek 3.2.1):

Madules

[ " Looking for data files

)

Rysunek 3.2.1 Okno startowe GIMP — pokazuje postep tadowania komponentéw

Po zakonczeniu tadowania, ujrzysz gtéwne okno programu (Rysunek 3.2.2):

B@@ = GNU Image Manipulation Program

Fle Edit Select  Wiew Image

k Menu rozwijalne

. Toolbox

Laver Calors

e N =
Lanse
& .*, ,:* ) s; [brop image files here ko open them]
BRACA
Y WAV
£ & 8y
& L

Okno
m |Przybornika Okno obrazu — to
2 gtéwne okno progra-
Paintbrush = mu
A —
Cpacityt - j v

P .
Seale: —j— :

Brush Crynarnics
[] Fade ou

[ Apply Jitear
[ tneremental

I:‘ Usze colar from gradient

=

|- [B]X]

CEX

Windaws

*® Layers, Chann..

By E:

Layers

Tools  Filkers Help

5 |
&

Okno z dodatkowy-

mi zaktadkami
(mozna  zamkna¢,
jezeli brakuje Ci

miejsca na ekranie)

L
Djm] a1
Brushes

Citle (14) {17 % 13)

\ p / /

v oy 6
Spading —_|———— |20 &

5 8 &

Rysunek 3.2.2 Domysiny ekran GIMP (2.6)

Podstawowym oknem GIMP jest okno obrazu (domysinie umieszczane posrodku). Z bokéw otwierajg sie dwie

dodatkowe panele z przybornikami.

o Dodatkowe okno po prawej (Layers, Channel, ...) mozesz w kazdym momencie zamkng¢, jezeli bedzie Ci

brakowac na ekranie miejsca.
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o  Wszystkie programy w tej ksigzce pokazuje w wersji anglojezycznej. GIMP ma takze dobre ttumaczenie na
jezyk polski. Jezeli bedzie Ci tatwiej, wybierz podczas instalacji wersje w jezyku polskim. Mozesz takze ze
strony Gimpa pobra¢ plik polskich podpowiedzi/opiséw! (Patrz str. 48 i dalsze)

W oknie gtéwnym programu wyswietlany jest edytowany obraz. Rysunek 3.2.3 przedstawia kilka istotnych ele-

mentéw tego okna:

Menu  rozwijaine B P40-org ver.tif 1.0 (grayscale, 1 layey 2480x... [=][8]X]
programu File Edit Select Wiew Image Laver Colors Tools  Dialogs  Filkers
B | |D Ll 1 | | |‘1 EIEIDI [ S | | |QDDD| | |
oA T !
1 .
| B
- : :
N 1 e :
] | =
! J |
| ! |
| 1 1
1 - 1
] ! =
] : — i
1] : e =S i
0 | o gl
o i = - |
o4 ——= , - . |
< — ,Linijki” — pozioma i o Tale :
i | ‘== pionowa —
- I — - e et
. : | —
1 =] |
| . !
i i
z ; T |
g T | —
—1 —m o !
i ==
- I :
|
] . !
- i ot i
I 1
1 —
1 ==
: =
Tu mozesz zmieni¢ 7] ' !
powigkszenie 8_ i i !
0 | L Informacja o rysunku
. ' (a dokfadniej - o
[N + aktualnej warstwie)

Rysunek 3.2.3 GIMP - zatadowany obraz (okno gtéwne)

W GIMP mozesz naraz otworzy¢ wiele obrazoéw. Kazdy z nich zostanie umieszczony w odrebnym oknie (sprébuj
np. wywotac kilka razy File >New). Mozna takze ten sam obraz otworzy¢ w kilku oknach (View >New View).

Dialogs  Filkers

Selection Tools 3
Paint Tools La " |
Transform Taals (3 Elipse Select E
— Color Tools » || |Free select F
L | paths B || @ |Fareground Select
a‘* Calar Picker o of 4, |Fugey Select ]
=y | Zoon Z [|"d |By Color select  shift+0
v Te ikony znaj-f.
'ﬁ Meal i iesz takze wltt & |Intelligent Srissors I
A Texd Przyborniku, T p
e
Toaolbox Chrl+B
B | Default Colors D
@ | Swap Colors b

Rysunek 3.2.4 Menu Tools (okno obrazu)

W GIMP polecenia z palety narzedzi (przybornika), sg dostepne
takze poprzez menu Tools (Rysunek 3.2.4). S3 w nim pogru-
powane w kilka submenu: Selection Tools, Paint Tools,
Transform Tools. W tekscie ksigzki tatwiej i bardziej jedno-
znacznie jest mi podawac polecenia z menu, niz umieszczac
obrazki ikon do nacisniecia. Bede wiec powotywat sie na nazwy
polecen. Jezeli wolisz korzysta¢ z przybornika - otworz tylko raz
podane przez mnie menu, aby upewnic¢ sie o ktérg ikone cho-
dzi. (Sg zawsze widoczne obok napiséw) Gdy juz rozpoznasz
ten symbol — uzywaj przybornika.

o Jezeli brakuje Ci miejsca na ekranie, mozna ,upchac” wszystkie potrzebne kontrolki w jedno okno przybor-

nika. (Szczegéty — na dalszych stronach).
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Rysunek 3.2.5 przedstawia wazniejsze elementy okna przybornika (Toolbox):

€ Toolbox

EEX

@ e %
Qésdri R
Al E 7/
& 8BFgo o o

Paleta narzedzi
do edycji obrazu

& iy 7
TR A
o L 8,

Aktualne ustawienia wybra-
nego narzedzia (Tool

Options) j‘
=Y

Wybér aktualnej barwy
(pod spodem - barwa tta)

Wybér rozmiaru i postaci
"narzedzia" (Brushes) E —

Szczegoty pracy z warstwami

(Layers)

Obszar na zaktadki

Rysunek 3.2.5 GIMP — okno przybornika

Zwro¢ uwage, ze na tej ilustracji w dolnej czesci przybornika widac tylko trzy zaktadki (i sg to zaktadki, ktore
domysinie znajdowaty sie w innym oknie — por. Rysunek 3.2.2). Taki zestaw narzedzi powinien wystraczyé na
poczatek pracy z Gimpem. Skonfigurowatem go, postugujgc sie menu rozwijalnym zaktadek.

Przyjrzyj sie nagtéwkowi obszaru zaktadek w oknie Toolbox.
Jest tam, po prawej stronie, taki niepozorny przycisk ,strzafki,
(Rysunek 3.2.6).

Gdy go nacis$niesz, pojawi sie menu sterujgce panelami GIMP.
Wida¢ na nim submenu, odpowiadajagce kazdej zaktadce tego
zestawu. (Na ilustracji zestaw zawiera tylko jedng — o nazwie
Tool Options).

&
il

[ |74 Toal Opkions Menu »

&dd Tab »

D)

1 Kiiknij w te strzatke,
by otworzy¢é menu
K < - - sterujace zaktadkami

v  Show Button Bar

e W GIMP mozesz otworzy¢ kazda zaktadke jako oddziel-
ne okno. Stuzy do tego polecenie Detach Tab (z subme-
nu odpowiedniej zaktadki)

Pressure sensitivity

Polecenie Close Tab zamyka aktualng zakfadke.

[ | Fade out
[ ] apply Jitker 3
(& ] 8 (&3]
—

Rysunek 3.2.6 Przycisk zarzadzajacy zakladkami
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Zajmijmy sie jednak poleceniem Add Tab. Jest to zagniezdzone menu, prezentujgce do wyboru wszystkie do-
stepne zaktadki (Rysunek 3.2.7):

“* Toolbox E]Iﬁlle i

File Edit Select Wiew Image Layver Colors Tools  Filkers  Windows Help
BAES
— |ﬂ Tool Options
[I / / Dievice Status
,ZC ﬁ,‘ (% % § 0 Layers
é §-J ‘ ! Channels
Calormap
.JJ
Histagram
Nainthumrh
|E Tool Options Menu » | [} Zelection Editor
# dose Tab % Unda Hiskory
™
* [y Poirter
Lock Tab to Dock .
4y Sample Paints
v Show Butbon Bar
= Colors - -
[ Fade aut < Wybierz stad jedng z
Il
_ dostepnych zaktadek
(] Apply diner 8l Patterns Open the brushes dialog
[] tneremental |I| Gradients Fress Fi formore Sajp)
[ Use color From gradient M Palettes
= o 1 [#® Forts

[0 EBuffers

Rysunek 3.2.7 Dodawanie do przybornika dodatkowej zaktadki

Gdy wybierz z tego menu jedng z zakladek (np. Brushes — ksztatty narzedzi), zostanie dodana do przybornika
(Rysunek 3.2.8):

Dodana zaktadka
w [0]
Brushes 4

Gl [(14) (17 & 230

Rysunek 3.2.8 Dodana zaktadka Brushes.

W ten sposéb mozesz w skompletowac w przyborniku wszystkie zakfadki, ktére sg Ci potrzebne do pracy. Wy-
daje mi sie, ze do naszych celéw wystarczg trzy: Tool Options, Brushes i Layers (por. Rysunek 3.2.5).
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3.3 Otwieranie pliku (obrazu)
Aby otworzyé obraz, wybierz z menu polecenie mEE
File >Open (Rysunek 3.3.1). rie [T
O Hew Chrl+h 3]‘} / L
. Chrl+0 @ A [ﬁﬁj E
@ Open Location. .. N -
Spowoduje to pojawienie sie okna dialogowego wyboru ©pen Recent d @ & o o
. . i Acquire 4
pliku (Rysunek 3.3.2). Okno to nie przypomina standar- * pror
Preferences
dowego okna Windows. Dzieje sie tak dlatego, ze GIMP @ Keyboard shartauts
uzywa do obstugi okienek zestawu komponentéw o na- & Units E
zwie GTK+'. Tak wiasnie wyglgda w GTK+ komponent do Dialogs ' ®
wyboru plikow. * |
@ qut arbg )
Rysunek 3.3.1 Otwarcie istniejagcego obrazu
Tu  mozesz Ope o Aktualna Sciezka.
wpisa¢ recznie L : Mozesz  przejs¢ do
nazwe pliku folderu  nadrzednego,
@ 1 l_] witold jawarski l Maje dokumenty ” Prywatne || Madel [ Rysunki || &IPress kiikajagc w odpowiedni
przycisk
Lista folderow/ Plares Marme ¥ | Modified ’Prgview
dyskow - _‘qwitold.jaworski #| A1-P40E-Back, ki 2008-08-19
|23 Deskiop =] AJ-P40B-Botkom, tif 2005-08-19
@ Cil =] AJ-P40B-Front.bf 2008-08-19
D #| AJ-P40B-Left L 00501
“# Metwork Drive (G: 2 51 o Pliki w aktualnym
etwark Drive (G:1) | AJ-P40B-Left 2N folderze
=2 Mebwork Drive (H:) —' | ¥ AJ-P40B-Right.tif
22 Metwark Drive (1:1) =) A1-P40E-Top.tF 2008-08-19 Pmo’,”.ff'\
o N : . L Podglad podéwie-
2 Metwork Drive (K1) & P40-org-fre.Lif 2003-08-18 745 KB tlonego pliku
2% Metwork Drive (Q:1) B P40-org-LT.kf = 2?f3e?e3?31?|f{:§»|5
2% Metwork Drive (R:) | | =l Pa0-org-RE.4f 2008-08-19

all images Click to update preview

Select File Tvpe {Automatically Detected)

Ctrl+Click to Force update even if preview is up-to-date

op

=y

[ conee

Rysunek 3.3.2 GIMP - okno wyboru plikéw

GIMP rozpoznaje wiele réznych formatéw zapisu obrazu. Po nacisnieciu Open zataduje wskazany w oknie dia-
logowym plik.

' GTK+ jest bibliotekg procedur Open Source pozwalajgca na pisanie programoéw, ktore bedg dziataty w wielu ré6znych systemach operacyj-
nych, m. in. Linux, Windows, Mac OS. Posiada nawet polskg wersje jezykow3!
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3.4 Zapisanie pliku (obrazu)
Wybierz polecenie File>Save As (Rysunek 3.4.1):

== *D40-org-ver.tif-4.0 (grayscale, 1 layer) 2472x720

5= Edit Select View Image Layer Colors Tools Dialogs  Filkers

O Mew... Ctrl+M |.|5W.|.|.|.|?5Q.|.|.|.|1DQU.|.|.|.|12$D,|,|,|,|1§QD,|,.,|,|1T$U,|,|,|,|2WU,|,|,|,|22$D,|,|,|,|25QD,||EQE
B Cpen... Chrl+0
= Open as Layers, .. Chrl+alk+0
@ Cpen Location, .,
Open Recent 3
Acquire ]
& save Chrl+35
] Shift+Ctrl+5
Save a Copy...
Save as Template, .,
Revert
& Print...
X Close Chrl+w
A Close al Shif t+Chrl+
@ Quit Chrl+Q oy
I | =+
|px - || 33% v “Save this image with a different name

Rysunek 3.4.1 Zapisywanie gotowego rysunku pod nowa nazwa

Spowoduje to pojawienie sie okna (Rysunek 3.4.2), podobnego do tego, w ktérym wybieraliSmy plik do zatado-
wania (por. Rysunek 3.3.2, str. 55 ):

A |P4DB T iefr] € Tu wpisz nazwe dla nowego pliku. GIMP rozpoznaje
ST b format zapisu po rozszerzeniu, ktére nadasz!

== Save Image E|
|
|

=

[=) Browse for other folders

E][-_') witald, jaworski ][ Moje dokumenty ][ Prywakne ]@[ Rewsunki ]

Places Mame > | Modified

12 wikold. jawars | Blender-wprowadzenie 2005-03-19

|23 Desktop S]] 2005-03-03
e O |2 Instalacje 2008-03-03
& D |23 Rysunki Today

2 Network Drivi
2% Metwork Drivi
22 Metwork Drivi
22 Metwork Drivi
= Metwork Driv
= Metwork Driv
= Metwork Driv

2% Network Drivi

2% Metwork Drivi v

| >

L
Za pomocg tych narzedzi ustal folder, f v|

do ktérego chcesz zapisac plik —/

Select File Type (By Extension)

e J o

Rysunek 3.4.2 Okno do zapisywania pliku

W oknie Save Image (Rysunek 3.4.2) wybieramy folder, do kiérego zapiszemy rysunek. Wpisujemy takze na-
zwe pliku. Bardzo wazne jest takze wpisanie wlasciwego rozszerzenia pliku — np. .png, .tif, albo .jpg. (GIMP
okresla sposéb zapisu obrazu na podstawie rozszerzenia pliku, ktére podasz).
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Na koniec nacisnij na w oknie Save Image przycisk Save. W za-
leznosci od formatu zapisu, ktéry wybrates, GIMP moze jeszcze
pokaza¢ pomocnicze okno, z dodatkowymi opcjami. Rysunek
3.4.3 pokazuje takie okno dla formatu TIFF. Mozna tu ustali¢ spo-
séb kompresji obrazu. Wybieraj zawsze opcje LZW.

(Nie sprawdzatem innych, ale LZW jest bardzo popularng metoda,
i poprawnie wczytuje sie do Blendera.)

Po nacisnieciu kolejnego przycisku Save, nasz rysunek zostanie
ostatecznie zapisany na dysku.

Compression
Wybierz te  opcje
M
O_, Drf & kompresji obrazu
® 2w
() Pack Bits
() Deflate
O PEG
Commenk:
Help ] [ Save l l Cancel ]

Rysunek 3.4.3 Okno dodatkowe — Szczegéty
zapisu formatu TIFF
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3.5 Kadrowanie obrazu
Wybierz z menu polecenie Tools >Selection Tools 2Rectangle Select, (lub nacisnij na klawiaturze |E|). Prze-

suwajgc myszke z wcisnietym |:[ zaznacz obszar dookota rzutu z boku (Rysunek 3.5.1).

File Edit 3Select View Image Lawver Colors Tools Dialogs — Filkers
0]
1|
0
D_
0
¥
1 Zaznaczony
1 obszar
7]
i
o
0
=
R
o
04
g, 1400 |px v” 13% v”Rectangle: 2512 = 728

Rysunek 3.5.1 Zaznaczenie rzutu z boku

Nastepnie poleceniem Image—>Crop to Selection ogranicz caty obraz do zaznaczonego obszaru (Rysunek
3.5.2):

File Edit 3Select Wiew Image Laver ©olors Tools Dialogs  Filkers
®, .0 vy b0y ol E

LI|I|I|I|D|

k

||Jx v|| 13% v”Background {26.7 ME)

Rysunek 3.5.2 Wycieta czes$¢ obrazu

Wirtualne modelarstwo — wersja 2.0 www.samoloty3d.pl



Rozdziat 3 GIMP — szczegoty obstugi 59

3.6 Linie pomocnicze (guides)

Linie pomocnicze (quides) stuzg do oznaczenia jakiegos istotnego miejsca, a takze poréwnan.
Aby doda¢ do rysunku linie pomocnicza, "ztap" myszka (|:[) za linijke, umieszczong ponad obrazem. Trzyma-

jac przez caty czas wcisniety D przesun jg do dotu. Zobaczysz woéwczas, ze przesuwasz poziomg linie po-

mochiczg (Rysunek 3.6.1):

== PAQ-1J-Left.tif-1.0 (grayscale, 1 layer) 247 2x728

File Edit Select VYiew Image Lawer Colors Tools Dialogs  Filkers

quI|I|I|I||25q|lulululqululul?5q|l|I|IJJJDQD_:Iulul_u|12$DL(;\|__|_I||15QD|I|I|I||1?SD|I|I|I||2!3I;ID|I|I|I||2250|I|I|I|E~g":

N - — = — A
: . { | Al
] | - — i ,." i I

Curtiss Tomahawk Il A
wersja rozpoznawcza, w kadubee kamera
7 F 24 o ogniskowe] 356 mm maszi anieoy

%_‘ ... | trzymajgc wcisnigty
g =i '
i ] przesuwaj
g myszke w doét.

— " |Przesuwana linia J
= == ——|pomocnicza

] xT e R —_—

1377, 186 |px v” 3% v"ndd Guide: 186

Rysunek 3.6.1 "Pobranie” linii pomocniczej

Gdzie zwolnisz |:I ("upuscisz" linie pomocniczg), tam zostanie. Nie jest cze$cig obrazu. Mozesz jg powtdrnie
ztapa¢ myszka i przesung¢ w inne miejsce. (Jezeli nie reaguje na myszke - naci$nij na klawiaturze E' aby

przejs¢ w tryb przesuwania).

W podobny sposob pobierz takze kolejne linie pomocnicze, tym razem pionowe, z linijki po lewej stronie obrazu.
Umies¢ je na kluczowych liniach konstrukcyjnych, o ktérych wiesz, ze powinny by¢ pionowe lub poziome
(Rysunek 3.6.2):

Linie pomocnicze, uzywane do spraw- E:l“‘_]_ AT ol

dzania linii pionowych —
Cirtiss Tomahawk Il A \

wiarsia rozpdznawcza, w kadiubee kamera
F 34 o ogniskowe] 356 mm, maszt anpteny

P e——

/"_;———"Ir—‘—‘—— E—

Rysunek 3.6.2 Przyktadowe rozmieszczenie linii pomocniczych
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3.7 Widok: powigekszanie, przesuwanie

W GIMP powigkszenie mozna zmieni¢ na dwa sposoby (Rysunek 3.7.1):
- szybko i mniej dokfadnie: trzymajgc wcisniety i obracajgc kétkiem myszki (:[);
- dokfadnie, ale nie tak szybko: wybierajgc z listy u dotu ekranu jedno z predefiniowanych powiekszen,
lub wpisujac nowe za pomocg polecenia Other...

== PAQB-JJ-Left.tif-1.0 (grayscale, 1 layer) 2390x720
File Edit Select Yiew Image Layer Colors Tools Dialogs  Filters
Ei, oy ey e 1500 o0

Metoda bezposrednia:

| Ele Edt select view Image Layer Colors Took Dislogs Fiters
o |75Q 1 L L L hﬂgﬂl 1 L L ‘12$D 1 1 Vllq'

Metoda doktadna:
wybierz Other...

[Eackground (8,18 ME)

5
0 s =
== 7oom Ratio E‘ o | 38w — S e
Select Zoom ! H i & A .
PAOB-11Laft -1 5 - 1 WpISZ. tu wartos¢ /\ v” 57% V“Ba[kgmund (8.18 M}
/ powiekszenia.
Zoom ratio: |3 87 =

o<

(o ] e ==

Rysunek 3.7.1 Widok: dwie metody zmiany powiekszenia (Zoom)

Przesuniecie widoku to ruch myszki z wcisnietym E (Rysunek 3.7.2):

w= P40OB-JJ-Left.tif-1.0 (grayscale, 1 layer) 2390x720 (=3
File Edit Select View Image Layer Colors Tools Dialogs — Filkers
By, o, [oga, | P R 1290 , ., T [1500 | T T - [1750 | |q,

Oczywiscie, mozna e
takze postuzyé sie
naskami nrzewiiania

b
I > P
|px v || §7% v “Background (5,18 ME)
Rysunek 3.7.2 Przesuwanie widoku (Pan)
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3.8 Zmiana rozmiaru obrazu

Aby zmieni¢ rozmiar obrazu (np. powiekszy¢), uzyj polecenia Image>Canvas size... W oknie dialogowym,
ktére sie pojawi (Rysunek 3.8.1), roztgcz powigzanie pomiedzy wysokoscig i szerokoscig (przycisk z "ogniwa-
mi"). Potem np. zwieksz wysokos¢ (Height).

€ Set Image Canvas Size fg
+ Set Image Canvas Size [=]

ol PA0-org-RE LF-S
1. Kliknij tu, by roztgczyé
Canvas Size zmiany  wysoko$ci i
widkh: | 2480 & 5 szerokosci
, Height: [ 1300] |5 8 | pixel v
2. Tu wpisz nowg e o |13uu > : |plxes |
wysoko$é — e p; [
Offset
Al
i |362 |C | pixels V| [ Center
I L |3. Ztap i przesun (D) miniature
nowa T N rysunku, dopasowujgc do nowego
wysokosé stara 1 obszaru
l wvsoko$¢ s
Layers
Resize layers: |F\II layers v|
4. Wybierz z listy warto$¢
’ Help ] [ Reset l I Resize All layers

Rysunek 3.8.1 Okno zmiany rozmiaru obrazu

Nastepnie przesun (|:I) miniature aktualnego obrazu, aby przestrzen, ktérg dodajemy, znalazta sie w odpo-

wiednim miejscu. Gdy skonczysz, nacisnij przycisk Resize.

Na koniec nie zaszkodzi wywotaé polecenie Layer->Layer to Image Size.
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3.9 Warstwy — zarzadzanie

Warstwy w GIMP mozesz sobie wyobrazi¢, jako oddzielne powierzchnie przejrzystej folii. Kazda z nich moze
zawiera¢ oddzielny obraz. Obrazy te naktadajg sie na siebie (Rysunek 3.9.1). Do zarzgdzania warstwami stuzy
zaktadka Layers, dostepna w przyborniku.

B *P40B-JJRight.tif-23.0 (grayscale, 2 lay... [= |[B]X]
File Edit Select Wiew Image Layer Colors Tools Dialogs File #tns  Help
UB_ Py oy e e 2008 | et ,g;-
] A4 88
] Yy
il s
i o
i +@l= 8%

Layers

Warstwa o nazw
P-40-JJ-Left.tif

ie fode: |Normal

pacity: -

o Yo o Eed
Mk .1

=B Warstwa o nazwie
e Background
ox | 13% v |[Pa0B--Left.tf (279 E) T

Rysunek 3.9.1 Warstwy — na obrazie i w zaktadce Layers

Zaktadka Layers zawiera liste warstw, oraz kilka pomocniczych kontrolek. Rysunek 3.9.2 wyjasnia, jak sie nig
postugiwac:

+ @l 8% I

Tryb "mieszania" z pozostatymi warstwamil
Lavers Regulacja nieprzej-
Warstwa podswietlona to Mode: INDrmaI— VH rzystosci  (Opacity)
warstwa aktywna — aktualnej warstwy

acityl c

Aby  zmieni¢  kolejno$¢

= :EKEF'-{[IE:—JJ—LEFLHF warstw, ztap (:]) jedna
V “ Z nich i przesun w nowg
Znacznik ,powigzania” z

pozycje
warstwag aktywna.
(Méwigc szczerze, nigdy /
go nie wykorzystatem) O * A ] ale = |

Tu kliknij, aby ukry¢ lub
pokazaé warstwe

Rysunek 3.9.2 Funkcje zaktadki Layers

Warstwy mogg zastania¢ sie wzajemnie. Jak w swiecie rzeczywistym, obowigzuje zasada, ze warstwa lezaca
wyzej zastania warstwe lezacg nizej. Stad, w przyktadzie na ilustracji (Rysunek 3.9.1), warstwa P-40-JJ-Left.tif
zastonita obraz na warstwie Background. Te nieprzejrzysto$¢ mozna jednak zmniejszy¢. Stuzy do tego suwak
Opacity, umieszczony powyzej listy warstw (Rysunek 3.9.2).

Kolejnos¢ warstw takze mozna zmieni¢ — wystarczy "ztapac" pojedynczy wiersz |:I i przesunaé w nowe po-

tozenie na liscie (Rysunek 3.9.2).
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Na liscie Layers zawsze jedna warstwa jest podswietlona na niebiesko. To warstwa aktywna.

e Prawie wszystkie polecenia, ktére wywotujesz w GIMP (rysowanie, usuwanie, transformacije, filtry, itp.).
dotycza wytgcznie zawartosci warstwy aktywnej! Pozostate warstwy nie ulegajg zmianie.

Warstwa moze by¢ powigzana (z warstwag aktywng). Takie powigzanie powoduje, Ze mozna przesuwaé (El,
por. str. 76) zawarto$¢ kilku warstw naraz. Do wigczenia/wytaczenia blokady stuzy ikona "lancucha", po lewej

stronie nazwy warstwy (Rysunek 3.9.2). To powigzanie nie dziata jednak podczas innych transformacji — np.
obrotu, ani malowania. Osobiscie nigdy go nie uzywatem'.

Wreszcie — warstwe mozna ukry¢. Stuzy do tego ikona "oka", umieszczona z lewej strony nazwy kazdej war-
stwy.

Aby zmieni¢ nazwe warstwy — kliknij w nig dwukrotnie. W wierszu pojawi sie chwilowe pole edycji, w ktérym
bedziesz mogt jg poprawié.

Na koniec moze wyjasnie, pochodzenie nazw warstw w tym przyktadzie:

Background — jest to warstwa domysina. Taka warstwa istnieje w kazdym obrazie, otwartym w GIMP.
(Chyba, Ze jg usuniesz i zapiszesz cato$¢ w natywnym formacie tego programu, czyli
xcf.)

P40B-JJ-Left.tif — warstwa powstata poprzez wczytanie dodatkowego obrazu (File >Open As Layer,
por. str. 62). GIMP nadaje w takim przypadku nazwe wczytanego pliku.

! Méwiac szczerze, przez diugi czas myslatem, ze wigczenie tej ikonki Jfancucha” blokuje warstwe przed zmianami! Jezeli nawet na jakichs
ilustracjach w tym rozdziale bedziesz widziat wigczong opcje powigzania, to nic to nie znaczy.
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3.10 Dodanie warstwy (z innego pliku)

Wczytamy zawarto$¢ drugiego pliku jako dodatkowy obraz, do nowej warstwy. Zazwyczaj chodzi o to, aby nato-
zy¢ na siebie dwa rysunki, i je poréwnac. Dlatego pokaze od razu, jak ustawi¢ czesciowa przejrzystos¢ warstwy

z wczytanym obrazem.

oAby efekt przejrzystosci byt mozliwy, aktualny rysunek nie moze zapisywac barw jako tzw. indeksowanych
koloréw. Jezeli w menu Image ->>Mode zobaczysz, ze twdj rysunek ma wigczony tryb Indexed, musisz to
zmieni¢. Najlepiej bedzie, jezeli wywotasz polecenie Image >Mode >Grayscale, To zmieni odwzorowanie

barw na 256 odcieni szarosci. Mozesz takze przetgczy¢ sie w tryb barwny — Image >Mode 2RGB,.

Zataduj drugi plik jako nowg warstwe: File>Open as Layers. W oknie dialogowym wyboru pliku znajdz i wskaz

obraz — powiedzmy, ze nazywa sie P40B-JJ-Left.tif.

W efekcie zobaczysz w oknie obrazu obydwa rysunki. Wczytany obraz przykryt dotychczasowy (Rysunek

3.10.1):

== *P40B-JJRight.tif-23.0 (grayscale, 2 lay... [= |[B]X] T
File Edit Select Wiew Image Laver Colors Tools  Dialogs . i —

@ g 4 e
l.|lEI oy oy oy oo g 2000 | """ - ¥ E@! i ﬁi / = ﬁ
] s ERAGE AR L
] 4 f O X8 & B O @ o
: —
al ——l Zmiana przejrzysto-
1 ' $ci podswietlonej
x | warstwy -\

1
1

1

i

1 Iz

! [ e v o= AN
1

1

i

1

1

=1 |
L

Zatadowany, dodat-
kowy rysunek jest na
wierzchu

Oryginalna (domysI-
na) warstwa jest pod

spodem

i

|px v” 13% v|[P4DB-JJ-LeFt.tiF {27.9 VE)

+ @l

Lavers \

Maode: | Mormal

- Background

(0] « (e [ &)

Rysunek 3.10.1 Dwie warstwy rysunku, kazda z sylwetka samolotu

Otworz w przyborniku zaktadke sterujgcg warstwami (Layers - Rysunek 3.10.1). Wida¢ tu liste z dwoma wier-
Kazdy z nich to jedna z warstw. Dotychczasowa zawarto$¢ rysunku znajduje sie na warstwie
Background. (To domysina nazwa warstwy w GIMP). Druga warstwa nosi nazwe wczytanego pliku. Efekt "na
tozenia" obydwu rysunkéw na siebie wziat sie stad, ze warstwa P40B-JJ-Left.tif znajduje sie powyzej warstwy

szami.

Background, i po prostu jg zastania.
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Teraz zmienimy przejrzystos¢ warstwy P40B-JJ-Left.tif. Upewnij sie, ze jest podswietlona na liscie Layers
(oznacza to, ze jest aktywna). Nastepnie zmien wartos¢, ustawiong na suwaku Opacity, np. z 100 na 40
(Rysunek 3.10.1). Zobaczysz, ze spod spodu zaczng "prze$witywac" linie warstwy Background (Rysunek
3.10.2).

BN *P40B-JJ-Right.tif-23.0 (grayscale, 2 layers) 2480x1300
ile Edit Select Wiew Image Layer Colors Tools Dislogs  Filters

.|.|.|5'3.'3|.|.|.|.|"U.'3'3|.|.|.|.|"5.'3'3|.|.|.|.J2|?.U'3|.|.|.|.|25.U'3|.||§:¢-"E

E
Eﬁm:-n.
g B

-

] .D|_E||

[N

DDU\l

SEST

&<

||Jx v” 5%, v|[P4DB—JJ—Left.tiF {27.9 V)

Rysunek 3.10.2 Efekt wtaczenia przejrzystosci na gérnej warstwie obrazu

Copyright Witold Jaworski, 2009 - 2012.



66 Szczegdty obstugi programéw

3.11 Dodanie warstwy (pustej)

W wyniku polecenia Layer=>New Layer pojawi sie okno dialogowe New

Layer (Rysunek 3.11.1).

W polu Layer name wpisz nowg nazwe warstwy. Sposréd grupy opcji
Layer Fill Type wybierz sposéb wypetnienia tta warstwy. Zazwyczaj wy-
bieram tto w petni przejrzyste (Transparency).

Po nacisnieciu OK nowa warstwa zostanie stworzona.

Wirtualne modelarstwo — wersja 2.0

% New Layer E
=  Create a New L3 ;
DdoB-JJ-Top.ch-y— |:|

Laver name: |Mask| I

wahe (s
Height: 2827 e v

Layer Fill Type

) Foreground color Pozostaw wypetnienie

O Background copfl transparentne
) white

(%) Transparency

Help H ok H Cancel

Rysunek 3.11.1 Tworzenie nowej warstwy
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3.12  Usuniecie warstwy

Warstwe mozesz usungé na dwa sposoby:

1. Poleceniem Layer—>Delete Layer. Usuwa aktualng
warstwe (zawsze sie upewnij, ktéra jest aktualna...)

2. W zakfadce Layers: Podswietl wiersz, odpowiadajg-
cy warstwie, ktérg chcesz usung¢. Nastepnie naci-
$nij przycisk z ikong kosza (Rysunek 3.12.1).

MO 1E] Jml_

Layers [
Mode: |N0rma| v |
Opacity: - j T
tock [ . Podswietl te warstwe i
nacisnij ten przycisk
s - Backgybund ! przy

Rysunek 3.12.1 Usuwanie warstwy (zakladka Layers)
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3.13 Rysowanie

Rysowanie pokaze na przyktadzie "z zycia wzietym": na potprzezroczystej warstwie narysujemy ksztatt kadtuba.
Linie rysunku wzorcowego, do ktérego mamy sie dopasowac, sg widoczne na warstwie lezacej pod spodem
(Rysunek 3.13.5 pokazuje, co ma by¢ narysowane).

Nim zaczniesz rysowac, upewnij sie, ze tryb koloru twojego rysunku jest ustawiony na RGB. W razie czego —
przestaw go w ten tryb (Image >Mode 2RGB). Inaczej zamiast czerwonego bedzie szary!

Zacznijmy od momentu, gdy warstwy sg odpowiednio ustawione. Przed rozpoczeciem rysowania czesto zmie-
nia sie aktualny kolor. W tym przypadku wybierz czerwony (Rysunek 3.13.1).

EEX

1. Wiacz
rysowania |

tryb

2 Change Foreground Color

)
-
|, [open the color selection dialog.

Foreground & background colors, The black and whilf
squares reset colors, The arrows swap colors, Click

Rysunek 3.13.1 Ustalenie aktualnego koloru

o, ) ) ll-H-H )
oc: |

—

o

=]
4

BT T
BT T o
e T

3... by wybraé
kolor czerwony

HTML notation: | FFO00Y,

ICi

[ ()

(eew )= [ o ]

Z palety narzedzi wybierz "pedzelek” (Tools>Paint Tools 2?Paintbrush z menu, albo El na klawiaturze). Na-

stepnie ustal forme narzedzia (Rysunek 3.13.2), oraz jego rozmiar (Rysunek 3.13.3):

palC al=r Resm
Brushes ]
Civole (19} (21 = 21} Wybrany
\ , / J . _ / ksztatt
e o & © 0 O .
. . - L] - L iz, it
X X WA v o NNy
@ = 0000
8 o e F
Spacing: j 3
& 0 [ = ] 3 €

Rysunek 3.13.2 Wybér ksztattu "pedzelka™

A A= e

Paintbrush [

Maode: |Norrna| w |
. I—1

Opacity: Wybrany

rozmiar (1.5)
Brush: @|Circle (19 _/ .
|4

Scale; J =

Pressure sensikiviky

[] Fade out

[] apply Jitter

[1 incremental

[] Use colar From gradient

]

& :

Rysunek 3.13.3 Ustalenie rozmiaru rysowania

W trybie rysowania, gdzie tylko naciéniesz [L21], na rysunku pojawi sig okragta "plama”. Obrysowanie kadtuba
najwygodniej jest wykona¢ za pomocag krotkich odcinkéw linii prostych. Aby zaczg¢ takg sekwencje, kliknij |:[

Wirtualne modelarstwo — wersja 2.0
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w naroznik obszaru, ktéry chcesz zaznaczy¢. Nastepnie trzymajgc wcisniety , WCishij , i nie zwalniajac
go, przesun myszke (Rysunek 3.13.4). Widzisz, ze ciggniesz koniec prostej linii? Gdy trzymasz wcisniety [shift],

GIMP zawsze tgczy aktualne potozenie kursora z koncem ostatnio narysowanej linii. W ten sposéb mozesz
szybko i doktadnie narysowac ksztalt przysziej selekc;ji.

*P40B-1J-Top.xcf-1.0 (RGB, 3 layers) 2356x2827

File Edit Select Yew Image Lawer Colors Tools Dialogs  Filkers

‘ myszke,
el [0

g it | . . llg

Q03, 1301 |p>< W || 150%: ”6?.3 pixels, Click to draw the line (Ctl For constrained angles)

Rysunek 3.13.4 Rysowanie prostymi odcinkami

"Ciggnieta" w ten sposob linia zakonczy sie tam, gdzie zwolnisz . Po obrysowaniu ksztattu nalezy zamalo-
wac wnetrze obszaru (Rysunek 3.13.5):

Rysunek 3.13.5 Do wypetniania wnetrza wygodniej jest zmieni¢ rozmiar narzedzia na wigkszy

Jezeli pomylisz sie i narysujesz cos, czego nie powiniene$ - uzyj polecenia Edit->Undo (-E|).

e Jezeli na rysunku masz juz zaznaczony obszar selekcji — GIMP pozwoli Ci rysowac tylko wewnatrz tego
obszaru. Mozesz go wiec wykorzystywac do celowego naktadania ograniczen (np. aby na pewno zadna li-
nia nie wystawata poza zatozony obrys).
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3.14 Usuwanie fragmentéw obrazu

Do usuniecia czegos z obrazu stuzy "gumka": Tools 2>Paint Tools 2Eraser . Znajdziesz jg takze w oknie przy-
bornika, pod odpowiednig ikong (Rysunek 3.14.1). Mozesz takze skorzysta¢ ze skrétu na klawiaturze: —E'.

Po wybraniu narzedzia, wybierz jego ksztatt z zakladki Brushes. (Rysunek 3.14.1). W zaktadce opcji narzedzia

ustal rozmiar (Rysunek 3.14.2):

= GIMP CEx

Ele  ¥tns Help

B @ N L |1, Wigcz tryb

I =R usuwania _h

//Dx@&%@oa
&

"JJ 2. Wybierz

. £ najwieksze
ElCT e i A

Brushes
it (78} (28 x 29}
R ‘

Too...

. . -

@ e 0000

3 on ke, 1
) wo 5
(2 Do )= ] 8 [ % ]I

Rysunek 3.14.1 Wybér narzedzia ("gumki") i jej ksztattu

Fie #tns Help
- PAaML &R QA
- =y &”@EAIAU@E
V4 / 4828 [ §
&
il
S| S e
Eraser =
| |
Opacity: | J-mv
Brush: @\cme(w) |
Scals: 1%‘.
Pressure sensitivity
I
Ustaw odpowiednig
il skale
L
[1 Hard edge
[] Anti erase (Al)
[ & ] i I

Rysunek 3.14.2 Wybor rozmiaru gumki

Teraz juz mozesz wymazac¢ z rysunku to, czego nie ma na nim by¢ (Rysunek 3.14.3):

== *P40-org-ver.tif-4.0 (grayscale, 1 layer) 2472x720

File Edit Seleck View Image Layer Colors Tools Dialogs  Filkers

B|||||||D||||||||||25Q||||||||5p$||||||||?§Q||||||||1pq0|||||||12$D||||||||15q0||||||||1T$D|||||||I2p$0|v||||||2250|||| |25QU||
0] T \1:; """"" E‘i‘:_ "" —
] 1 T
. f Curtiss Tomahawk Il A
. ! wiersja rozpoznawcza, w kadhbie kamera
] ' F 24 o ogniskowe] 356 mm,maszt anteny
7] '
5] ! M e =
0 | A
. ! e
E . 1 lssssss)
] I ———————
] | T .
5] i "i‘nk S,
Ho <
] ! l
H Tu pojawiajg  sie
— podpowiedzi do tego, —
7 . . —
5 co aktualnie robisz! GIMP zmienia lkursor
o w svmbol aumki
i | >
2097, 654 ||3x v || I W “Click to erase (try Shift For a straight line, Chrl to pick a background color)

Rysunek 3.14.3 Wymazywanie z rysunku niepotrzebnych elementéw

Gumka Sciera, gdy trzymasz wcisniety |:[ (Ta zasada obowigzuje w Gimpie dla kazdego narzedzia: pedzla,

aerografu, itd.). Jezeli pomylisz sie i zetrzesz cos, czego nie powinienes - uzyj polecenia Edit>>Undo (-EI).

e Jezeli na rysunku masz juz zaznaczony obszar selekcji — GIMP pozwoli Ci usuwaé obraz tylko wewnatrz
tego obszaru. Mozesz go wiec wykorzystywac¢ do celowego naktadania ograniczen (np. aby na pewno nie
usung¢ niczego wiecej).
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3.15 Zaznaczenie obszarem prostokatnym

Zaznaczanie obszaru wyboru za pomocg prostokata jest w GIMP najprostszg formg selekcji. Nacisnij na klawia-
turze klawisz E lub wybierz z menu polecenie Tools 2>Selection Tools 2Rectangle Select:

— L, ™~
o
—

wskazacé poczatek
¢ |2. Trzymajgc wcisnigty
d, przesuwaj myszke

prostokata

,

T = 2\

3. Tu zwolnij D — by zazna- / o

" czy¢ krance wybranego obszaru

Rysunek 3.15.1 Zaznaczenie obszaru selekcji

Rysunek 3.15.2 pokazuje wybrany obszar. Nadal mozna go jeszcze zmieni¢ (powiekszy¢, pomniejszy¢). Stuzg
do tego uchwyty w naroznikach obszaru. (Sg tak duze, ze trudno ich nie zauwazy¢):

Za te uchwyty mozesz "ztapac"
( ) myszki i przeciagngé. To

najszybsza metoda zmiany
obszaru

Rysunek 3.15.2 Prostokatny obszar wyboru

Aby wytgczyé obszar selekcji — wystarczy wywota¢ polecenie Select>None.
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3.16  Zaznaczenie obszarem nieregularnym
Narzedzie dla ludzi o pewnej rece! Wybierz polecenie Tools->Selection Tools 2>Free Select (lub E| z klawia-

tury). Zacznij rysowac zamkniety obszar (Rysunek 3.16.1):

n
\\ 1. Tu zaczynasz
=

- nacisnij | 2| 7@“’—"

i

2. Rysujesz, trzymajac
wciénietyD
_—:—""'_J-‘_F.
&

= \

Rysunek 3.16.1 Rysowanie granic obszaru selekcji

Obszar po zamknieciu jest obrysowany linig przerywang (Rysunek 3.16.2):

Rysunek 3.16.2 Przykfad nieregularnego obszaru selekcji

Aby wytaczy¢ obszar selekcji — wystarczy wywotaé polecenie Select->None.
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3.17 Zaznaczanie — narysowanym obszarem

W GIMP obszar selekcji moze by¢ dowolng plama/plamami. Moze takze mie¢ rozmyte krawedzie. Takie efekty
mozesz uzyskac tylko w jeden sposob: malujgc obszar selekgciji, tak jak maluje sie jakis ksztatt.

e Narysowanie obszaru selekcji nie zadziata, jezeli rysunek jest zapisany w trybie tzw. indeksowanych barw.
Aby mie¢ pewnos¢, ze wszystko bedzie poprawnie, przetgcz go w tryb RGB (Image ?Mode 2>RGB)

Pokaze, jak to zrobi¢ na przyktadzie opisanym w pierwszej czesci tej ksigzki (str. 39). Chodzi o objecie $cisle
"przylegajacg" selekcjg rysunku tylnej czesci kadtuba samolotu. Linie rysunku znajdujg sie na warstwie o nazwie
Background.

Obszary selekcji bedziemy malowaé na oddzielnej warstwie, kidrg stworzymy wytgcznie dla tego celu. Wywotaj
polecenie Layer>New Layer. Dodaj do rysunku na nowg warstwe, o nazwie Mask (szczegoty — str. 66). War-
stwa musi by¢ zupetnie przejrzysta. (Podczas tworzenia, w oknie dialogowym New Layer, okresl kolor tta jako
Transparency).

Rysunek 3.17.1 pokazuje, jak nalezy przygotowaé ukiad

warstw (szczegdty - str. 62): 4 g A
. > _ Z[o]H] el
- Ukryj wszystkie inne warstwy poza Mask i Background; Warstwa ze wzorem -
) ) Layers do obrysowania o)
- Przesun warstwe ze wzorcem ksztattu do narysowania — |j.4e: [wormal 3z
Background — ponad Mask; Opacity: 100 |4

Ustaw nieprzejrzysto$¢ Background na 50%, by wygod- |k 1§88

4
@ Background
: [EES s Mask — aktywna

P40B-11-Left. Lif

#
ﬂg Pozostate warstwy — D o

ukryte

niej dopasowac rysowany ksztatt do linii kadtuba;
Podswietl Mask, aby stata sie warstwg aktywna.

Rysunek 3.17.1 Zmienione uporzadkowanie warstw

Po ustaleniu stanu warstw nalezy na warstwie Mask obrysowac i wypehi¢ (szczegéty — str. 68) ksztatt kadtuba
(Rysunek 3.17.2):

ol

L E
o m - )

Rysunek 3.17.2 Rysowanie ksztattu selekcji
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Na koniec zmien narzedzie na "gumke" (Tools >Paint Tools 2Eraser, z klawiatury -El). Ksztalt narzedzia

pozostaw bez zmian, za to rozmiar przestaw na 1.0. Uzyjemy go do drobnych wygtadzen i korekt narysowanego
ksztattu, np. wymazania naddatku linii (Rysunek 3.17.3).

i

1

.
-
a

C o e

"

Wymazany naddatek

Rysunek 3.17.3 Koncowe przygotowania - wymazanie "naddatkow"

Pozostaje zmieni¢ narysowany ksztalt w selekcje. Wywotaj polecenie: Layer—=>Transparency>Alpha to

Selection.

| to wszystko. Na koniec porzadkujemy warstwy (Rysunek

3.17.4):

- ukryj Mask (mozna by jg bylo usuna¢, ale moze sie przydac
przy nastepnym takim przypadku);

- odkryj inne warstwy (te, ktére sg potrzebne do dalszej pracy);

- podswietl warstwe, na ktérej chcesz co$ zmieni¢, za pomoca
aktualnie wybranego obszaru (np. Background). (Stanie sie w
ten sposob warstwa aktywna)

SCaE Fm ]

Layers Mask wylgczona i =
Mode: | plormal ukryta e |
: 1 ~
Opacibd - LU et
/ Background do-
Lo [ |stepne do zmian

Lk

O
ﬂ .Mask

v

' Background

Pozostate
— widoczne

warstwy

(D )Ce (s (&) &« [ 8 ]

Rysunek 3.17.4 Przygotowanie warstw

o W GIMP ksztalt selekcji "przenika" przez wszystkie warstwy. Nie jest zwigzany w szczegdlny sposéb z
zadng z nich. Dzieki temu warstwa, na ktérej go rysowates, moze by¢ zaraz usunieta
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3.18 Obroét

Jezeli w GIMP jaki$ obszar jest wybrany (selekcjg) — obrét bedzie dotyczyt tylko tego obszaru. Jezeli jednak nic
nie jest wybrane, obracana jest cata zawartos¢ warstwy aktywnej. Operacje pokaze na przyktadzie wtasnie ta-
kiej sytuaciji.

Wywotaj polecenie Tools 2>Transform Tools 2Rotate (—E|). Pojawi sie dodatkowe okno Rotate (Rysunek
3.18.1). Zauwazysz takze pewne pogorszenie jakosci wyswietlanego obrazu. Linie staty sie mniej gtadkie, gdyz
GIMP przetaczyt sie na wyswietlanie "roboczej kopii" rysunku. Pokazuje teraz, jak bedzie wygladat obraz, gdy
zatwierdzisz ten obroét. (Czyli taki, jaki bytby, gdybys w tym momencie nacisngt przycisk Rotate. Jezeli naci-
$niesz Cancel - zrezygnujesz z catej operaciji).

e Edit  Select Miew Image Layer Colors  Tools  Dialogs  Filters

Eil
B |DI|I|I|I||2$q|I|I|I||5pQ|I|I|I||?5Q|I|I|I||1quI|I|I||12$D|V|I|I||15qnul|I|I||1Y$D|I|I|I||2pQD|| " ||2250| |I|I|QSQd

il
|

Curtiss Tomahawk [ A Y
wadok z praws] Fieny ¥

?M

1 11 1L

Z] i iK & W
£] - | To jest znacznik $rodka obrotu /
0] Mozesz go przesuwac !
. - T
d - P
5] | B Rotate el 1 =
o4 ™ Background-10 (P40-org-RE 1if) =
o

I j — £
e ) - | l," r1 1
17| Centers 134400 [T L e
0+ ~ Tl \\, e

I conterys (4700 [ ox v e ra

1 l Help l ’ Reset l [ Ratate l l Cancel 4’
134

Rysunek 3.18.1 Okno obrotu obrazu (Rotate)

Zwro¢ uwage, ze okno Rotate nie przeszkadza w zmianie powigkszania widoku, ani w przesuwaniu poziomym i
pionowym suwakiem. To bardzo wygodne, gdyz z wiekszg doktadnoscig mozesz obserwowac¢ zgodno$¢ linii
pomocniczej i linii na kadtubie samolotu. Podczas obrotu pokazywana jest takze 0§ obrotu — koétko z krzyzy-
kiem, wygladajgce jak celownik (Rysunek 3.18.1). Mozesz w kazdym momencie jg ztapac (|:l) i przesung¢ w

nowe miejsce.

Obraz mozna obracac przesuwajgc myszke z wcisnietym |:[ (dobre na pierwsze przyblizenie). Mozna takze

zmieni¢ numeryczng wartos¢ kata obrotu w oknie Rotate, polu Angle (tak najwygodniej wprowadza¢ ostatnie,
drobne poprawki). Wartos¢ kata w polu Angle zmienia sie takze wtedy, gdy obracasz obraz myszka.

Obroét zatwierdzamy naciskajgc przycisk Rotate. Jezeli obracaliSmy tylko wybrany obszar — po zakonczeniu
obrotu nalezy dodatkowo wywota¢ polecenie Layer-=>Anchor Layer, by "zatwierdzi¢" rezultat operacji.
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3.19 Przesuniecie

Jezeli w GIMP jakis obszar jest wybrany (selekcjg) — przesuniecie bedzie dotyczy¢ tylko tego obszaru. Jezeli
jednak nic nie jest wybrane, zmianie ulega cata zawartos¢ warstwy aktywne;j.

Transformacje zademonstruje na przyktadzie, gdzie przesuwam fragment potprzejrzystego obrazu z gérnej (ak-
tywnej) warstwy ponad obrazem na drugiej warstwie. (Zostat tam umieszczony jako wzorzec). Na warstwie ak-
tywnej jest zaznaczony prostokatny obszar (Rysunek 3.19.1). Nacisnij na klawiaturze E (jest to skrot polecenia

Tool>Transform Tools ?Move). "Ztap" zmieniamy obszar () i przenie$ we wiasciwe miejsce:

Zaznaczony frag-
ment (warstwa
aktywna)

- "Ztap" (| 5:\1}) zazna- I‘

Y1l czenie i przesun

»|Zarys  obrazu
wna  fragmencie
uldo przesunigcia

| |zarys obrazu
wzorcowego

Rysunek 3.19.1 Przesuwanie fragmentu obrazu

Przesuniecie kohczysz, zwalniajgc (Rysunek 3.19.2):

Obrys ustrzenia jest
doktadnie nasuniety
na obraz wzorcowy

Fragment po
przesunieciu

Rysunek 3.19.2 Obraz po przesunigciu

Na koniec wywotaj polecenie Layer>>Anchor Layer (-E|). To scali "ptywajacy” ponad rysunkiem, deformo-

wany obszar, z resztg obrazu, i zakonczy catg operacje.
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3.20 Przekoszenie (Shear)

Jezeli w GIMP jakis obszar jest wybrany (selekcjg) — transformacja bedzie dotyczy¢ tylko tego obszaru. Jezeli
jednak nic nie jest wybrane, zmianie ulega cata zawarto$¢ warstwy aktywne;.

Transformacje zademonstruje na przyktadzie, gdy wybrany jest prostokgtny obszar. Wywotaj polecenie
Tools >Transform Tools ?Shear (lub —E|). Pojawi sie dodatkowe okno Shear (Rysunek 3.20.1). Zauwa-
zysz takze pewne pogorszenie jakosci obrazu w zaznaczonym obszarze. Linie staty sie mniej gtadkie, gdyz
GIMP przetaczyt sie na wyswietlanie "roboczej kopii" tego fragmentu. Pokazuje teraz, jak bedzie wygladat ob-
raz, gdy zatwierdzisz te transformacje. (Czyli gdy nacisniesz przycisk Shear. Jezeli nacisniesz Cancel - zrezy-
gnujesz z catej operacji).
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? Backgraund-55 (P40BE11-Right tif)

Shear magnitude %: h‘

Shear magnitude ¥: |0

Help ] [ Reset

Rysunek 3.20.1 Przekoszenie (poziome)

Polecenie Shear dziata podobnie do obrotu. (Zresztg wszystkie transformacje w GIMP dziatajg w taki sposab).
Obecnos¢ okna Shear nie przeszkadza w zmianie powiekszenia widoku, ani w przesuwaniu pionowym i pozio-
mym suwakiem. Przekoszenie nie ma, niestety, widocznego srodka, ktéry mozna by byto przesungé. Punkt ten
jest staty i znajduje sie w srodku obszaru selekgc;ji.

Podswietlony na rysunku fragment mozna deformowac przesuwajgc myszke z wcisnietym |:[ (dobre na
pierwsze przyblizenie). Mozna takze zmieni¢ numeryczng wartos¢ transformacji w oknie Shear, polu Shear
magnitude X (Rysunek 3.20.1) (tak najwygodniej wprowadza¢ ostatnie, drobne poprawki). Wartos¢ w polu
Shear magnitude X zmienia sie takze wtedy, gdy dokonujesz deformacji myszkg. Przekoszenie zatwierdzasz
naciskajgc przycisk Shear.

e W GIMP nie wskazujesz $rodka tej transformaciji. Po jej zakonczeniu zmieniony fragment moze leze¢ nie-
zupetnie tam, gdzie trzeba. Trzeba go wtedy przesungé (IE, por. str. 76) we wtasciwe miejsce.

Na koniec wywotaj polecenie Layer>Anchor Layer (-E). To scali "ptywajgcy" ponad rysunkiem, deformo-

wany obszar, z resztg obrazu, i zakonczy catg operacje.
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3.21 Skalowanie

Jezeli w GIMP jaki$ obszar jest wybrany (selekcjg) — zmiana skali bedzie dotyczyta tylko tego obszaru. Jezeli
jednak nic nie jest wybrane, zmianie ulega cata zawarto$¢ warstwy aktywnej. Operacje pokaze na przyktadzie
wihasnie takiej sytuaciji.

Wywotaj polecenie Tools 2>Transform Tools >Scale (lub —). Pojawi sie okno dialogowe Scale (Rysunek
3.21.1). Zauwazysz takze pewne pogorszenie jakosci wyswietlanego obrazu. Linie staty sie mniej gtadkie, gdyz
GIMP przetgczyt sie na wyswietlanie "roboczej kopii" rysunku. Pokazuje teraz, jak bedzie wygladat obraz, gdy
zatwierdzisz te zmiane skali. (Czyli gdy naci$niesz przycisk Scale. Jezeli nacisniesz Cancel - zrezygnujesz z
catej operacji).

l‘m

File Edit Select Yiew Image Lawer Colors Tools  Dialogs  Filkers
N v T O 1 S RS - s U S O 11« PR |
’
1.Tu kliknij D b )
. [ {rospencs e A = scale 3
a rozprzac zmiane -
T ] wymiar - Scale
1 T Tk Backgringd-3 (P40B-1)-Tap xefl
: + I. o
7] g I I width: | 2356 e Jednostka mial
1 |2.Tu  wpisz  nowg S A X - np. piksel! i
] g . 2Ll Height: L2827| N | pixels V|
s SZ‘?rrOkOSC lub wyso- il 2356 x 2827 pixels
i 1 [kos¢ ' 300 ppi
1 ban 1 B % i} [l
h : ST S U
T : x»,?% 'I o K ’ Help ] I Scale I ’ Cancel
0] 1 -
o] | |
a 1 ’
_ : -2
T - Skale mozesz takze zmie-
] nia¢, tapigc za te
% ~E uchwyty
a| S
a g
. 11 [
LT —
B | >4
|p>< v” 15%: v“Background (53.9 ME)

Rysunek 3.21.1 Zmiana rozmiaru obrazu w kierunku pionowym

Zwro¢ uwage, ze okno Scale nie przeszkadza w zmianie powiekszania widoku, ani w przesuwaniu poziomym i
pionowym suwakiem. To bardzo wygodne, gdyz z wiekszg doktadnoscig mozesz obserwowac¢ zgodnos$c¢ linii
pomocniczej i linii na rysunku samolotu.

Jezeli nie zamierzasz zmienia¢ skali tak samo w obydwu kierunkach: upewnij sie, ze wysokosc¢ i szerokos¢ sg
"rozprzegniete". (Ogniwa fancucha w oknie dialogowym Scale powinny byé przerwane). Nastepnie w polu
Height lub Width wpisz nowy rozmiar obiektu.

Transformacje zatwierdzamy naciskajgc przycisk Scale. Jezeli przeksztatcaliSmy tylko wybrany obszar, a nie

catg warstwe — po zakonczeniu skalowania nalezy dodatkowo wywota¢ polecenie Layer->Anchor Layer. To
"zatwierdzi" rezultat operacji.
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Rozdziat 4. Inkscape — szczegoly obstugi

Na Inkscape natkngtem sie przypadkiem. GIMP miat tylko marginalne mozliwosci rysowania linii wektorowych. A
ja szukatem wiec czegos, w czym mozna by byto wygodnie rysowac (i poprawiac) linie nitdw i tgczenia blach.
Gdy jednak wertowatem jego plik podpowiedzi, szukajgc szczegotow tej funkcii, natknagtem sie na zdanie:
"Rysowanie linii w GIMP nie jest tak wygodne, jak w wyspecjalizowanych programach, np. Inkscape".

Co to jest to "Inkscape"? Wystarczyto wpisaé to hasto w Google, by znalez¢ strone tego projektu. Jest to naj-
miodszy z programéw, uzywanych w tej ksigzce. Nie osiggnat jeszcze "petnoletniosci" (aktualne wersje maja
nadal numer ponizej 1.00). W zwigzku z tym potrafi czasami sie "zawiesi¢", lub zakonczy¢ sie nagle z jakims
krytycznym btedem. Na szcze$cie nie dzieje sie to zbyt czesto. W kazdym razie nie zapominaj o czestym zapi-
sywaniu swojej pracy do pliku!
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4.1 Instalacja Inkscape

Po uruchomieniu programu instalacyjnego pojawia sie ekran "powitalny", a nastepnie ekran z umowg licencyjng
(Rysunek 4.1.1):

E E m! # Inkscape -- Open Source Scalable Vector Graphics Editor E]lglgl
License Agreement
Welcome to the Inkscape 0.44 0 Plesse review thelicense terms before instaling Inkscape 0,44,
Setup Wizard
This wizard will guide you through the installation of Inkscape Press Page Down to see the rest of the agreement.
0.44.
GMUI GENERAL PUBLIC LICENSE ~
Itis recommended that you dose all other applications Wersion 2, June 1991
before starting Setup. This will make it possible to update
relevant system files without having to reboot your Copyright (C) 1989, 1991 Free Software Foundation, Inc.
computer, 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
Click Next to continue. of this license document, but changing it is not allowed.
Preamble
The licensses for most software are designed to take away your v

Inkscape 0.44 is released under the GNU General Public License (GPL). The license is provided
here for information purposes only, Click Next to continue,

T e

Rysunek 4.1.1 Instalacja GIMP — pierwsze dwa ekrany

Po nacisnieciu przycisku I Agree na ekranie License Agreement, przejdziemy do ekranu Choose Components
(Rysunek 4.1.2):

% Inkscape -- Open Source Scalable Vector Graphics Editor E|E\@‘ {7 B E m‘l
Choose Components Choose Install Location
Choose which it to install. Choose the folder in which to install Inkscape 0.44.
Wytgczone trans-
lacje na jezyki
Check the components you want o install ar n't want to Setup will install Inkscape 0.44in the following folder. To installin a different folder, dick
install. Click Mext to continue, obce - poza Browse and select another folder. Click Install to start the installation.
angielskg
Select components to install: A
[Jes Spanish
[ es_Mx Mexican Spanish
[l es Estonian Destination Folder
B
Dea wish “ F:\Program Files\Inkscape Browse...
[
Description
Space required: 90. 1MB Space required: 50, 1MB
Space svalable: 96,568
[ <8adk ][ Mext> ] [ Canced <Back | Instal | [ Cancel

Rysunek 4.1.2 Wybor opcji instalacji

Warto dopilnowa¢, aby na ekranie Choose Components. wytgczy¢ z komponentéw wszelkie ttumaczenia poza
angielskim (obowigzkowe) i polskim. Na ekranie Choose Install Location mozna zmieni¢ domysiny folder pro-
gramu.

Po nacisnieciu przycisku Install wykonuje si¢ instalacja (Rysunek 4.1.3):

aEg

# Inkscape - Open Source Scalable Vector Graphics Editor g|§|g|

Completing the Inkscape 0.44 Setup
Wizard

L3
Installing
Please wait whie Inkscape 0.4 is being installed.

Extract: _init__pyc

Show details

Inkscape 0.44 has been installed on your computer.

Click Finish to dose this wizard.

Run Inkscape 0,44

Rysunek 4.1.3 Instalacja Inkscape - ekrany: postepu i finalny
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4.2 Wprowadzenie

Rysunek 4.2.1 pokazuje, jak wyglgda ekran Inkscape zaraz po pierwszym otwarciu:

“ New document 1 - Inkscape

Przyciski, wywotujace panele:
e  Wiasciwosci obiektu,
e Wiasciwosci tekstu.
Zarzadzanie warstwami

Fle Edit Wiew Layer ©Object Path Text Fiters Extensions Help
(¥ o /= de
NBEEE Ak %0 eeQ@ nad @8 FTeRE %0
B o VY R SF ST | ¥ 200003 v 30000003 wo|zE00ocd H|300.000%5 px | affect:
® : 7 xlmons 1 [moxd] w [moxs 3 nlmox ;
p— -500 1 250 500 1000 =y
‘*‘}.IIIUHdO/RedO |I|I|I|I|||I|I|I|||I|I|I|I|||I|I|I|I|||I|I|I|"||||I|I|I|I|g|
-l I h
b - — .
1 Potozenie wybrane- Rozmiary wybra-
ﬁ ] go obiektu nego obiektu
[ ]:-
a =
Q-
O I Przybornik z
g 4 narzedziami
|
Y| e
Eg’ § | ‘
l@- - - -
Al -
ey | - YN 3
g
0 -
- Doktadna zmiana
la\‘n E powigkszenia
nﬁ‘ "1_' Aktualne barwy i
al . nieprzejrzystos¢ Sterowanie \kN?po:rzedne
é E warstwami ursora
b
2}
E::"r:oke: None oo {'# a ‘Layer 1 % ||[Rectangle in laver Layer 1. Click selection to toggle scalefrotatio ﬁ 1222:?3 7 3% &

Rysunek 4.2.1 Okno Inkscape

Okno programu jest tu jednoczesnie oknem obrazu. Wokét krawedzi sg rozmieszczone réznorodne przyborniki
z ikonami (Rysunek 4.2.1). Pionowo, po lewej — przybornik z narzedziami edycji. U géry — m.in. pola umozli-
wiajgce zmiane potozenia i rozmiaréw wybranego obiektu.
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4.3 Otwieranie i zapisywanie do pliku
W poprzednich wersjach Inkscape wykorzystywat takie same okna wyboru plikéw, jak w Gimie (por. str. 55). W

ostatnich wersjach, po wybraniu polecenia File 2Open, pojawia sie standardowe okno wyboru plikéw Windows
(Rysunek 4.3.1):

Select file to open E
Saukajw: | () B.02 ¥ 02 > E (@
), =] 0001.prg £
1 2? Eﬂ 75.png - I
Muaje biszace C'] calor.png Podglad  pod- s |
dokumenty | |[%] decals.prig $wietlonego =
. . B pliku (o ile nie »
|__ jest zbyt duzy) o
G &
Pulpit 5] &
! ""/ decals
oje dokumenty 7o kE
12512

k) komputer
.% Mazwa pliku: |decals.svg b | [ Otworz l
Muoje migjzca o ; -
R!Enim\l",_ Fliki typur |AII Inkscape Files - | [ Arilug ]

Rysunek 4.3.1 Inkscape - okno wyboru plikéw

Inkscape umozliwia podglad zawartosci pliku, pod$wietlonego na liscie — ale tylko do pewnego rozmiaru. Po
nacidnieciu przycisku Open, w Inkscape pojawi sie zatadowany plik.

Podobnie w przypadku zapisu pliku (polecenie File->Save As): obecna wersja Inkscape tu takze uzywa stan-
dardowego okna Windows (Rysunek 4.3.2):

Select file to save to

Fapizz W |L':} 04_Save V| G ? # -

D

Moje biezgce
dokumenty

'—-[":

Pulpit

9

Faje dokumenty

M aj komputer

Mazwa pliku:

Zapisz jako typ: |Inkscape SYGE ["ava) v| [ Anuly ]

toje mileisc:a Title: | |

Rysunek 4.3.2 Inkscape - okno zapisu plikéw
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4.4 Ustalenie rozmiaru obrazu

Wywotaj polecenia File 2Document Properties. (Rysunek 4.4.1):

" New document 1 - Inkscape

=8 Edit  Wiew Layer ©Object Path Text Effects Whiteboard Help

Hew S BRER & »
= open... Ctr+0 ey r=1E"3
Open Recent 3 E= 5 == »
pen 2 o @Document Properties {Shift-+Cerl+D) =
= I ||2_r. q
jug| Rewert A I BRI
E Save Chrles Page |Guides Gtids | Snap | Snap points -~
General
& save bs... shift+Ctrl+5
Defaulk units: | pe ﬂ
Save a Copy.,.. Shift+CErl+AlE+S
Background: SRSty
-B Import... Chrl+1
(B Export Bitmap... Shift+CErH-E Format
A4 210.0 x 297.0 rm
& Brint... Chrl+P LS Letter 8.5%11.00n 0
Page size: i
(a Vacuum Defs :\\ U3 Legal 8.5x 14.00n
1T-"""" AN LS Executive 7.3x%10.5in T - -
®d Document Properties.., ograzv::plsz wymiary
p— ey o B 7 Page orientation: erait @
Document Metadata, ., % P -
ustom size
‘é‘%, Inkscape Preferences,.,  Shift+Chrl+P widthe |z300.00 = 3
bl : . w | |PX
Input Devices, .,
Height: | 1000 % | [Eit Pge to selection |
 Cose Chrl+w AN Ustalenie ich w
! Border pikselach  utatwi
ol Quit o eksportowanie do
Q e Show page border pliku rastrowego
9 - [] Border on top of drawing
S |Obszar, ktory ustalasz p. 4
AI N Show border shadow
#EI i Border color: IS |

Rysunek 4.4.1 Ustalenie rozmiaru dokumentu

W oknie dialogowym Document Properties, w pola Width, Height sekcji Custom size, wpisz wymiary dokumen-
tu. Sugerowatbym, aby — dla wygody — zatozy¢, ze 1 jednostka Inkscape = 1 piksel weryfikowanego obrazu.

Okno Document Properties nie ma przycisku "OK." — zmiany zostajg wprowadzone, gdy tylko opuscisz to ok-
no.
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4.5 Wstawienie dodatkowego obrazu rastrowego

Wywotaj polecenie File>Import. W oknie dialogowym wyboru plikéw, ktére sie pojawi, wskaz jakis plik rastrowy
(Rysunek 4.5.1a):

Y ct file to import

Saukaj v | [ Rysurki v | Q T e - |
Y Mazwa Rozmiar Tvp [ 15
\_gﬁ =] P40C-ML-Right. LiF 312KB  Obraz TIF 2
Moje biezgce E'] P40C-ML-Left2 L 312KB Obraz TIF 2 i
dakurment = ! I .
Y E]P‘iDC-ML-SBEtIDnS-tIF Wskaz pllk r z b i
= ] P40C-ML-Combine. png rastrowy iley & »
L %] P40C-ML-Frant.p o ro—oorEr PhG 2
Pulpit : Top. ki 586 KE Obraz TIF 2 Wybieraj zawsze te
] P40C-PL-Biottom, ki 593 KE  Obraz TIF 2 opcie, by pliki SVG nie
- =] P40B- 13-Biktom. kF 618KE Obraz TIF 2 P4OC-ML-Top byly zbyt duze
’__j &) P40B-13-Tap 1 640 KB Obraz TIF 2 585 kB
Maje dokumenty %] P40C-ML-Left1.png 856 KE  Obraz PNG 2 2827 % 2330
%] P40C-ML-Left.png B60KE  Obraz PNG 2
] P40C-ML-LeFt2.png B03KE Obraz PNG 2
'31)3 %] P40C-MiL-Battom.prg 1460 KB Obraz PG 2 (S Rtiff GDK pixbuf Input
- k'om ter ] P40C-ML-Top. png 1498 KB Obraz PNS 2 ok bed
Jlsetugs s P4DC-ML-Combine. bga 3054KE TrueVision Targa L Mt G GETErS6) T ) embed
N b @ lirk
< | >
. — — [\ Embed results in stand-alone, larger SWa Files,
= . B , Link references a file outside this SYG document
Moje misjsca Nazwa pliku: |F'4DE-ML-T0p.t|f 4 | [ Dtwdrz I" " and all files must be moved together,
FiECiowE - -
Pliki bypu: |AII Inkscape Files v | [ Anuluj ] i 1
[ Cancel l | ok |

Rysunek 4.5.1 Wybor pliku rastrowego

Gdy nacisniesz przycisk Otwoérz, Inkscape wyswietli jeszcze dodatkowe okno dialogowe (Rysunek 4.5.1b).
Wybierz na nim opcje link. Wéwczas wybrany obraz zostanie wstawiony do aktualnego rysunku (Rysunek
4.5.2):

" PA0C-ML-Combine.svg - Inkscape :IIEI[‘S_TI
File Edit Wiew Lawver Object Path Text Effects ‘whiteboard Help
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A A
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£ - : \ :
Q, | "oE _ ' :
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N SR S IR :
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Obraz | / E ' E
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ZLCZ ] SN s i e = - Dodany, =t |
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o : i : B
A - R s n
&
o o
b N bt
/o« | TN
;it"r:oke; 3:::: O:v 5 3| oot Z| Image with bad reference: P40C-ML-. é 2;22:22 Z::

Rysunek 4.5.2 Kolejny obraz rastrowy, dodany do dokumentu Inkscape
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4.6 Widok: powiekszanie, przesuwanie

Obstuga zmiany powigkszenia (zoom) i przesuwania obrazu (pan) jest w Inkscape prawie taka sama jak w
GIMP.

Zmiany powiekszenia mozna dokona¢ na dwa sposoby:
- szybko i mniej doktadnie: trzymajgc wcisniety i obracajgc kétkiem myszki (D);

- dokfadnie: wpisujgc %powigkszenia w pole Zoom, u dotu ekranu (Rysunek 4.6.1);

" P4DC-ML-Left.svg - Inkscape
Fle Edt Vew Layer Object Path Text Effects whiteboard Help

DEEL PR ee DX0D QAQ BEE|E -
e e

h 2| E==x

" P40C ML Left.svg - Inkscape

Eile Edit W¥iew Layer Object Path Text Effects  Whikely
DEEE BE «e| D D TEE EE P
5 o0 2 wom |* @ nloa Severerrent
A - , AL AT e
— Metoda bezposrednia:
5 o] L]

i rif -
P Ctrl
mi T
o — s gl
Ok 3 e e SEL [T
z@, ) - % &\“ VA

/—— R g i 4

¥ - < | b
V- B e MR o[ ] R comecim v Noobjecsseete ¥ 72928 210w, |2
® '
Al 7— Metoda doktadna: wpisz w

) to pole warto$¢ powiek-
g‘:"& ) szenia (W %) ﬁ
FN .

| N

. A
Tl | S
E't”r’nke: zj:ﬁ o:l:l 45 @ | Correction lennh]Ectssalectad. Click, Shift-+click, or drag i fz:i:gg s s |3

Rysunek 4.6.1 Widok: dwie metody zmiany powiekszenia (Zoom)

Przesuniecie widoku to ruch myszki z wcisnietym D (identycznie jak w GIMP — str. 60). Mozesz takze uzyc¢

w tym celu paskéw przewijania (scrollbars), umieszczonych z boku ekranu.

Dodatkowo, zgodnie ze standardem Windows, obrot D powoduje przewijanie obrazu w goére i w dét. Juz poza

tym standardem, kombinacja - [ przesuwa widok w poziomie.
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4.7

Warstwy — zarzadzanie

W Inkscape, podobnie jak w GIMP, istniejg warstwy, za pomocg ktérych mozesz grupowaé elementy rysunku.
Gdy wywotasz polecenie Layer->Layers (——), na ekranie pojawi sie dodatkowy panel (Rysunek

4.7.1):

New document 1 - Inkscape E”E”?_q
File Edit Wew Layer o©Object Path Test Effects ‘Whiteboard Help Kliknij w nazwe warstwy
] o — i mozesz jq od razu
DEEHE AR el D=—on NEE & BTREE {mema
: Przetgcznik Zmienic:
@ ED s o = blokady zmian | v |o.000 e w [o.001 [* H (ool |*
&k :P a : i :m| | | 3 | 19( | = Zamyka panel
_ T e P AR R Przetacznik T Q Liars (Shift+Ckr+L B =4
1 . P ——a ]

—= widocznosci - %
E v |Dodaje warstwel
Qb | -/ LICIENF

"4 Poziom  nieprzejrzystosci Bendmode: [ormal  MIN—
D - (aktualnej warstwy)

i Opacity, %%
@ —] ‘ 0o |,

Rysunek 4.7.1 Panel zarzadzania warstwami

Panel sterowania warstwami zapewnia petng kontrole ich stanu. Zwré¢ szczegoing uwage na kontrolke Opacity
— zmienia przejrzystos¢ podswietlonej na liscie warstwy. Bedziesz jej czesto uzywat. Panel Layers (i wszystkie
inne) mozesz "schowac" lub przywota¢ z powrotem naciskajac El (View >Show/Hide Dialogs)

Oprocz paneli zarzadzania, Inkscape ma dodatkowg kontrolke u dotu ekranu (Rysunek 4.7.2). Za pomocg tej
listy rozwijalnej i dwdch przetgcznikow mozna:

- zmieni¢ aktualng warstwe;

- wigczy¢ lub wytgczy¢ widocznos¢ warstwy;

- wigczy¢ lub wytaczy¢ blokade zmian dla obiektow umieszczonych na warstwie.

New document 1 - Inkscape

File Edit Wiew Layer Object Path Text Effects Whiteboard Help
DBE& solE ¢ Dl Q@@ Daa & BPTRE »
Q[ E =55 oo |3 Y|DDDD [$ wlooo |2 @ nfooor |* »
(| |1 [ I B |2:-"1 BN 1-71 S Q iSlayers (Shift+Cerl+L) H®
Tu mozesz sie
E"\'E' i przetaczy¢ na :
L] ¥ inng warstwe & R Image
£
Qi ()7 [+ [8]&][=]
l:‘ : Tu mozna Blend mode: | Mormal :I
_ |przetaczy¢ Opacity, %
@ _ - |widocznos¢ 1000 o
4==_I-Jiblokade } \______|__}____ __ __ __ e _
. [0 et st Bttt \: ——————————————————————
/ @ [ . 50
;it"r:oke: mg O:I:I (<] @.I -Drawing Z|No objects selected, Click, Shift-+click, or drag arou.i;lggé:zg Z::

Rysunek 4.7.2 Elementy szybkiego zarzadzania warstwami

Z kontrolki umieszczonej u dotu ekranu korzysta sie najczesciej, gdyz nie zajmuje tyle cennej przestrzeni ekra-
nu, co panel Layers.
Warto zwréci¢ uwage na pewne konwencje prezentowania nazwy warstw na liscie rozwijalnej:

- nazwa zablokowanej warstwy jest ujeta w nawiasy kwadratowe.

- nazwa warstwy ukrytej jest szare, a nie czarna.

W ten sposéb, zaraz po rozwinieciu listy, mozesz sie szybko zorientowac co do stanu kazdej z warstw.
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4.8

Warstwy — dodanie nowej

Otworz panel Layers (Layer—>Layers). Na panelu nacisnij przycisk [*+]. Mozesz takze (alternatywnie) uzyc¢ po-
lecenia z menu: Layer>Add Layer.... Pojawi sie okno dialogowe nowej warstwy (Rysunek 4.8.1):

Elle Edit ‘iew Layer Ohject Patl

IS T

Domysinie:
wstaw  ponad

DEEHE PR eoe Dx%0 QAQA I TERE fH FTRE »

- [oX]

Effects ‘Whiteboard Help

==

| 15 = 53 57| =[ooo0 [$ v|ooo0 £ w oot [* @ Hooor [ »

0 i 500
I T T e IO . Layers (Shift+Chrl+L (]
|Tu wpisz nazwe Stayers( ) O

| W @ Image

|
Layer name: |Drawing| |

KBTI

aktualng

Positiﬂnbove current
Blend mode: ‘Normal ﬂ

[ Cancel l l Add ] Opacity, %

Rysunek 4.8.1 Dodawanie nowej warstwy

- J[1o0o]s
|

W oknie Add Layer wpisz w pole Layer name nazwe nowej warstwy. W polu Position mozesz ustali¢, w ktérym
miejscu na liscie ma by¢ umieszczona (powyzej lub ponizej warstwy aktualnej).
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4.9 Warstwy — usuwanie

Otworz panel Layers (Layer—=>Layers). Na panelu podswietl warstwe do usuniecia i nacisnij przycisk (=]
(Rysunek 4.9.1). (Mozesz takze — alternatywnie — uzy¢ polecenia z menu: Layer—>Delete Current Layer..).

" New document 1

- Inkscape

CEX

ktorg chcesz usungé

Second

FiIe Edit View Lawer Object Path  Text Effects ‘Whiteboard Help
DE&E& HEh o DD QQ@Q TDEaw @& FPTEHE »
1 £ == 57 o000 (& vioooo & wlooor [* @ Hfooor [* ’_j
e o ooy |2’j Coco PP 0 Q| E3ayers (shift+cere ® ®
L‘ 4 1. Podswietl warstwe, -

ﬁ ] L] a Layer 1
1.
Q, i (+] %]« [2])(2]
3 Blend rpada:—tlarmal Z|
|:| r o t2. Nacisnij
N Pactlten przycisk
D - T D e

Rysunek 4.9.1 Usuniecie warstwy
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410 Linie pomocnicze (guides)

W Inkscape mozesz uzy¢ linii pomocniczych (guides). Stuzg do zaznaczania jakiego$ istotnego miejsca, a takze
poréwnan. Tworzy sie je tak samo jak w GIMP: poprzez "wyciggniecie" z linijki z boku lub z géry ekranu

(Rysunek 4.10.1):

[ L

- - — - |F
i trzymajgc wcisniety
przesuwaj myszke

w prawo

_|Przesuwana
pomocnicza

linia

Rysunek 4.10.1 "Pobranie” linii pomocniczej

Linia pomocnicza nie jest czescig obrazu — nie jest drukowana, ani nie pojawia sie w obrazach wyeksportowa-

nych do pliku rastrowego.

Istniejgce linie pomocnicze mozna przesuwaé. Gdy zblizasz do nich
wskaznik myszki na odlegtos¢ kilkunastu pikseli, linie zmieniajg kolor
na czerwony. W ten sposéb Inkscape sygnalizuje, ze wcidniecie w
tym obszarze D i przesuniecie myszki przeniesie linie pomocni-

Cczg W nowe miejsce. Zostanie umieszczona tam, gdzie zwolnisz

=1.

Aby usuna¢ linie pomocnicza — trzymajac weisniety [ctr], Kliknij w

nig |:l

Jezeli w oknie Document Properties ([shiftHctriH{p]) jest wiaczone

"przycigganie" do punktow charakterystycznych (Rysunek 4.10.2) —
tworzone lub edytowane obiekty bedg sie dopasowywac do linii po-
mocniczych.

@Document Propetties (Shift+Ctrl4+D)

Page | Guides | Grids| Snap | Snap points
Snapping

Wytgcza lub wigcza
dziatanie  wszelkich
pomocniczych "przy-
ciggan”

] Boundin

Snap to objects
[] snap to paths

] snap to nodes

Snap only when closer than:

Snap distance j 10
i Steruje  "przycigga-
Snap to grids niem" punktéw
[] snap only whén closer tlobiektéw ~ do  linii
pomocniczych
=~
Snap to guides
Snap only when closer than:
Snap distance J 10

Rysunek 4.10.2 Wiaczenie "przyciagania” do

linii pomocniczych

Copyright Witold Jaworski, 2009 - 2012.



90 Szczegdty obstugi programéw

411 Rysowanie linii

Rysowanie linii zaczynamy od przetaczenia sie¢ w odpowiedni tryb pracy — rysowania linii (Rysunek 4.11.1):

......... | 100

P BT I.|I.’.jl

I o P

I i

I |_.).jl

F 4
|

anme

,_
il
R I

-

2. Kiiknij tutaj 3. Kikni (D) fu,

( ), by aby zakonczyé seg-
rozpoczgc linie. ment linii...

1. Kliknij tu, by wtgczy¢
tryb rysowania linii.

SEASSONJOE NP
R

Rysunek 4.11.1 Rysowanie linii w Inkscape

4. Nacisnij , by

zakonczy¢ catg linie.

/

Linie zaczynasz od kliknigcia Ij w punkt, ktéry bedzie poczgtkiem pierwszego odcinka. Od tej chwili za kurso-

rem myszki zaczyna sie "ciggna¢" czerwona kreska (mimo, ze nie naciskasz zadnego klawisza). Gdy po raz
drugi klikniesz |:[ — wskazesz koniec odcinka. Linia moze sie sktadaé z jednego lub wiecej takich segmen-

tow. Zwrdé uwage, ze po wskazaniu drugiego punktu Inkscape "z wtasnej inicjatywy" rozpoczat "ciggngc" kolej-
ny odcinek linii. Musisz na koniec nacisng¢ , aby zasygnalizowa¢ programowi, ze "na tym konczymy".

e Aby usunac¢ ostatnio narysowany odcinek linii — nacisnij |Backspace|.

e Jezeli rysowany odcinek ma by¢ poziomy lub pionowy — podczas rysowania trzymaj wcisniety .

Inkscape stara sie utatwic¢ rysowanie linii jako figury zamknietej. Stad,
gdy podczas rysowania linii zblizysz koniec ostatniego odcinka do
poczatku pierwszego — punkt poczatkowy ulegnie pod$wietleniu
(Rysunek 4.11.2). Gdy umiescisz w nim punkt koncowy odcinka, kto-
ry rysujesz (klikniecie D) — linia stanie sie zamknieta.

Wirtualne modelarstwo — wersja 2.0
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Po  zblizeniu  kursora
punkt poczgtkowy staje
sie czerwony

Ostatni

linii

segment

Rysunek 4.11.2 "Zamykanie" obrysu
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412 Wilasciwosci ksztattu

Kazdy obiekt w dokumencie Inkscape — poza obrazem rastrowym — jest figurg geometryczng, ztozong z
dwoch elementow:

- linii konturu (stroke);

- wypetnienia (fill);

Dla obydwu mozna ustali¢ kolor, a w bardziej ztozonych przypadkach — gradient czy desen, jakim sg rysowane.
Linia konturu dodatkowo posiada takie wtasciwosci jak grubosé i wzor (ciagta, kreskowana, kropkowa,...)

Kontury otwarte takze mogg posiada¢ wypetnienie — cho¢ w takim przypadku wyglgda nieco dziwnie.

Do zmiany wypetnienia i linii konturu obiektu stuzy panel Fill and Stroke (Rysunek 4.12.1):

Flle Edit Wiew Lawer Object Path Text Effects  ‘Whiteboard Help mﬂb
DEEE AR ¢ DXD QA UEE P8 ZTEHE %@

Fill: Aione
—v a = = .. i otworzy sig okno wiasci- stroke: [ =
A e R T wosci ksztattu, oz [ RF and Stroke (Shift+Ciri+F) E
- A IB IVC |7D |—E [F Fill | [ strake Eaint|£5tr0ke style
LY -

width: | B.oo0 : e W

I ;;;,ITU zmien grubosc linii.... | —/ﬁ'
il —-—-—-J" ] W0

— / [ o
r : A Miter limit: 4DD

LTINS

@ E_ /""'|L’j o Cap: . . .
] Ei\\ :
i Dashes: | —+=—+—- | 0.00
@) h a
@}' _1 érlStart Magkfrs: | Mone w
1.
@ ;_ Mid Markers: | Mone A4
g i End Markers: | Mone v
/s '_ v Blur:
|J_ i
Ui | Spei_— 1 Se== |0
I NN i I — : pacity, %
FIFFIT - Opacty, %

1
-
f
|
f
i
(I
s
=
=1
!
4

AT
Rysunek 4.12.1 Okno witasciwosci ksztattu (Fill and Stroke)

W zaktadce Stroke style ustalasz grubosc i desen linii obrysu. W zaktadce Stroke paint ustalasz barwe (lub
gradient, lub desen) linii (Rysunek 4.12.2):

inne opcje: gradienty:

/ liniowy i eliptyczny

--------- iE |l:l e |2:'."1| o |I.n' oo [ o o [E Cl, gFill and Stroke (Shift+Ch/H:) ONE]
k ] Aktualnie wybrany sposob wypetnienia:| .

pe 7 _A. I_B jednolity kolor (Flat color) —-\Fill“—SterE Eain%ESterB Stﬂe

i

T T T \ ‘
2
S I X D k inne opcje:

f . I g@/.ﬂ'l Flat col desen
|
RGE CrMyE | Wheel | CMS

Tryb jednolitego koloru:

[STETTN

Aby zmieni¢ barwe, zlap D i| =
przesuwaj suwak.

i
,
N
L_'._
i
@

1
[}
/"
P
1
ﬁcu
o
3

ra
o
5]

4

POOLLH
.

E—

Rysunek 4.12.2 Zmiana barwy linii — zakladka Stroke paint
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Zaktadka sterujgca wypetnieniem obiektu to Fill. Zawiera
identyczne kontrolki jak Stroke paint.

Sposréd mozliwych trybow wypetnienia wyréznia sie pierwsza

opcja od lewej — . (Rysunek 4.12.3). Gdy jg wybierzesz w
zakladce Fill, obiekt w ogdle nie bedzie miat wypetnienia.
(Analogicznie, wybdr tej opcji w Stroke paint spowoduje, Zze
obiekt w ogodle nie bedzie miat obrysu).

Na zakonczenie warto wspomnie¢ o jeszcze jednej wtadciwosci obiektu w Inkscape. Mozesz tu sterowac nie-
przejrzystoscig pojedynczego obiektu doktadnie tak samo, jak w GIMP steruje sie nieprzejrzystoscig catych

TAFil and Stroke (Shift-+Ctrl+F)

Fill !_Stroke paint zStroke style

EO0E?
NJ&W\

Rysunek 4.12.3 Wylaczenie wypetnienia wnetrza obiektu

Wylgczone (w ogodle
nie jest rysowane)

warstw. Stuzy do tego niewielka kontrolka O, umieszczona u dotu ekranu (Rysunek 4.12.4):

Al

o T

OPLLh

[=2=2%,
' .

£ -
Q i
L

)

Opacity = 100%
— obiekt zupetnie
nieprzejrzysty

E Opacity = 50% —

> { X

zakryty
przeswituje spod
spodu

Tl
0!/100 |, 15 @) | Laver1 v

Fill: Fill:
Stroke:

Rysunek 4.12.4 Zmiana nieprzejrzystosci obiektu (Opacity)
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4.13 Edycja linii

Linie (a wlasciwie — "Sciezki", bo Inkscape okresla je jako paths), ktére narysowates, mozesz pdzniej modyfi-
kowac. Stuzy do tego oddzielny tryb — edycji weztow (Rysunek 4.13.1). (Weziem linii jest kazdy z jej wierzchot-
kow):

Tryb , edycji Wspotrzedne ostatnio wskazanego wierzchotka |
weztow \|
- - e (D VL S B i o N S N TR P R T i TR el
rereeeees 100 150 00 50 31 350 500
I I [ I | I [ I | PO R B A R | CRN T IR B B | ...................... I 1
] ,,, ~

Q 1_ Wezly aktualnie wybrane_ linii.
D N Mozesz je przesuwac | )
. /," ~. f
® :
N K \
—— I i T Rl T \-\ ----- -/’ 5— -----------------------

Rysunek 4.13.1 Edycja wierzchotkéw wybranej linii

W tym trybie kazdy punkt linii (wezet) jest oznaczony matym rombem. Mozesz za nie "tapac" (|:[) i przesu-

wac w nowe miejsca. Obowigzujg tu doktadnie te same reguly, co przy edycji calych obiektéw. Pojedyncze klik-
niecie w wezet oznacza go jako wybrany (Wezet wybrany zmienia swoj kolor na niebieski). Jezeli podczas
wskazywania weztow bedziesz trzymac wecidniety klawisz - mozesz zaznaczy¢ wiele punktow naraz. Mo-

zesz je takze zaznaczac obszarem prostokatnym.

e Aby dodac¢ do linii nowy wierzchotek — kliknij dwukrotnie D w segment, w miejscu w ktérym ma by¢

wstawiony.

e  Aby usung¢ wybrany wezet/wezty — nacisnij klawisz . To zazwyczaj powoduje zmiane ksztattu linii.
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414 Linie krzywe

Inkscape pozwala od razu rysowac linie krzywe — wystarczy w trakcie rysowania kolejnego segmentu trzymac
przez caty czas wcidniety |:I Musze jednak przyznaé, ze dla doktadnego odwzorowania ksztattu ta metoda
jest troche nieodpowiednia. (A moze — nie przec¢wiczytem jej dostatecznie.) W kazdym razie pokaze tu sposob,
ktérego uzywam "na co dzien".
Polega on na:
- pierwszym przyblizeniu obrysu za pomocg linii famanej (patrz str. 90, 98);
- przeksztatceniu kolejnych segmentéw famanej w odcinki krzywej.

Aby zmieni¢ ksztatt linii tamanej w krzywa, musisz sie przetgczy¢ w tryb edycji. Potem wystarczy "ztapaé" za
segment linii [Z2] i wygia¢ w odpowiedni ksztatt (Rysunek 4.14.1):

:;: AR TP ALY A
1 1

= 4

“L\
=
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[}
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=
<
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®
Q.
<
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°
=
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>
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=
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==
v
I S
-]
| T

1
oo
1

R T ...ztap D za jaki-

kolwiek punkt na linii...

ooy simpel v

1
[=T=pe
1

ppger Ampe) |

1
1
|

Rysunek 4.14.1 Linia krzywa uzyskana poprzez "wyciagnigecie"

Alternatywng metodg jest zamiana poszczegdlnych weztéw (wierzchotkdw) z "ostrych" na "gtadkie", poprzez

nacisniecie ikony — . Rysunek 4.14.2 przedstawia, na czym to polega:

-, % [E]] e TR ARV NRISASSE] S
p— 1500 0 p— 100 200 300 200 50
k [ [} | . 1 LI | * ol o 1 | 1 [ 1 | ol 1 1 | . 1 LI | .
e . e .
¥ - : ¥y - :
Zaznace - kliknij w ' e 5 '
ten wezet te ikone : . '
_"} Q ] Wygtadzony wezet !
D B HH D EE g (styczne sg symetryczne) \;
a- 1 a- !
O - O - R 5
C‘E} a- @} a_ — Mozesz  przesuwaé
=] ~ konce stycznych

Rysunek 4.14.2 Linia krzywa uzyskana poprzez zmiane¢ typu wezta na "gtadki, symetryczny"

W weZle pojawity sie dwie styczne do krzywej. Mozesz sterowac ksztattem linii zmieniajgc ich pochylenie i dtu-
gos¢. Przedstawiony na rysunku wezet jest "symetryczny", co oznacza ze zmiana jednej stycznej powoduje
identyczng zmiane drugiej. (Dzieki temu wygiecie bedzie bardziej "ptynne", gdyz krzywe z obydwu stron wezta
maja w tym miejscu taki sam promien krzywizny).
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Jezeli nie zalezy Ci na az tak "dokladnych" zaokragleniach — mozesz wezet przetgczy¢ w tryb = (Rysunek
4.14.3). Wtedy styczne z kazdej strony wezta bedg utrzymywaty wspotliniowos¢. Moga sie jednak rézni¢ diugo-
Scig.

F S X HERIVYNR A L] e
rarEEeo 100 | 200 . | 300 |—)I|
k 1 1 1 ™o 1 LI R | [ | 1 1 PR I B |
~ =
NI e ,
£ - :
D 1_ o Styczne moga miec '
7 nieréwng dtugosc H
@ 7 A >
r e '
P £ ¢

Rysunek 4.14.3 Wezel gtadki, niesymetryczny

e Krzywe, uzyskane w ten sposéb, "na oko" wygladajg na gtadkie. Gdy jednak styczne w wezle réznig sie
dtugoscig, wystepuje w nich skokowa zmiana promienia krzywizny.

Gdy chcesz uzyska¢ w wezle ,naroznik” — przetgcz sie w tryb v Wtedy mozesz manipulowac kazdg ze
stycznych oddzielnie (Rysunek 4.14.4):

- 46 88 88
= +

& s a'n ;?; ',v\ \O’I,‘ ‘o lad n)a m'fa q] PF E =]
1 1 1

.I.I.‘lz).:‘I.I.I.I.vli‘.]I.l.

2|
]
=

%%

® |

oo

)2OPOLHh

.-;.-..l

Rysunek 4.14.4 Wezet ostry

Ostateczny ksztalt krzywej uzyskujesz, przeksztatcajgc kolejne wezty na "gtadkie" i — zazwyczaj — symetrycz-
ne (Rysunek 4.14.5). Zaczynasz ten proces od jednego kranca linii famanej. Sukcesywnie przeksztatcasz w
krzywg i nadajesz wtasciwy ksztatt kolejnym segmentom, dopdki nie dotrzesz do konca linii.

Ten wierzchotek
byt drugi

Ten wierzchotek wygta-
dzilismy jako pierwszy

Styczng na krancu linii mozna

E "wyciggna¢" z wezta:
- [shift |j:]

Rysunek 4.14.5 Krzywa z wieloma wierzchotkami
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Podobnie jak podczas edyciji linii famanych:
- Aby doda¢ nowy wierzchotek, kliknij dwukrotnie [Z2] w miejscu, gdzie ma powstag.

- Aby wierzchotek usung¢ — zaznacz go i nacis$nij |Delete];
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415

Odwzorowanie obrysu zawierajacego tuk

Luk to specjalny przypadek krzywej. Operacje pokaze na przyktadzie formowania obrysu krawedzi natarcia
statecznika pionowego. Jest to odcinek prostej i fragment tuku. Zaczatem jednak od narysowania dwdch pro-

stych odcinkéw (Rysunek 4.15.1a):

i, aE @B B8 B ~ ) i “Ei\\
a) —E— B 2 &% o'p o & I\E)I :;E"“I E('E I‘-'lf { q:d
......... [z zmien wybrany odcinek IM.\'T‘%FFU. i
k 7 na segment krzywej
= RO, SN I T4
S

1. Kiliknij D w $rodek

odcinka, by stat sie wybrany.

Promien
"~ { tuku

Rysunek 4.15.1 Obrys — wygtadzanie

Aby zmieni¢ drugi segment w tuk:
- przetgcz sie w tryb edycji weztow;

— a8 aB &8 a
—E— - 2 s a0 B & e led El’)a m'(- q._d

......... | 2075 2100 21

I | [T TR et I
F_E U (IR | T
I, 3 A

i e g

A iy

Reguluj
krzywizne

|Styczna KA

- kliknij w $rodek segmentu, ktéry ma by¢ zakrzywiony. (Jego obydwa wierzchotki powinny zabarwi¢ sie

na niebiesko);

- nacisnij przycisk w pasku narzedzi, zmieniajgcy odcinek w segment krzywej (Rysunek 4.15.1a);
- ustaw odpowiednio uchwyty stycznych na koncu linii, aby nada¢ krzywiznie wtasciwy ksztatt (Rysunek

4.15.1b);

W Inkscape kazda krzywa to tzw. krzywa Beziera. Pojedynczy segment takiej linii potrafi catkiem doktadnie od-
wzorowac tuk o kgcie do 60°. W tym przypadku kat nie przekracza 45°, wiec nie dodawatem zadnego dodatko-

wego wezta posrodku.

Gdy za pomocg krzywej Beziera masz zamodelowac tuk, trzymaj sie nastepujgcych zasad:
- kierunki stycznych na koncach krzywej powinny byc¢ takie same, jak styczne tuku;
- dtugosci obydwu odcinkéw stycznych powinny by¢ réwne.
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416 Odwzorowanie krzywizny

W tej sekcji pokaze, jak za pomoca krzywych odwzorowac zadany kontur - na przyktadzie obrysu steru kierunku
P-40. (Odwzorowanie przedniej czesci — konturu krawedzi natarcia statecznika pionowego — jest opisane na
str. 97.) Jezeli do tej pory w Inkscape rysowates tylko linie tamane — zerknij na str. 94. Znajdziesz tam wprowa-
dzenie do tworzenia linii krzywych.

Najpierw obrysuj kontur linig tamang (Rysunek 4.16.1a). Wierzchoiki linii wstawiaj w takich miejscach, by naj-
wigksze wybrzuszenie krzywej lezato w rownej odlegtosci od poczatku i kohca odcinka (Rysunek 4.16.1b).

= I

M i ‘:ﬁ hl
-4Zasada rysowania
! |famanej obrysu:
i o A
' |Maksymalne
wybrzuszenie - w
$rodku segmentu

'|Obrysuj konturu linig
| |tamang

Gemtu

1]

Rysunek 4.16.1 Wstepny obrys steru kierunku — odcinkami prostych

Po narysowaniu linii, wigcz tryb edycji weztow. | o e w2 =y W) 2 0t @ @ (3] s w 2meld v [sa0.3514]
Zamien tamang na krzywa, wygtadzajgc kolej- ... Fi v F B B e

ne wierzchotki (p. str. 95).. Dla kolejnych we- S P

ztow (poza krancowymi): Pl :

- zaznacz wezet jako "symetrycznie gtadki”
(Rysunek 4.16.2);

- dostosuj krzywizne za pomocg stycznych.
Czasami trzeba takze przesung¢ wezet.

Przelqczeﬁie wezta na
¢ L1"symetrycznie gtadki".
‘i|(Obydwie styczne majg

.= -f{ten sam kierunek i diu-

=
Ny
i
|

Podczas wygtadzania moze sie takze zdarzy¢,

e zdecydujesz sie jakis wezet dodac lub usu- &
nac. §'.<
| B

Rysunek 4.16.2 Wygtadzanie linii tamanej
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417 Rysowanie prostokata
Przetagcz sie w tryb rysowania prostokgtéow (Rysunek 4.17.1):

New: Ry |0.000 A|:->c hd
2. Wcisnij D: tu jest

L |;\_'-n |3-,n
v b /e e dpierwszy naroznik... ST

3. Podczas tego ruchu trzymaj

r

G-
7
]
>

1. Kliknij tu, by wtgczyé 2 S
rysowanie  prostokata/ ] AP / wcisniety , aby uzyskac

kwadratu proporcje bokoéw 1:1...

1
’
’

I
’
’

’
’

111
’

I
’
’

I
’

I
N/

AN N 4. Zwolnij I:[: tu jest
N \ / drugi naroznik.

™

©LOoedL b

=
.
I

Rysunek 4.17.1 Rysowanie kwadratu

Wcisnij |:[ w miejscu, gdzie ma sie znajdowac jeden z naroznikdéw prostokgta. Nastepnie, trzymajgc wcisniety
Ij, przesuwaj kursor. Bedziesz "ciggnat" w ten sposéb przeciwleglty naroznik prostokata. Aby uzyskac ksztatt
kwadratu, trzymaj jednocze$nie wcisniety . Miejsce, w ktérym zwolnisz |:] wyznaczy przeciwlegly naroz-
nik obiektu.
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418 Rysowanie elipsy
W Inkscape okregi rysuje sie tak samo jak kwadraty (por. str. 99). Wybierasz tylko inny tryb rysowania: okregéw

(oznaczony ikong: O ). Nastepnie naciskasz [ || w miejscu, gdzie maj sigga¢ lewe, gérne granice elipsy.
Przeciggasz kursor z wcisnietym |:[ i zwalniasz ten przycisk w miejscu, do ktérego majg siegac prawe, dolne

granice elipsy (Rysunek 4.18.1):

' New: | Startyfm 2. Weisnij D3 tujestl, ., | O
- e pierwszv naroznik... =
.||.|.|.|.|.|.|.|.|.|.|.|.|.|.'|.|.|

f:' 3. Podczas tego _ruchu
trzymaj wcisniety Ctrll, aby

uzyska¢ proporcje  bokdéw
1:1..

1. Kliknij tu, by
wigczyé  rysowanie
elips/okregow

4. ...zwolnij D: tu
/ jest drugi naroznik.

©) @__Qﬁ Ok

N
o
|

Rysunek 4.18.1 Rysowanie okregu
Podobnie jak w przypadku kwadratéw, wazne jest wcisniecie klawisza podczas "przeciggania" drugiego

punktu, bo inaczej narysujesz elipse.

e Jezeli podczas tworzenia okregu bedziesz trzymat wcisniety klawisz |Shift| — poczatkowe potozenie myszki

stanie sie srodkiem okregu, a nie naroznikiem jego ,ramki”
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4.19 Ramka selekcji

W Inkscape, wokot kazdego zaznaczonego obiektu rysowana jest ramka. Nazwijmy jg ramka selekciji.
Poczgtkowo ramka selekcji pojawia sie zawsze w trybie "zmiany rozmiaru" (Rysunek 4.19.1). Jezeli jednak
jeszcze raz klikniesz w zaznaczony obiekt Ij przetgczysz sie w tryb "obrotu/przekoszenia" (Rysunek 4.19.2):

Uchwyty, pozwa-
lajace zmieni¢
rozmiar obiektu

Rysunek 4.19.1 Ramka zmiany rozmiaru

Srodek
transformacii

Uchwyty
przekoszenia

Rysunek 4.19.2 Ramka obrotu/przekoszenia

Ramka obrotu zawiera bardzo wazny punkt — $rodek transformacji. Jest oznaczony niewielkim krzyzykiem

(Rysunek 4.19.2). (Gdy nie mozesz go od razu dostrzec, zmniejsz powiekszenie — wtedy fatwiej go znalez¢).

Srodek transformacji mozna "ztapac" |:[ i przesungé w
inne miejsce (Rysunek 4.19.3).

Srodek jest zawsze wykorzystywany przez Inkscape pod-
czas obrotu, oraz — gdy trzymasz wcisniety klawisz —

podczas zmiany skali i przekoszenia.

Ztap :[ i

przesun $rodek
transformacji

Rysunek 4.19.3 Przesuwanie srodka obiektu
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420 Skalowanie
Zaznacz obiekt, ktéry ma by¢ zmieniony. Nastepnie ztap D za uchwyt ramki selekcji i przeciggnij. Nowe

rozmiary obiektu beda ustalone dla miejsca, w ktérym zwolnite$ [L2] (Rysunek 4.20.1):

Srodek transformacii

... i przesun w
nowe miejsce!

Ztap D za

ten uchwyt...

Rysunek 4.20.1 Zmiana rozmiaru (skali) obiektu

DomysIinym srodkiem skalowania jest przeciwleglty naroznik ramki.

Aby zmienia¢ skale wzgledem srodka obiektu (patrz str. 101) — podczas przesuwania myszki dodatkowo trzy-

maj wcisniety klawisz .

Aby zmieni¢ skale réwnomiernie we wszystkich kierunkach — podczas przesuwania myszki dodatkowo trzymaj
wcisniety klawisz .

Jezeli chcesz dokonaé zmiany skali o doktadnie ustalong wartosé — | S Transform (Shift-CtrtH1) B ®
otworz panel Transform za pomocg polecenia Object->Transform | tove| 3rale |Rotate| Skew | Matrix

(--@) . Wybierz w niej zaktadke Scale (Rysunek 4.20.2). W =] width |120.000 v % ¥

w
] [

pola Width, Height mozesz wpisaé doktadne warto$ci nowej skali. @ Height 1200

y,

[] apply to each object separately

Clear ] [ apply

Rysunek 4.20.2 Panel transformacji — zaktadka
skalowania
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4.21 Przekoszenie (Skew)

Zaznacz obiekt, ktory ma by¢ przekoszony. Kliknij w niego jeszcze raz, aby przetgczy¢ ramke selekcji w tryb
przekoszenia (szczegoty - str. 101). Nastepnie ztap |:I za jeden z uchwytéw na boku ramki, i przesun. Prze-

koszenie obiektu bedzie ustalone dla miejsca, w ktérym zwolnisz [L2] (Rysunek 4.21.1):

| Srodek
ﬂ H . +‘ transformacii

Ziap D za

ten uchwyt...

... 1 przesun w
nowe miejsce!

Rysunek 4.21.1 Obroét obiektu

Przed przekoszeniem mozesz przesung¢ srodek transformacji w inne miejsce. Wystarczy go "ztapac" |:[ i

przesungc (szczegoty — str. 101).

Aby przekoszenie nastepowato skokowo, doktadnie co 15° — podczas przesuwania myszki dodatkowo trzymaj
wcisniety klawisz [Ctri].

Jezeli chcesz dokonac przekoszenia o doktadnie ustalong wartoSC  |Cifransiam e ceriei) =
otwérz  panel Transform za  pomocg  polecenia Wove| Scale)| Rokate] Shew | Hekriz

Object->Transform ([shiftHcti[{m]) . Wybierz w niej zaktadke ), toreorta 20,00

= deq v
Skew (Rysunek 4.21.2). W pola Horizontal, Vertical mozesz wpi- ﬂ’ yertical | 0,000 =
sac doktadne wartosci przekoszenia.
[] apply to each ohject separately
Clear ] L pply
Rysunek 4.21.2 Panel transformacji — zakladka

przekoszenia
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Dodatki

Czytajac wczesniejsze rozdziaty, zapewne przekonates juz sie, ze uwielbiam umieszcza¢ u dotu strony przypisy
z dodatkowymi informacjami. Ta czes¢ ksigzki to wtasciwie wybor takich "uwag na marginesie”, ktére w trakcie
pisania urosty do rozmiaru catej sekcji ©.

Jak w kazdym dodatku, sg to informacje, z ktérych nie musisz korzysta¢, aby stworzy¢ e-model samolotu. Cza-
sami jednak mogg sie przydac¢, by cos wyjasni¢ lub utatwi¢. Mam jednak nadzieje, ze znajdziesz tu rozwiniecie
wielu zagadnien, ktére swiadomie skracatem w gtéwnym tekscie ksigzki.
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Rozdziat 5. Szczegdlowa weryfikacja planéw samolotu

Mozna powiedzie¢, Ze jest to rozdziat dla prawdziwych modelarzy — istot, ktére chcg odtworzy¢ pierwowzor
najdoktadniej, jak to jest mozliwe. Efektem poréwnan, ktére pokaze ponizej, bedzie poprawiona sylwetka P-40.
Szczerze méwigc, metody, ktére tu przedstawiam, pozwolityby opracowaé solidne plany modelarskie. Nie to
byto to jednak w tym przypadku moim celem.
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5.1 Poréwnanie z rysunkami fabrycznymi

Znalaztem w Internecie ([1] ) obrazy kilku rysunkéw fabrycznych P-40. Niestety, nie majg zbyt duzej rozdziel-
czosci, wiec wiekszosci wymiarow nie mozna odczytaé (Rysunek 5.1.1). Mimo tego sie przydadzg. W tej sekgc;ji
sprobujemy poréwnac z nimi odpowiednie fragmenty planéw samolotu.

Tr

ATf TR

Wymiary sg
nieczytelne!

Rysunek 5.1.1 Przyktadowy, zeskanowany rysunek fabryczny (z www.p40warhawk.com)

To poréwnanie wykonamy w Inkscape (wprowadzenie — patrz str. 81), a nie w GIMP. Dlaczego? W Inkscape
wygodniej jest skalowac i obracaé obrazy. GIMP na czas takiej operacji wytgcza wszelkie "przejrzystosci”
warstw. Inkscape podczas transformacji niczego nie przetgcza ani nie wytgcza - warstwy pozostajg przejrzyste.
Dzieki temu przez caty czas nie tracisz z oczu wzorca, do ktérego sie dopasowujesz. To ogromna réznica. Do-
poki nie chcemy ingerowaé we "wnetrze" porownywanych rysunkow, Inkscape jest lepszym narzedziem porow-
nawczym.

Zaczniemy od weryfikacji ksztattu usterzenia poziomego. Zmien nazwe pierwszej warstwy (utworzonej domysl-
nie w nowym rysunku przez Inkscape) z Layer 1 na Image (szczegoty — str. 86). Dodaj takze drugg warstwe —
nazwijmy jg Drawing.

W warstwe Image wstawimy obraz rzutu z lewe;j:
- wybierz warstwe Image jako aktualng;
- wczytaj (File>Import, str. 84) plik P40C-ML-Left.tif,
- dosun wczytany rysunek do lewego gérnego naroznika obrazu (Rysunek 5.1.2):

& ody g =2 | IS = = 57 | |0969 |- i |22446_

|w|2390c|c|, @ Hm px j affect: 3| )

v o0 |Tu mozna wpisaé|, ., L AT T e B N
k . wprost  odpowied-
nie wspotrzedne
—8
Nr Zep <|:l>ﬁ
8- iprzeciggnij [~~~ "7~
i]

LA

.;,.;“_..l

OLOCLLH

.;,l

Rysunek 5.1.2 Przesuwanie obrazu na docelowe miejsce
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Na koniec zablokuj warstwe Image przed zmianami (p. str. 86). Dzieki tej blokadzie nie bedziesz w stanie omy}-

kowo zaznaczy¢ i przesungé obrazu.

Teraz zatadujemy rysunek fabryczny steru kierunku na warstwe Drawing:

- wybierz warstwe Drawing jako aktualng;

- weczytaj Source\Curtiss\Tail-Rudder framework.gif (z pliku source.zip — por. str. 15)

Rysunek 5.1.3 pokazuje rezultat:

Rysunek 5.1.3 Rysunek steru kierunku, zaraz po wczytania

Jak wida¢ (Rysunek 5.1.3), wczytany obraz musimy nieco przygotowac, nim zaczniemy przymierza¢ do planow:
- wywolaj polecenie Object->Rotate 90° CW (lub uzyj przycisku z paska skrétow);

- ukryj na razie warstwe Image (p. str. 86);
- zmniejsz nieprzejrzystos¢ warstwy Drawing do 60% (p. str. 86);

Rysunek 5.1.4 pokazuje rezultat:

% 8557553 v |-267.19)3 w [sev00d @ H 1000.0[3'?3 fffect: =3 »
NPT ry PP PT ST PEPT I P ITQ 3L ayers (Shift+Ctrl+L) & ®
w £ - ~
e '
i :
.
!

Obrét of — P

90°

-;;-:u.;l
U

Irnage

Ukryj

na

razie| _
warstwe Image.

Blend rmode: |Normal

A !
— 1
1
Q, i
[ ’
Ea Opadity, %
\y O
- -
O i :
1 - FE——, 1
E i ' T !
@ 7] e ‘s T = Zmniej i j
| | | jsz nieprzejrzy-
ZLC;‘ _ . N stos¢ warstwy Drawing
1 1
P PE ] N -
l@ . " : L*

Rysunek 5.1.4 Wstepne przygotowanie rysunku
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Zbliz sie do obrazu steru kierunku (str. 85) i przyjrzyj mu sie uwaznie. Czy osie sg proste? Czy sg wzajemnie

prostopadte? (Rysunek 5.1.5):

Dodaj do rysunku kilka linii pomocniczych
(p. str. 89). Rozmies¢ je tak, by mozna
byto sprawdzié, czy kluczowe linie rysunku
sg pionowe lub poziome.

W przyktadzie, ktoéry pokazuje ilustracja
(Rysunek 5.1.5), wyglada na to, ze 0$
steru ma odchylenie. Jednoczesnie linie
zeber sg poprawne, czyli poziome. Taka
sytuacja oznacza, ze rysunek ma drobne
przekoszenie. Bedzie to trzeba poprawic
przez transformacje odwrotng (por. Rysu-
nek 5.1.6c, szczegdty - str. 103).

Musimy jednak wczesniej zadba¢ o wia-
Sciwe potozenie $rodka tego przekoszenia
(p. str. 101). Przesun rysunek tak, by dolny
zawias steru znalazt sie tam, gdzie przeci-
najg sie dwie linie pomocnicze. Nastepnie
przesun w to miejsce takze srodek obrazu
(Rysunek 5.1.5, Rysunek 5.1.6b).

O$ steru jest tylko
odrobing odchylona

Linie pomocnicze -
tworzenie i obstuga

= = jak w GIMP
- - ) A
Zebro jest .
poziome R
0. i '
A . .
Lol 1
B i |
2 1
1 .
! _ !
:."'-_". ) :
| il
===y
P 1
s Gl
1

Przesun stad srodek |-

transformacji nad
dolny zawias steru

Rysunek 5.1.5 Wyszukiwanie deformacji w rysunku fabrycznym

Rysunek 5.1.6 pokazuje szczegdly przekoszenia (Skew), ktérym skorygujemy odchylenie osi na rysunku fa-
brycznym (Rysunek 5.1.6a). Srodkiem tej transformacii jest punkt, w ktérym o$ rysunku pokrywa sie z linig po-

mocniczg (Rysunek 5.1.6b):

) R Rl EEEEEEE R
Korygowane: LA i
odchylenie osi = ==
steru od liniif_ p1.- i i
pomocniczej P ommy - 11
i daptese s g R | F
B Ui

(Skew)

Odchylenie skorygujemy
drobnym  przekoszeniem

Srodek
transformacji

E

Rysunek 5.1.6 Korygowanie przekoszenia obrazu

_'i_;_-:‘;_TA_'.;,___J ',

Tak niewielkie przesuniecia, jak przedstawiona powyzej, staraj sie wykona¢ w jak najwiekszym powiekszeniu.
(Wystarczy widzie¢ na ekranie uchwyt, ktéry masz ,ztapa¢” myszka, i mie¢ troche miejsca na przesuniecie).
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Rysunek 5.1.7 pokazuje, w jakim powiekszeniu mozna wygodnie i doktadnie skorygowaé niewielkg deformacije
osi. Widzimy tu tylko fragment ramki obrotu (Rysunek 5.1.7a). To nic nie szkodzi, bo najwazniejszy element —
uchwyt przekoszenia — jest nadal dostepny do "ztapania". Na ekranie jest takze miejsce na jego przesuniecie.

2150 z 0 2150 20 250 FE T
a) I OéSterv"”iapomOC”i'.l.‘Tl.l@ b).jl.l.l.l. NIRRT TR .ﬂ.l@
cza, i korygowany dystans

sg duze i widoczne

| Fragment ramki
“fobrotu —  uchwyt
przekoszenia (Skew)

Po przesunigciu
uchwytu w prawo o0$
pokryta sig z linig
pomocniczg

i

] I

- |Jest tu takze miejsce na wyko-
~|nanie przesunigcia. (Poprawka
a/jest mata, wiec i miejsca nie
trzeba zbyt wiele)

Rysunek 5.1.7 Przyktad powiekszenia, w ktérym koryguje os$ steru

Przeciagnij uchwyt w prawo tak, by 0§ na obrazie pokryfa sie z linig pomocniczg (Rysunek 5.1.7).

e Jezeli w czasie przeciggania drgneta Ci reka - dopdki nie zwolnisz D, mozesz nacisngc El To prze-

rwie catg operacje.

o Jezeli juz skonczytes - i skrzywite$ rysunek - zawsze mozesz wycofaé ostatnie polecenie (Edit>Undo, albo

i)

Wiacz z powrotem widocznos¢ warstwy Image, z sylwetkg samolotu. Nasun obraz steru na sylwetke tak, by w
tym samym miejscu miaty dolny zawias. (Pamietasz? tam umiesciliSmy srodek tego obrazu). Zmniejsz rysunek
steru, za pomocg naroznego uchwytu ramki (Rysunek 5.1.8). Zréb to, tak, by rozmiar zmienit sie proporcjonalnie
wzgledem ustalonego $rodka transformaciji. (Trzymaj wcisniete klawisze i — por. str. 102)

2. Zmniejszaj proporcjonalnie
obraz (trzymajgc wcisniete i

(F ). Zrob to tak, by uzgodnic¢

z planami potozenie gérnego
zawiasu

Il 7 ——
1. Nasun obraz na sylwetke tak, : ;
by dolny zawias steru ($rodek|ll
transformacji) byt w tym samym %
miejscu co na planach

Rysunek 5.1.8 Nanoszenie rysunku fabrycznego na sylwetke samolotu

Podobnie jak rysunek steru kierunku, wczytaj i dopasuj rysunek statecznika pionowego (plik Source\Curtiss\Tail-
Fin.gif, z pliku source.zip). Uwaga: rysunek jest nieco obrécony i przekoszony — popraw go nim ztozysz ze
obrazem steru. Statecznik dopasuj do steru tak, by pokrywaly sie ich osie oraz punkty zawiaséw. Obraz statecz-
nika umies¢ na tej samej warstwie, co obraz steru (Drawing).
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Rysunek 5.1.9 przedstawia ostateczny efekt natozenia rysunkéw fabrycznych na rzut z lewej. Widaé roznice
pomiedzy liniami planéw modelarskich i dokumentacji samolotu. To, ze sg niewielkie, dobrze swiadczy o auto-
rach planow.

= . il
( 3 P ima] Mnelezy
i promien

krzywizny |—B 7

" i | e g
. 3 e i
Roznica: na  rysun-[F5 e Fora e -
kach fabrycznych | p } N
krawedz nieco bar- i
dziej w tyle :
j wty e =

Odrobing inny
ksztatt obrysu
klapki trymera

WU & SRS A
e "

et
="

Rysunek 5.1.9 Efekt natozenia rysunkéw fabrycznych na rzut z lewej

Gdy znalezliSmy takie réznice — warto je uwzgledni¢ przy budowie modelu. Jednak korzystanie wprost z rysun-
kow fabrycznych bywa troche nieporeczne. Jest ich duzo, i zawierajg sporo nieczytelnych wymiaréw. (Takie
wymiary sg zupetnie bezuzyteczne). Proponuje nanies¢ na rzut z lewej poprawiony obrys usterzenia pionowe-
go, odpowiadajgcy rysunkom fabrycznym. Linie tego obrysu narysujemy w Inkscape, na oddzielnej warstwie.
Nazwiemy jg — Correction. Aby nasze poprawki odrézniaty sie od reszty rysunku, wszystko na tej warstwie
bedzie w kolorze czerwonym. Ztozenie warstw Correction i Image wyeksportujemy jako rysunek rastrowy
P40C-ML-Right.png, ktory uzyjemy w Blenderze.

Zrébmy to. Zablokuj warstwe Drawing przed zmianami. Dodaj do rysunku nowg warstwe - Correction (str. 87).

Rysowanie poprawek zaczniemy od naniesienia osi i kilku linii pomocniczych. Narysujemy je w kolorze niebie-
skim, by zaznaczyé¢ w ten sposéb, ze nie sg zadnym "namacalnym" elementem konstrukciji.

Narysuj linie osi steru (Rysunek 5.1.10). Po narysowaniu pierwszej linii przestaw (por. str. 91):
- grubosc¢ na 0.5 px;
- wzér na linie kreskowang;
- barwe na kolor niebieski.

(Dopodki tych ustawien nie zmienisz, kazdy kolejny obiekt, ktéry narysujesz, bedzie miat wiasnie takg grubosé,
barwe i wzor).

Na rysunku statecznika pionowego znajduje sie takze os i zarys profilu statecznika poziomego. Teraz narysu;j
samg os, potem skopiuj takze profil. (Na wszystkich planach modelarskich statecznik wydaje sie mie¢ zbyt zao-
kraglong krawedz natarcia. Dokumentacja fabryczna i zdjecia wskazujg raczej na zastosowanie profilu z ostrym
noskiem — p. str. 138.)
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Rysunek 5.1.10 Naniesienie na rysunek osi steru i kilku pomocniczych obryséw

Rysunek 5.1.10 zawiera, oprécz linii, takze okrag. Na planach fabrycznych jest zaznaczone, ze obrys zaokrg-
glonej koncowki statecznika byt fukiem. Aby to sprawdzic¢, umiescitem w podanym przez plany srodku okrag, o
odpowiednim promieniu (rysowanie okregu — p. str. 100). Zgadza sie z zarysem statecznika!

Teraz narysuj wszystkie wazne linie wewnetrzne. Sg to linie proste, czasami sktadajgce sie z kilku segmentéw.
Po narysowaniu pierwszej z nich zmien jej wiasciwosci: barwe linii na kolor czerwony, a wzor linii na linie ciggts.

|2|-.".1 |2|2’.- 2150 |2|.-'b 200 |2225 2250 |22.-".- |2>.'-.'l 325 |23’.-.1
1 [N 1o (I} R I L I P P T I P T T I I T T I I T O I I I T

. PO T B B PR B B PR PR PR ) II..I. . PR B Y . e
k - Wiaczony tryb .

‘ ﬁr-a & edycji weztdw

Wezly aktualnie wybranej linii. Mo-
zesz je przesuwac )

Rysunek 5.1.11 Poprawianie narysowanych linii

Podczas rysowania nie zapomnij trzymaé wcisniety klawisz , aby linie byty doktadnie pionowe lub poziome.
Gdy jednak zdarzy Ci sie popetni¢ blgd — mozesz to poprawi¢. Wystarczy przetgczy¢ sie w tryb edycji weztow
(p. str. 93) (Rysunek 5.1.11).
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Linie krzywe, odwzorowujgce ksztatt samolotu, najlepiej jest tworzy¢ w dwéch etapach:
- najpierw obrysowac kontur przyblizong linig famang, o niezbyt duzej liczbie wierzchotkow;
- potem wygtadzi¢ te przyblizong linie tak, by doktadnie odda¢ ksztatt obrysu.

Na str. 94 znajdziesz ogdlne informacje o pracy z krzywymi w Inkscape. Na stronie 97 umiescitem sie opis, jak
odwzorowac¢ krawedz natarcia statecznika pionowego (jest to ztozenie linii prostej i tuku). Na str. 98 znajdziesz
opis, jak odwzorowac kontur steru kierunku (jest to "ogélna" krzywa, a nie zadne ztozenie tukéw).

Rysunek 5.1.12 przedstawia ostateczny efekt korekt. Wykorzystatem tu wszystko, czym dysponowatem, nawet
rysunek fabryczny owiewki wokét usterzenia i kadtuba. (Nie pokazatem, ani nie omawiatem go w tej sekcji.)

Zebra i detale sg przesu-
nigte w stosunku do
planow JJ/ML

Kontur ma mniejszy
J promien

- i
| Py
| |

Statecznik poziomy jest|” B
nieco wigkszy!

=y

—_—

Poprawna granica
owiewki!

©)r 1 H
~~"|Poprawna, przesunieta do przodu )
krawedz kadtuba! "—'—'/'v‘ +

Os$ steru kierunku

Szczegdlnie zaskakujgce na tym rysunku jest przesuniecie tylnej krawedzi kadtuba. (Chodzi o krawedz ostatniej
wregi kadtuba, wzdtuz ktérej biegnie o$ steru kierunku — Rysunek 5.1.12.) Wedtug wszelkich zdje¢, o$ steru
lezata z tytu tej linii, a na rysunkach JJ/ML jest z przodu. Takze ksztatt dolnej krawedzi owiewki usterzenia jest

Rysunek 5.1.12 Korekty usterzenia pionowego

inny, niz na planach modelarskich.

Zachowaj to poréwnanie jako plik P40C-ML-Left.svg. Wyeksportuj takze do bitmapy (File 2Export Bitmap) jako
plik P40C-ML-Left.png.

Podsumowanie

e Jezeli dysponujemy rysunkami fabrycznymi, choéby fragmentéw samolotu — warto je natozy¢ na plany
modelarskie. Mozemy odkryé wiele réznic (str. 110)!

e Do poréwnania (poprzez natozenie) wielu obrazéw wygodniej jest uzywac¢ Inkscape, a nie GIMP. W Inks-
cape podczas kazdej transformaciji (skalowania lub obracania) nie tracisz z oczu zadnej z warstw. To zde-
cydowanie utatwia wzajemne dopasowanie (str. 109).

o  Korekty oryginalnych rysunkéw nanosimy w Inkscape na oddzielng warstwe, w kontrastowym kolorze (np.
czerwonym — por. str. 112)
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5.2 Rzut z boku: poréwnanie ze zdjeciami

Poréwnanie planéw modelarskich z rysunkami fabrycznymi zmusito nas w poprzedniej sekcji do naniesienia
poprawek na plany. Mielismy do dyspozycji tylko rysunki fragmentéw ogona: statecznika pionowego, jego
owiewki, i steru kierunku. A co z resztg? Nie mamy juz wiecej fabrycznej dokumentacji kadtuba wersji P-40 B/C.
Czy nie czajg sie tam kolejne niespodziewane réznice? Pozostaje poréwnac¢ naszg sylwetke z jakim$ wyraznym
zdjeciem (Rysunek 5.2.1):

Widoczny dystans pomiedzy topatami $migta

$wiadczy o tym, ze ten fragment jest juz
znacznie znieksztatcony perspektywicznie

Natozenie na siebie goleni ozna-

cza, ze gdzie§ na ten obszar

== skierowano centrum  obiektywu
=4 aparatu fotograficznego

Rysunek 5.2.1 Tomahawk IIA (Hawk 81-A2, czyli P-40B) na lotnisku fabrycznym (Curtiss).

Weczytaj to zdjecie (Source\Photo\P40B-Left-Photo.png z pliku source.zip, por. str. 15) do Inkscape. Warstwe, na
ktorej je umiescisz, nazwij Photo. Zawsze zaczynaj od sprawdzania, czy fotografia jest zdeformowana — nie-
proporcjonalnie rozciggnieta w pionie lub w poziomie. Wybierz w tym celu na obrazie cos, co powinno by¢ ko-
tem. W przypadku tego zdjecia (Rysunek 5.2.1) sa to piasty podwozia gtéwnego:

Slad po rozciag-
gnieciu zdjecia w
Deformacja el
kota

2

Rysunek 5.2.2 Oryginalne zdjecie Rysunek 5.2.3 Zdjecie po przeskalowaniu (Y: -4%)

Narysuj ponad piastg okrag (rysuj z wcisnietym , by na pewno nie byt elipsg). Jezeli dostrzezesz odchylenia
w ksztalcie piasty (Rysunek 5.2.2) — przeskaluj zdjecie (tj. obraz), aby stata sie z powrotem kotem (Rysunek
5.2.3).
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114 Dodatki

e Podczas dopasowywania zdjecia, utatwisz sobie prace przesuwajgc srodek transformaciji do srodka wzor-
cowego okregu. Pamietaj tylko, gdy bedziesz zmieniat skale obrazu, aby trzyma¢ wcisniety klawisz [shit]
(W ten sposob wymusisz przeskalowanie wzgledem $rodka transformacji obiektu).

Po sprawdzeniu i ewentualnym "wyprostowaniu" zdjecia, usuh niepotrzebny juz okrgg. Zablokuj takze przed
zmianami warstwe, na ktoérej znajduje sie ta fotografia.

e Uzywaj zdje¢ o jak najwiekszej rozdzielczosci. Na zdjeciach marnej jakosci poprawny okrag moze sie wy-
dawac odrobine sptaszczony, z powodu duzego rozmiaru rastra (pikseli). Kierujgc sie tg fatszywa przestan-
ka, mozesz sptaszczy¢ zdjecie. Potem bedziesz sadzit, ze caty rzut z lewej jest do poprawy, gdyz nie pasu-
je do fotografii.

Utwoérz nowa warstwe (o nazwie Drawing) i wczytaj na nig rzut z lewej (P40C-ML-Left.png). Nastepnie zwieksz
przejrzystos¢ tej warstwy (Rysunek 5.2.4):

A B rC | D rE rF G H
Rzut z lewej na warstwie
Drawing (na wierzchu) = i [ /
Ll L= L

"\ Zdjecie na warstwie

Photo (pod spodem)

Rysunek 5.2.4 Nalozenie na fotografie rzutu z lewej

Dopasuj rzut z lewej do sylwetki na fotografii. Pochyl go w ten sam sposob, co samolot na zdjeciu. Zmniejsz
skale tak, by wysoko$¢ kadtuba w okolicy najmniejszego znieksztatcenia byta zgodna z wysokoscig na zdjeciu
(Rysunek 5.2.5):

W tym miejscu uzgodnijf T
wysokosé kadtuba c Obszar, w ktorym i
sylwetki i zdjecia | f kadtub ma najmniej-
sze znieksztatcenie

T “|Obszary o najwiek- / E
szym znieksztatceniu " !
e QT - = 2 Y ~

Rysunek 5.2.5 Wstepne dopasowanie sylwetki do zdjecia
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Po wstepnym dopasowaniu sylwetki do zdjecia wida¢, ze nie bedziemy ich w stanie od razu poréwnaé. Znie-
ksztatcenie geometryczne fotografii jest zbyt duze. Pomijam znieksztatcenie perspektywiczne skrzydta (jego
koncowka jest o wiele blizej obiektywu). Ksztattem pfata nie bedziemy przejmowac. Wazny jest tylko jego profil
przy kadtubie, w szczegdlnosci punkt na krawedzi sptywu.

W rzucie z boku najwazniejszy jest obrys kadtuba. Linia ta lezy na ptaszczyZnie symetrii samolotu. Na analizo-
wanym zdjeciu (Rysunek 5.2.2) ulegta tzw. "znieksztatceniu beczkowatemu". Rysunek 5.2.6 i Rysunek 5.2.7
pokazuja, jak wyglada takie znieksztatcenie na przyktadzie fotografii regularnej, prostokgtnej siatki.

Znieksztatcony | _L j; Znieksztatcony
obraz g FH#*”

L obraz
4

e

j: F‘\—i
T

T
BEE

PEE
1
\‘4

[
T
-

]
]
AREN
o
=
Ry

L
/ .
Krzywa deformaciji ggc))/\rﬂrfacji

(hiperbola)

Wygieta _/4

koncéwka

Rysunek 5.2.6 Proste znieksztalcenie beczkowate Rysunek 5.2.7 Zlozone znieksztatcenie beczkowate

Gdyby soczewka obiektywu aparatu fotograficznego miata idealng ogniskowg — uzyskaliby$my znieksztatcenie
proste (Rysunek 5.2.6). Deformacja obrazu ma tu ksztatt hiperboli.

W realnym sSwiecie nic nie jest jednak proste, a ogniskowe - idealne. Deformacja zdjecia wykonanego obiekty-
wem o ziozonej ogniskowej moze mie¢ skomplikowany ksztatt — przyktad pokazuje Rysunek 5.2.7. W okolicy
krawedzi tej fotografii krzywa deformacji obrazu ma koncowki wygiete do gory. (Doktadniejsze wyjasnienie natu-
ry tej transformacji mozesz znalez¢ w dodatku 6.1, na str. 131).

Czy mozna jako$ zdeformowaé rzut z boku tak, by odpowiadat sylwetce na poréwnywanym zdjeciu? Ze wzgle-
du na pracochtonnosé, bez zastosowania komputera jest to niewykonalne. A to oznacza, ze wszelkie rysunki
samolotéw wykonywane metoda tradycyjng mogg zawierac réznorodne btedy ksztattu. Autor takich rysunkéw na
pewno doktadat wszelkich staranh, aby zrobi¢ je jak najdokfadniej. Zazwyczaj jednak (prawie zawsze) podstawag
do opracowania nowych planéw modelarskich byty:

- rysunki samolotu opracowane przez innych autoréw;

- zdjecia, ktore byly poréwnywane z planami w duzej mierze "na oko". Deformacja perspektywiczna byta

kompensowana tylko w za pomocg bardzo zgrubnych poprawek.

Z kolei sam fakt opracowania rysunkéw na komputerze nie sSwiadczy jeszcze o tym, ze sg bezbtedne. Jezeli

bazowaly wytgcznie na wczesniejszych opracowaniach - mogg tylko powtarza¢ popetnione wczesniej pomyiki
innych autorow.
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Obecnie istniejg juz wyspecjalizowane programy, odwzorowujgce deformacije perspektywiczng — jednym z nich
jest np. Hugin (dostepny w ramach licencji Open Source). Ku mojemu zaskoczeniu, znalaztem jednak te funk-
cjonalnos¢ takze w Gimpie. (W kazdym razie oceniam, ze jest wystarczajgca do naszych celow). Sprobujmy jg
zastosowaé. W tym celu przygotuj w Gimpie odpowiednie zestawienie:

wyeksportuj (File 2Export Bitmap) z Inkscape zawarto$¢ warstwy z fotografig (por. Rysunek 5.2.5, str.
114) do pliku P40C-ML-Left-Photo.png;

wyeksportuj z Inkscape zawarto$¢ warstwy Drawing (zawiera odp. pochylony rzut z lewej) do pliku
P40C-ML-Left-Drawing.png;

otwoérz w GIMP utworzony przed chwilg plik P40C-ML-Left-Photo.png;

dodaj do niego, jako dodatkowg warstwe, plik P40C-ML-Left-Drawing.png;

zapisz ztozenie tych dwdch rysunkoéw jako plik GIMP o nazwie P40C-ML-Left.xcf,

ustaw jako aktualng warstwe P40C-ML-Left-Drawing (czyli rzut z boku), i zmniejsz jej nieprzejrzystosc
(Opacity) do 50-60%. (Powinna sie pod nig pojawi¢ fotografia samolotu. Jako pierwsza z wczytanych,
znajduje sie ,na dole” stosu warstw, na utworzonej przez GIMP wartwie o nazwie Background);

Rysunek 5.2.8 pokazuje efekt tych operacji - przeniesione do GIMP ztozenie z Inkscape (por. Rysunek 5.2.5,
str. 114):
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Rysunek 5.2.8 Ztozenie zdjecia i rzutu z lewej — przeniesione z Inkscape do GIMP

Moze, tak na marginesie, wyjasnie dlaczego nie zaczatem od razu od Gimpa: w Inkscape jest wygodniej skalo-
wac i obraca¢ obrazy. Do GIMP proponuje wczyta¢ tylko obrazy wyeksportowane z Inkscape. W ten sposdéb
zawarto$¢ obydwu warstw ma identyczne wymiary. Dzieki temu rzut z lewej znajdzie sie w GIMP dokfadnie w
tym samym potozeniu ponad zdjeciem, co w Inkscape.
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Teraz wywotaj polecenie Filters 2Distorts >Lens Distortion. Spowoduje to pojawienie sie okna dialogowego,
z parametrami znieksztatcenia beczkowatego (Rysunek 5.2.9):

X

Podglad transformacji - niestety,
Y shift: -100% tylko aktualnej warstwy

**® Lens Distortion

Parametry

100%

vl transformaciji
|-
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L

Edge:
0.000 |5

L

Zoam:

0.000 |3

EBtighten: -
-60,000|%

Ll

% shift:

L

0.000 |3
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i shift:

e )5 [

Rysunek 5.2.9 GIMP — okno dialogowe transformacji Lens Distortion.

Okno zawiera suwaki, odpowiadajgce nastepujgcym parametrom transformaciji:

X shift, Y shift. potozenie na fotografii Srodka obiektywu. (Chodzi o punkt, na ktéry skierowany byt apa-
rat w chwili wykonywania zdjecia). Pofozenie jest okreslane w zakresie od -100% do +100%. Wartos¢
0% odpowiada $rodkowi obrazu (patrz Rysunek 5.2.9);

Main: gtébwny wspotczynnik znieksztatcenia. Dodatni oznacza "skurczenie" obrazu wokét krawedzi.
Ujemny — to oczywiscie efekt odwrotny. Przy dopasowywaniu do zdje¢ bedziesz uzywac wartosci do-
datnich;

Edge: dodatkowa deformacja w okolicy krawedzi. Podobnie jak Main moze by¢ dodatnia (dodatkowe
"skurczenie" obrazu) lub ujemna.

Zoom: powiekszenie (zwykta zmiana skali, bez zadnej "magii") wzgledem punktu okreslonego przez X
shift, Y shift. Ten parametr warto uzy¢, gdy nie docenite$ deformacji zdjecia i np. nie mozesz osiggng¢
odpowiedniej wysokosci kadtuba w obszarze wokét srodka obiektywu

Ustalanie transformacji zacznij zawsze od ustalenia punktu, na ktéry byta wycelowana kamera (X shift, Y shift).
W przypadku klasycznego zdjecia samolotu stojacego na lotnisku, wspétrzedna Y srodka obiektywu wypada
zazwyczaj na poziomie horyzontu/wzrostu cztowieka. Potozenia wspotrzednej X mozesz sie domysleé, szukajgc
obszaru, w ktérym nie wida¢ zadnego odchylenia ptaszczyzn poprzecznych. (Na przykiad — koncowki topat
$migta, albo golenie podwozia, zastaniajace sie wzajemnie).
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Po ustaleniu celu kamery staraj sie dopasowac plany do zdjecia za pomocg zmiany gtéwnej krzywizny: Main.
Staraj sie jg dobra¢ w ten sposob, by przynajmniej dtugos¢ obydwu sylwetek stata sie taka sama. Jednoczesnie,
jak najwiecej "kluczowych" punktéw konstrukcji w okolicy "celu” kamery (jak nasada skrzydta, statecznika po-
ziomego, ramki kabiny...) powinno sie zgadzac.

W oknie Lens Distortion jest dostepny podglad efektu transformacji (Rysunek 5.2.9). Niestety, wida¢ w nim tylko
aktualng warstwe, wiec nie wiemy, czy "trafiliSmy" w zdjecie, czy nie. Pozostaje tylko taktyka "kolejnych przybli-
zen":

- ustaw parametry transformacji (zazwyczaj zmieniasz tylko Main);

- naciénij przycisk OK;

- obejrzyj rezultat;

- gdy nie jest odpowiedni:

- cofnij efekt transformaciji (Edit >Undo Lens Distortion);

- wywofaj ponownie okno dialogowe Lens Distortion (Filters >Re-Show "Lens Distortion"). Na szczescie

okno "pamieta" ostatnio uzyte wartosci parametrow;
- popraw parametry transformacji i sprobuj jeszcze raz.

Parametru Edge uzywaj dopiero woéwczas, gdy w zaden sposob nie mozesz odwzorowac zdjecia za pomocag

samego parametru Main. Moze to wygladac tak:
- dtugosé zdeformowanej sylwetki doktadnie zgadza sie z dtugoscig na zdjeciu, podobnie jak cze$¢ klu-

czowych wymiaréw;
- mimo to ksztatt usterzenia pionowego nie jest zgodny ze zdjeciem.

Rysunek 5.2.10 pokazuje efekt transformacji dla X shift = -40%, Y shift = -10%, Main = 5.8 (pozostate parametry
sg pozostawione w pozycji neutralnej):

/D

[E
Cel kamery: A
o o Potozenie
Xshift=-60%, Yshift = -10% statecznika
Potozenie kabiny - poziomego
poprawne - zaodne!

Krawedz sptywu u
- nasady skrzydta -
zgodna!

Rysunek 5.2.10 GIMP — Rzut z lewej, dopasowany do zdjecia (transformacja Lens Distortion)

Oprécz linii zgodnych, dostrzezemy szybko na ztozeniu wiele niedoktadnosci. Wida¢ nieco zbyt wygiety grzbiet
kadtuba za kabing, zbyt gteboka chtodnice pod silnikiem... Czy mozna w jakis tatwy sposdb przenie$¢ te po-
prawki na niezdeformowany rzut z lewej?
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Oczywiscie! Wystarczy, ze poddamy odwrotnej deformacji nie plany modelarskie, a samo zdjecie:
- wycofaj (Edit>Undo Lens Distortion) ostatnig transformacje;
- zmien aktywng warstwe na Background (to ta, zawierajgca fotografie);
- wywolaj ponownie okno dialogowe Lens Distortion (Filters Re-Show "Lens Distortion") i zmien zna-
ki parametrow Main i Edge (Rysunek 5.2.11):
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Rysunek 5.2.11 Parametry odwrotnej transformacji — z fotografii do rzutu prostopadiego

Rysunek 5.2.12 pokazuje efekt odwrotnej transformac;ji - zdjecie dopasowane do rzutu z lewej!
(Main = -5.4, pozostate parametry transformacji — bez zmian.)

Rysunek 5.2.12 Fotografia, "rozciggnieta” za pomoca Lens Distortion do rzutu prostopadiego

Teraz wystarczy przenies¢ zawartos¢ warstwy Background do Inkscape. W ten sposéb bedziemy mogli porow-
nac rysunek z prawdziwym samolotem!
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Aby to zrobic:

- (w GIMP:) wytgcz widocznos¢ warstwy P40C-ML-Left-Drawing (to ta z rzutem z lewej). Na ekranie po-
winna pozostac tylko zdeformowana fotografia;

- zapisz widoczng warstwe (File >Save As) do pliku o nazwie P40C-Left-Photo.tif,

- otworz (w Inkscape) plik P40C-ML-Left.svg (stworzyliSmy go w poprzedniej sekcji — zobacz str. 112);

- wytgcz w pliku P40C-ML-Left.svg (Inkscape) widocznosé wszystkich warstw, oprocz warstwy Image;

- dodaj nowg warstwe: Photo. Umies¢ jg pod warstwg Image;

- weczytaj na warstwe Photo (File 2Import...) plik P40C-Left-Photo.tif. (To ten utworzony przed chwilg w
Gimpie);

- przesun i obro¢ wezytany obraz, tak, by pasowat do rzutu z lewej (Rysunek 5.2.13):

File Edit Wiew Layer Object Path Text Effects Whiteboard Help
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Zbyt gteboka [
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Rysunek 5.2.13 Inkscape — zlozenie rzutu z lewej z "wyprostowanym™ zdjeciem

Teraz pozostaje tylko obrysowac roznice ksztattu na warstwie Correction, tak jak to robiliSmy w poprzedniej
sekcji (por. str. 111). Na przyktad — ze zdjecia wynika, ze gérny zawias steru kierunku jest nieco wyzej. Czy
pamietasz, ze wiasnie do tych zawiaséw przyktadalismy rysunki fabryczne (por. Rysunek 5.1.8, str. 109)? Zato-
zylismy wowczas, ze sg we wiasciwym miejscu. Teraz bedzie trzeba przesunac troche caty obrys.

e Jezeli nie porownasz rysunkow fabrycznych z odpowiednim zdjeciem, mozesz je zastosowaé w sposob
niepoprawny, i nie uzyskac prawdziwego ksztattu samolotu

Podczas poréwnywania planéw z fotografig pamietaj takze o tym, ze nie wszystkie efekty znieksztatcenia per-
spektywicznego zniknety z rysunku. Przyjrzyj sie koncoéwkom topat $migta (Rysunek 5.2.13): nadal sg wygiete
wzgledem obserwatora. Ten efekt powoduje, Zze np. luk akumulatora na planach powinien znajdowac¢ sie nieco
bardziej z przodu, niz na zdjeciu. Jedynie elementy lezgce dokladnie w osi symetrii kadtuba nie bedg mialy ta-
kiego przesuniecia. Mozesz je oszacowac, mierzgc np. odchylenie przedniej krawedzi pokrywy kétka ogonowe-
go. Potem proporcjonalnie zmniejszaj te odlegtos¢, jesli element jest blizej centrum deformacji. (No céz, jak
widaé, nawet tu odwzorowujemy cos "na oko". Zapewniam jednak, ze ogdlna niedoktadnos¢ tego poréwnania

jest o niebo lepsza niz to, z czego moglismy korzystaé¢ przed "erg komputeréw".1)

! Wiele bym dat, aby mie¢ do dyspozycji takie narzedzia, gdy w 1988 opracowywatem rysunki McDonell Douglass F4E! (Opublikowne p6z-
niej w matej monografii tego samolotu, w styczniu 1990).
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Rysunek 5.2.14 pokazuje rezultat — korekty naniesione na rzut z lewej. Rysowatem je w kolorze czerwonym.
Dodatkowo na rzut naniostem wzorce profilu ptata - w osi symetrii i u nasady skrzydta. (Zgodnie z dokumenta-
cja, byt to NACA 2215. Jezeli chcesz dowiedzie¢ sie, w jaki sposdb na podstawie symbolu profilu narysowaé
jego obrys — patrz "Ksztatt profili lotniczych (metody odwzorowania)" na str.133.) Ksztalt przekroju skrzydta
bardzo sie przydaje w weryfikacji dolnej krawedzi kadtuba kazdego dolnoptata. Wiekszos¢ autoréw rysuje ten
fragment dos¢ nieuwaznie, podobnie jak rzut z boku skrzydta. (Na przyktad - na rysunkach Jacka Jackiewicza i
Mariusza tukasika ztozone kota podwozia gtéwnego sg w rzucie z boku za szerokie. Wyglada to tak, jak gdyby
dotykaty kadtuba.)

A

m
)

Poprawiony kontur
usterzenia pionowego |——»

4 1 Tt . Nieco mniejsza
= [E— wysokos$¢ ogona
) Profil  skrzydta w

Ptytsza chtodnica okolicy kadiuba

Rysunek 5.2.14 Korekty rzutu z boku, naniesione po poréwnaniu ze zdjgciem

Ogolnie rzecz biorgc, nasza sylwetka wyszta z poréwnania ze zdjeciem "obronng rekg". Powaznych réznic nie
ma. Z wiekszych:
1. Chilodnica cieczy okazata sie na fotografii ptytsza, niz na rysunku.
2. Tylna krawedz kadtuba lezy bardziej z przodu, niz na planach.
3. Os$ obrotu steru pozostata w tym samym miejscu, wiec obecnie jest poza kadtubem. (I tak byto w praw-
dziwym samolocie).
4. Kotpak sSmigta okazat sie diuzszy, niz na planach (patrz Rysunek 5.1.10 — weryfikowatem to takze z in-
nymi zdjeciami).

Ta ostatnia poprawka wydtuzyta catg sylwetke o ok. 0,3%. Jednoczes$nie niemal niezauwazalnie przesuneta sie
do przodu tylna krawedz steru kierunku. W sumie sylwetka wydtuzyta sie o 0,25%, co oznacza roznice w skali
rzeczywistej o ok. 2,5 cm. Moze jestem chorobliwie dokfadny, ale jest to zbyt drobna réznica, by powtérnie ko-
rygowac cieciwe pfata. (W skali rzeczywistej, w najszerszym miejscu, réznica wynositaby ok. 8 mm. To zupetnie
niezauwazalne. Mimo to, jak pokaze w nastepnej sekcji, dopasowatem ptat do tego rozmiaru.)

Na koniec powiekszytem wysokos$¢ tego obrazu z 720 do 1024 jednostek, tak, by obejmowat caty obrys dolnej
topaty $migta. (Nie po to sie meczytem sie nad jej obrysem, by teraz go obcinac¢.) Uzyskany rysunek zapisz, na
wszelki wypadek, jako dokument Inkscape (P40C-ML-Left.svg). Stwérz takze jego kopie rastrowg
(File>Export Bitmap). Nadaj jej nazwe P40C-ML-Left.png.

Dzieki poréwnaniu ze zdjeciami uzyskaliSmy poprawiony rzut z boku. Oszczedzamy sobie w ten sposéb poz-
niejszego odkrywania tych wszystkich réznic. (Modelowanie w 3D bezbtednie wytapuje wszelkie niekonsekwen-
cje rysunku) Kazda z nich objawia sie tym, ze nagle co$ do czegos nie pasuje. Takie btedy znajdowalibysmy w
trakcie budowy modelu, jeden po drugim. Zapewniam, ze wtedy ich poprawianie wymaga wigkszego wysitku.
Oznaczatoby koniecznos¢ ciggtego poprawiania ukohczonych juz elementéw, a to hamowatoby caty postep
prac.
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Podsumowanie

e Za pomocg narzedzia GIMP — Lens Distortion — mozesz "rozwing¢" zdjecie, dopasowujgc je do rzutu z
boku (str. 114 - 119). Otwiera to nowe mozliwosci weryfikacji planéw modelarskich.

e Zdjecie, ktérego uzyjesz do poréwnania z rzutem z boku, powinno mie¢ jak najwiekszg rozdzielczos¢. Sa-
molot powinien by¢ na nim jak najmniej znieksztatcony (str. 114 - 115).

e  Staraj sie zawsze sprawdzié, czy zdjecie nie jest zdeformowane (zanadto wyciggniete w pionie lub pozio-
mie). W tym celu wybierz na fotografii ksztatt, o ktérym wiesz, ze powinien by¢ doktadnym kotem. Poréwnaj
go z okregiem, narysowanym w Inkscape (str. 113).

e Uzyskane w GIMP "rozwiniete" zdjecie mozna wczytaé¢ do Inkscape, aby wygodnie nanies¢ na plany po-
prawki (str. 120 - 121).
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5.3 Rzut z géry: poréwnanie ze zdjeciami i rysunkami fabrycznymi

Sprawdzilismy juz tak doktadnie, jak sie tylko dato, rzut z boku P-40. Pozostat nam jeszcze do sprawdzenia rzut
Z gory. Z nieocenionego http.//www.p40warhawk.com uzyskatem rysunki fabryczne dwéch elementéw:

- kompletnego ptata (znajdziesz go pod nazwag Source\Curtiss\Wing-overall.gif w pliku source.zip);

- steru wysokosci (znajdziesz go pod nazwg Source\Curtiss\Tail-elevator.gif w pliku source.zip);

Jezeli chodzi o zdjecia, to niestety, metoda jakg zastosowaliSmy do "wyprostowania" rzutu z lewej (patrz str.
113), tu nie zdaje egzaminu. Problem polega na tym, ze rzut z géry nie ma jednej ptaszczyzny, nad ktérg mozna
by sie byto skoncentrowac. Jest tu kilkka waznych powierzchni: ptata, usterzenia poziomego, kadtuba. Niestety,
kazda z nich jest w innej odlegtosci od obserwatora. W dodatku ptaty majg wznios, co jeszcze bardziej kompli-
kuje sprawe. Zresztg zdje¢ z gory samolotu jest o wiele mniej niz zdje¢ z boku. Wynika to z prostego faktu, ze te
z gory trzeba byto zazwyczaj wykonaé w powietrzu. Na taki "strzat" fotograf ma o wiele mniej okazji — aby go
zrobi¢, musi sie znalez¢ w innym samolocie.

Szukajgc w ogdle jakichkolwiek zdje¢ z gory, natknatem sie na nastepujgce (Rysunek 5.3.1):
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Rysunek 5.3.1 P40N — zdjecie z géry (USAAF)

To nic, ze fotografia przedstawia pézng wersje P-40. Wszystkie — od pierwszych do ostatniej serii — miaty takie
same ksztalty skrzydet i usterzenia poziomego.
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Rysunek 5.3.1 zawiera unikalne ujecie. Ten P-40N jest przechylony na lewo — o 7-8°. Dzieki temu lewy pfat jest
ustawiony niemal prostopadle do obserwatora. Jednoczesnie znieksztatcenie perspektywiczne jest niewielkie.
Koto, w ktére wpisana jest gwiazda na lewym ptacie nie ma zadnych widocznych znieksztatcen. Takze maszt
anteny na ogonie samolotu jest tylko odrobine odchylony od pionu. Kamera byta skierowana na okolice kabiny
pilota. Catej fotografii "rozwing¢" z perspektywy, tak jak to zrobilismy z rzutem z lewej, nie jesteSmy w stanie. Ale
pojedyncze obszary - to co innego! Uzyjemy tego zdjecia do weryfikacji dwéch elementéw. Rysunek 5.3.1 poka-
Zuje je, obrysowane liniami przerywanymi. To:

- obrys ptata’;

- obrys usterzenia poziomego.

Ewentualne réznice naniesiemy jako poprawki na plany samolotu (tak samo, jak to zrobiliSmy z rzutem z lewej).

Zacznijmy od poréwnania ptata z fotografii i ptata z planéw. Otwérz w Inkscape plik P40C-ML-Top.tif. Utwérz
nowg warstwe (pod spodem) i wczytaj na nig to zdjecie (Source\Photo\P40N- Top-Photo.png z pliku source.zip).
Dopasuj jak najdoktadniej do planéw lewe skrzydto samolotu z fotografii. W pierwszym kroku uzgodnij jego roz-
miary (szerokos$¢ i wysokos¢). Nastepnie ustaw fotografie tak, by linia ostrzegawcza byta pionowa. Jednocze-
$nie ostony zasobnika z amunicjg powinny by¢ poziome (Rysunek 5.3.2). Osiggniecie tego efektu wymaga
drobnego obrotu i minimalnego przekoszenia fotografii. (Przekoszenie niweluje drobny efekt wzniosu ptata,
widzianego z gory, z tytu):

o
Spora réznica w ksztatcie

Obrys krawedzi
sptywu (wg planéw)

Obrys krawedzi .
sptywu (wg zdjecia) ® _ *

-

“|Linia ostrzegawcza i zarys
k. |komér amunicyjnych —
poziome (zgodne)

= Owiewka podwozia jest nieco
mniejsza od plandw!

Rysunek 5.3.2 Ksztatt ptata — poréwnanie fotografii z planami M. Lukasika (i J. Jackiewicza)

Efekt jest zaskakujgcy: krawedz sptywu i kocéwka ptata sg na planach zle narysowane! Pociggneto to za sobag
takze btedne potozenie osi lotki — jest za bardzo przesunieta do przodu.

e Na planach modelarskich samolotu, powierzchnie poziome — ptat, usterzenie — zawierajg czesciej btedy,
niz lepiej udokumentowane fotografiami powierzchnie pionowe

! Rysunek fabryczny to "potozony" ptat. W zwigzku ze wzniosem ptata o 6°, zmniejszytem proporcjonalnie rozpietos¢ w rzucie z géry do
cos(6°) = 99.5% oryginalnego rozmiaru.
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Upewnijmy sie, czy mozemy zastosowac posiadany fragment dokumentacji fabrycznej. Wczytaj na kolejng war-
stwe plik z ogéinym zarysem ptata (Source\Curtiss\Wing-overall.gif z pliku source.zip). Rysunek 5.3.3 pokazuje

ztozenie tego rysunku ze zdjeciem:
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Rysunek 5.3.3 Poréwnanie fotografii z fabrycznymi rysunkami ptata

Jak mozna byto przypuszczaé, tym razem rdéznic nie ma. By¢é moze autorzy planéw (Jacek Jackiewicz, a potem
Mariusz tukasik) nie mieli okazji skorzysta¢ w odpowiednim czasie z tego rysunku.

Rysunek 5.3.4 przedstawia rzut z géry z naniesionymi poprawkami. O dziwo, poza tylnym dzwigarem, wszystkie
taczenia blach i linie nitdw na planach pasujg do rysunkow fabrycznych!

Owiewka podwozia
byta nieco mniejsza

Rysunek 5.3.4 Rzut z géry — poprawiony obrys ptata

Obrys koncowki ptata
to zilozenie trzech
tukéw
I':
|
[
]‘g-" T -
e[ H:\
e Y
Yy

taczenia blach i linie nitéw sg na planach popraw-
ne! (Od krawedzi natarcia do tylnego dzwigara).
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W podobny sposoéb zweryfikujmy obrys usterzenia poziomego. W tym obszarze rysunki Jacka Jackiewicza i
Mariusza tukasika réznig sie od siebie.

Na rysunku Jacka Jackiewicza ster wysokosci ma bardziej zaokrgglong krawedz sptywu. Jego kompensacja
aerodynamiczna znajduje sie takze w innym miejscu, niz na zdjeciu — i nie jest to mata roéznica (Rysunek
5.3.5). Ster na tym rysunku zawiera tyle r6znic, Ze nie ma co sie nim posiugiwa(f.

Zbyt duze zaokraglenie

oy

|Nieprawidiowy obrys kom-
|pensacji aerodynamicznej
\ P 4 ot 7

Krawedz natarcia powinna e SR - " N Krawedz natarcia powinna
by¢ bardziej z przodu . L al . by¢ bardziej z przodu

Rysunek 5.3.5 Obrys usterzenia P-40 wg planéw J. Jackiewicza Rysunek 5.3.6 Obrys usterzenia P-40 wg planow M. Lukasika

Mariusz tukasik zauwazyt te roéznice, i starat sie jg poprawic¢. Jego obrys usterzenia jest bardziej zblizony do
fotografii (Rysunek 5.3.6). Krawedz steru znajduje sie w poprawnym miejscu, a wywazenie masowe ma rozmiar
zblizony do rzeczywistego. Wyglada jedynie, ze w tym przypadku autor nie zauwazyt niewtasciwych proporcji
statecznika — jego krawedz natarcia jest nadal przesunieta do tylu. To w efekcie spowodowato zmniejszenie
promienia obrysu koncowek usterzenia. (Ster musiat pasowac do statecznika). Wyglada na to, ze Mariusz tuka-
sik starat sie zachowac ksztatt krawedzi natarcia jak na rysunkach Jacka Jackiewicza. Czyli — jest lepiej, ale tez
nie za dobrze.

Co z tym fantem robi¢? Sprébowatem ztozy¢ catg posiadang dokumentacje fabryczng, ktéra dotyczy tego frag-
mentu (Rysunek 5.3.7).

Na zdjecie usterzenia natozytem rysunki fabryczne:
- steru wysokosci (Source\Curtiss\Tail-elevator.gif z pliku source.zip);
- oprofilowania usterzenia (Source\Curtiss\Tail-fairing.gif z pliku source.zip);

Na pierwszym z nich jest oznaczony Srodek okregu konturu koncowki usterzenia. Przedtuzytem go znad steru
na statecznik, gdyz taki ksztatt jest zgodny ze zdjeciem.

Nastepnie narysowatem prostg linie krawedzi natarcia. Linia ta jest styczng do okregu koncowki, a z drugiej
strony — przechodzi przez punkt wskazany na rysunku oprofilowania usterzenia. Tak "wydedukowany" obrys
jest zgodny ze zdjeciem, a wiec — poprawny.

" Musze przyznaé, ze zaciekawiony tym btedem na skadinad doktadnych planach, sprébowatem dociec ich przyczyny. W tym samym cza-
sie, co rysunki P-40, Jacek Jackiewicz opublikowat takze rysunki do innej monografii AJ Press: P-36. Samolot ten, znany takze pod nazwa
Curtiss "Hawk" 75, byt przodkiem P-40. P-40 "odziedziczyt" po nim prawie wszystko, poza przodem kadtuba. | wiasnie tu moze tkwi¢ putap-
ka: usterzenia poziome P-36 i P-40 roznig sie od siebie! Na rysunkach Jacka Jackiewicza sg identyczne. W rzeczywistosci, wygladaty
podobnie, ale w P-36 ster wysokosci miat wzdtuz catej krawedzi dodatkowe wywazenie aerodynamiczne. Oznacza to, ze blachy statecznika
konczyly sie niemal doktadnie na krawedzi tylnego dzwigara. W P-40 to zakonczenie byto o kilka centymetréw przesuniete do tytu. Rysunek
Jacka Jackiewicza wydaje sie by¢ "ztozeniem" tych dwdch podobnych, ale nie identycznych, usterzen. Stad btedna krawedz podziatu sta-
tecznika i steru. Trudno jednak dociec, skad sie wzigt niepoprawny obrys catego usterzenia. By¢ moze byt taki na rysunkach, na podstawie
ktérych Jacek Jackiewicz opracowywat swoje plany.

Wirtualne modelarstwo — wersja 2.0 www.samoloty3d.pl


http://www.samoloty3d.pl/downloads/wm/source.zip
http://www.samoloty3d.pl/downloads/wm/source.zip

Rozdziat 5 Szczegbtowa weryfikacja planow samolotu 127

Obrys koncowki to
pojedynczy tuk

Krawegdz natarcia wydedu-
kowana z wymiaréw i zgod-
na ze zdjeciem

s

Rysunek 5.3.7 Obrys usterzenia P-40 — ztozenie dostepnej dokumentacji fabrycznej

Rysunek 5.3.8 przedstawia korekty naniesione na plan usterzenia poziomego (statecznika i steru).
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Rysunek 5.3.8 Korekty ksztattu usterzenia poziomego

taczenia blach poszycia statecznika poziomego biegng wzdtuz wzmocnionych podtuznic. Podobne podtuznice
biegna przez statecznik pionowy. Obydwa stateczniki byty, w miejscu styku tych podiuznic, skrecone $rubami.
(Usterzenie pionowe "stato" na niedzielonym stateczniku poziomym, ktéry z kolei byt przykrecony do kadtuba).
Na rysunkach fabrycznych statecznika pionowego zaznaczone sg punkty potgczen z usterzeniem poziomym.
Pozwolito mi to wyznaczy¢ potozenie podiuznic u nasady statecznika poziomego. (Rysunek 5.3.8 zaznacza je
liniami przerywanymi.) Jak widac¢, roznig sie tylko nieznacznie od potozenia wg planéw. Potozenie tych podiuz-
nic i szwéw blachy przy koncowce statecznika wypada inaczej, gdyz skorygowana koncowka jest duzo szersza.
Potozenie zeber steru wysokosci na rysunkach M. tukasika jest zgodne z dokumentacjg fabryczna.
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Rysunek 5.3.9 przedstawia ostateczng postac rzutu z gory, zawierajgcg poprawiony obrys usterzenia poziome-
go i skrzydta:

Poprawiony  ksztatt
usterzenia poziomego

Poprawiony
ksztatt skrzydta

|
|
I
|
o S e iy
3

B .
]

Rysunek 5.3.9 Rzut z gory z naniesionymi poprawkami

Wyeksportuj ten rysunek Inkscape do pliku obrazu o nazwie P40C-ML-Top.png (File 2Export Bitmap). Aby za-
oszczedzi¢ czas, nie kopiuje tych poprawek na drugg, symetryczng strone samolotu, ani nie przenosze ich na
inne rzuty. Wystarczy, aby pamietac, ze ptat lub usterzenie nalezy wykonywacé z rzutu z gory, wg czerwonych, a
nie czarnych (oryginalnych), linii.

Jak widzisz — kazdy popetnia btedy, nawet twércy plandw modelarskich. Opierajgc sie jednak na jak najlep-
szych planach, mozemy zidentyfikowa¢ i poprawi¢ wiekszos¢é pomyiek, ktére sie na nich znalazty. Jest to mozli-
we za pomocg odpowiedniego oprogramowania, ktdre pozwala na poréwnanie wielu obrazéw naraz. W po-
przednich dekadach taka mozliwos¢ jeszcze nie istniata’.

' Widziatem w wielu recenzjach modeli plastikowych nastepujacg weryfikacje: autor przyktadat kadtub czy skrzydto do planéw. Gdy cos sie
nie zgadzato — ogtaszat, ze model jest niepoprawny wymiarowo, i sugerowat, jak to skorygowac¢. Z perspektywy naszych doswiadczen
planami P-40 (ktére sg naprawde niezle) takie postepowanie wyglada na dos¢ naiwne. Autorzy recenzji modelarskich zaktadali, ze plany sg
nieomylne!
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Podsumowanie

e Zdjecia samolotu z gory nie poddajg sie tak tatwo rozwinieciu, jak rzut z boku. Zrezygnowatem z tej opera-
cji, bo mozliwos¢ btedu w rezultacie takiej pracy bytaby zbyt duza (str. 123).

e Liczba dostepnych, w przyblizeniu prostopadtych, zdje¢ samolotu z gory (lub z dotu) jest o wiele mniejsza
od zdje¢ "horyzontalnych". Dzieje sie tak dlatego, ze takie fotografie muszg by¢ robione wytgcznie z powie-
trza (str. 123).

e Plany modelarskie mogg zawiera¢ wiecej btedéw ksztattu ptata i usterzenia poziomego, niz kadtuba i uste-
rzenia pionowego. Wynika to z mniejszej liczby dostepnych fotografii (str. 125, 127).

e Rysunki fabryczne skrzydfa, statecznikéw i steréw sg w tej sytuacji wiasciwie jedyng metodg weryfikaciji.
(Chyba, ze uda Ci sie trafi¢ na jakies zdjecie, wykonane z duzej odlegtosci pod kgtem niemal 90°).
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Rozdziat 6. Dodatkowe wyjasnienia
W tym rozdziale umiescitem informacje "dla dociekliwych". Znajdujg sie tu szczegdtowe wyjasnienia wybranych
zagadnien, nad ktérymi nie chciatem sie rozwodzi¢ w cze$ci gtéwnej. (Aby nie zbacza¢ z tematu).
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6.1 "Znieksztatcenie beczkowate" fotografii

Fotografia utrwala rzeczywisty obiekt w Scisle okreslonym ujeciu perspektywicznym. Podstawowym parametrem
tego ujecia jest dtugos¢ ogniskowej obiektywu (patrz Rysunek 6.1.1). Powiedzmy, ze wynosi 50mm. Wymiary
kliszy sg zazwyczaj standardowe (wysoko$¢ 35mm, szeroko$¢ 48mm). Obraz na odbitce 10x15cm wygladatby
"zupetnie jak prawdziwy", gdybys ogladat go z odlegtosci 30 cm, zamkngwszy przy tym jedno oko. Oczywiscie,
nigdy tak zdje¢ nie oglagdamy. Napotykajgc je na co dzien, przyzwyczailismy sie nawet do takich drastycznych
deformacji beczkowatych jak "rybie oko". (Mimo, ze nie mamy szans zobaczy¢ swiata w ten sposéb — wyklucza
to budowa ludzkiego oka).

Wykonanie zdjecia Co widaé na zdjeciu:

C
B /
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Plaszczyzna syme- Hiperbola
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c b a b A
Ptaszczyzna kliszy j Vo) JITIRERRET
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Rysunek 6.1.1 Znieksztatcenie beczkowate na fotografii

Rysunek 6.1.1 pokazuje:

- po lewej: geometrie projekcji podczas wykonywania zdjecia. Linia z punktami A, B, C to np. 0§ symetrii
prawdziwego samolotu. Linia z punktami a, b, ¢ to obraz tej osi na zdjeciu. Zwré¢ uwage, ze odcinek
|Cc| jest o wiele dtuzszy od |Aa];

- po prawej: sytuacje, gdybysmy odbitke tej fotografii obserwowali z nieskonczonej odlegtosci (czyli nie
bytaby to w ogdle perspektywa, a techniczny rzut z lewej). Dlatego tu wszystkie odcinki |Aal, |Bb|, |Cc]|
sg réwnolegte. Rozne odlegto$ci pomiedzy obiektem a jego obrazem, wystepujgce w perspektywie,
zrobity jednak juz swoje. Jezeli wysokos$ci oryginatu (np. kadtuba) w punktach A i C sg identycznie, to
w punkcie ¢ (na zdjeciu) jest ona mniejsza niz w pkt. a.

Linie, demonstrujgca stopien znieksztatcenia beczkowatego, mozna uzyska¢ ustawiajac linie |Cc|, |Bb|, |Aa|
pod katem 90° do ptaszczyzny zdjecia (Rysunek 6.1.1). Diugo$¢ tych odcinkdéw jest taka sama jak podczas
tworzenia zdjecia. Ich konce wyznaczajg teraz krzywg deformacji. Krzywa deformacji ma w tym przypadku
ksztatt hiperboli.
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W rzeczywistosci soczewki obiektywu nie majg idealnych ogniskowych. Na wiekszosci zdje¢ krzywa deformacii
nie jest idealng hiperbolg — moze by¢ dodatkowo wygieta na krancach. Rysunek 6.1.2 pokazuje, jak powstaje
taki efekt:

Wykonanie zdjecia Co wida¢ na zdjeciu:
c B A /
Wygigcie —/
Krétsza  odlegtosé
do fotografii
c b a c b a
* S -il_-'._'r
T Y I I
Ptaszczyzna L T Y - |
fotografii o ;| _ -
* L] ! ,
niedoktadnosé
.‘1:‘-1'-'; ‘Logmskowej
A ‘
- §
11 L

Rysunek 6.1.2 Przyktad ztozonego znieksztalcenia beczkowatego
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6.2 Ksztalt profili lotniczych (metody odwzorowania)

Wsrdd konstruktorow lotniczych funkcjonuje powiedzenie "the wing is the king". Ma to znaczyé¢, ze geometria
ptata ma decydujgcy wplyw na wszelkie charakterystyki samolotu. Na przykiad — P-40E "Warhawk" i P-51A
"Mustang" miaty niemal identyczng powierzchnie pfata. Uzywaly takich samych silnikow Allison, miaty bardzo
podobng powierzchnie czotowg — chtodnic, kadtuba, skrzydet. Réznity sie jednak drastycznie oporem, jaki sta-
wiaty podczas lotu. Wspétczynnik oporu P-40E wynosit 0.0242". Ten sam wspotczynnik dla P-51A wynosit
0.0176. Co powodowato te réznice? Przede wszystkim profil ptata! W wyniku zastosowania skrzydta o profilu

laminarnym pierwsze "Mustangi" byt o 45 km/h szybsze od "Warhawkéw" 2,

Profil ptata jest odwzorowywany w lotnictwie bardzo doktadnie — nawet nieznaczne réznice ksztattu mogg w
znaczny sposob zmieni¢ np. charakterystyki przeciggniecia. Rysunek 6.2.1 wyjasnia podstawowe pojecia, uzy-
wane w opisie geometrii profili lotniczych:

y L Maksymalne
ugiecie linii

szkieletowej \
Linia szkieletowa

%-ﬁ.}(_% .X+__. _______________ X
PN

)& / A 100
\_ ]

==
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»

Maksymalna
grubos¢

Rysunek 6.2.1 Geometria profilu lotniczego

Tradycyjnie profile lotnicze rysuje sie w ptaszczyznie XY. Z lewej strony, w punkcie (X=0, Y=0), znajduje sie
zawsze tzw. nos profilu, okreslajgcy ksztatt krawedzi natarcia ptata. Nos jest zazwyczaj zaokraglony. Czasami
jest podawany promien tego zaokraglenia. Profil jest zawsze zakonczony w punkcie (X=100, Y=0). Linia profilu
jest czesto dzielona na dwie czesci: obrys gorny i obrys dolny. Obrysy tgczg sie na kraincach profilu (w X =0 i
X=100).
Prosty odcinek, tgczgcy nos z krawedzig sptywu nazywamy cieciwg. Drugg linig charakterystyczng jest
szkieletowa. Punkty tej linii lezg w rownej odlegtosci od gornej i doinej krawedzi profilu. Mozna jg sobie wyob-
razi¢ jako linie przechodzgcg przez srodki okregdw, wpisanych w obrys profilu (Rysunek 6.2.1).
Dla profilu podawana jest czesto takze:

- maksymalng grubos¢ (informacyjnie — chodzi tu o wysokos$¢, mierzong wzdtuz osi Y);

- punkt maksymalnego ugiecia linii szkieletowej (Rysunek 6.2.1).

Gdzies tak do lat dwudziestych XX wieku profile ptatéw opracowywali sami konstruktorzy. Robili to metodg prob
i bledow. Na przyktad popularny profil Clark Y powstat wkasnie w tym czasie (opracowat go w 1922 r. Virginius A.
Clark). Uzyto go w dziesigtkach samolotoéw z lat dwudziestych. Aby inzynierowie na catym Swiecie byli w stanie
poprawnie odtworzy¢ ksztatt profili, zaczeto publikowaé wspétrzedne ich obrysow (Tabela 6.2.1, Rysunek 6.2.2):

! Wspétczynnik "czystego oporu" mierzony w sytuacji, gdy ptat nie wytwarza sity nosnej (samolot jest wéwczas pochylony o 2—3° do dotu).

2z predkoscig wznoszenia juz nie byto tak dobrze: obydwa samoloty nie byty pod tym wzgledem najlepsze. Przy praktycznie takiej same;j
masie catkowitej (porownywany "Warhawk" byt nieznacznie — o 120 kg — Izejszy) "Mustang" osiggat 610 m/min, a "Warhawk" — 670
m/min. (Profil laminarny "Mustanga" miat o wiele nizszy opdr, ale takze wytwarzat relatywnie nizszg site no$nga.) Dla poréwnania — Messer-
schmitt Bf 109E miat predko$¢ wznoszenia 1020 m/min, a Bf 109F — 1260 m/min (ta ostatnia byta jedng z najlepszych w ciagu catej wojny).
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Tabela 6.2.1 Wspéirzedne profilu Clark Y

X 0] 125 25 5/ 7.5 10 20 30 40 50 60 70 80 90( 100

Yg| 3.49( 5.53| 6.50| 7.87| 8.86| 9.63( 11.35( 11.73| 11.40| 10.52| 9.18] 7.72| 5.54 3.32( 0.25

Yd| 3.49( 1.94| 1.46| 0.94| 0.61| 0.40( 0.04( 0.00| 0.00| 0.00|/ 0.00] 0.00| 0.00{ 0.00( 0.00

A
y
(| — T —
X
.- a i s v e e < v
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Rysunek 6.2.2 Profil Clark Y, wykreslony na podstawie wspotrzednych z Tabela 6.2.1

Gdzies$ w latach dwudziestych coraz szerzej zaczeto uzywac profili, opracowanych przez placéwki naukowe. Na
przyktad publikowat je niemiecki uniwersytet w Getyndze. (Byly oznaczane np. "Gétingen - 623", albo "Gdétingen
- 543".) W 1933 r. finansowana przez rzgd USA NACA opublikowata istotny raport, zawierajgcy geometrie i cha-
rakterystyki 78 profili lotniczych. Byly to tak zwane "profile rodziny 4-cyfrowej". Od tamtej pory profile te byly
szeroko wykorzystywane w wielu konstrukcjach lotniczych, nie tylko amerykar’]skich1. Do rodziny tej naleza tak-
ze profile ptata P-36 i P-40: NACA 2215 i NACA 2209.

Czy wiesz, ze numer profilu NACA nie jest wcale numerem kolejnym? Tak naprawde zawiera opis jego kluczo-
wych parametrow geometrycznych:
- 1 cyfra: najwigksze ugiecie szkieletowej (czyli wartos¢ Y max. ugiecia w %).
- 2 cyfra: odlegtos¢ punktu o najwiekszym ugieciu szkieletowej od nosa profilu, podzielona przez 10. Na
przyktad — "2" oznacza, ze max. ugiecie szkieletowej znajduje sie 20% od krawedzi natarcia.
- 34 cyfra: grubos¢ profilu (%).

Tak wiec symbol profilu P-40 — "NACA 2215" — oznacza profil o grubosci 15% i maksymalnym ugieciu szkiele-
towej 2%, w X = 20% cieciwy. W istocie ksztatty NACA 2215 i NACA 2209 réznig sie tylko gruboscig. Gdy prze-
skalujesz rysunek NACA 2209, rozciggajgc go w pionie, uzyskasz NACA 2215. (Na odwrot to takze dziata!)

Co wiecej — NACA opublikowato wzory matematyczne, ktére pozwalajg odwzorowac ksztatt profilu z dowolng
doktadnoscig. (Trzydziesci punktéw, jakie Tabela 6.2.1 dla profilu Clark Y, pozostawia jeszcze pole do pewnej
dowolnosci).

e NACA opublikowata parametry takze tzw. "rodziny 5-cyfrowej", ale nie bedziemy sie nig tu zajmowac. Poza
tym istniejg takze profile NACA, noszace inne oznaczenia. Na przyktad — laminarny profil ptata "Mustanga"
to NACA 45-100. A profil skrzydta Messerschmitta Bf 109 jest podany jako NACA 2R;14.2 (to oznacza po-
dwojne zatamanie szkieletowej).

! Skad tak wielka popularno$¢? Sekret kryje sie w sposobie pomiaru. NACA dysponowato wéwczas jedynym w $wiecie petnowymiarowym
tunelem aerodynamicznym, w ktérym miescit sie caty mysliwiec. Charakterystyki opublikowanych profili byty zmierzone na duzych ptatach,
w warunkach zblizonych do rzeczywistego lotu. Wczesniej wszyscy "dmuchali" (tak to sie méwi w lotnictwie) ptaty o rozmiarze niewielkiego
modelu w matych tunelikach aerodynamicznych. Potem starano si¢ te "modelarskie" charakterystyki przeliczy¢ na prawdziwe warunki lotu.
Zdradze tu wszystkim tym, ktorzy nie zetkneli sie z praktyka inzynierska, maty sekret: obliczenia aerodynamiczne, szczegodlnie bez uzycia
komputeréw, sa strasznie niedoktadne! Profile NACA byly wiec w oczach konstruktorow o wiele bardziej "pewne", niz wszystkie inne.
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Gdy zaczniesz szukac w Internecie hasta "NACA, airfoil", znajdziesz szybko kilka stron podajgcych wspoétrzedne
wielu réznych profili lotniczych. Uwazam, ze godny polecenia jest w szczegolnosci serwis dostepny pod adre-
sem http.//www.ppart.de/programming/java/profiles/NACA4.html-

NACA 4 Digits Series

Jens Trapp and Robert Zores Iy

S —

Dakota Ultrasonics
Ultrazonic Thickness gauges, Flaw Detectars, and Bolting
equipment

Airfail: MACADDT 2 v d akotaultrazonicz.com
) . — Airfoil Software For PC
Maximum Camber (0-8):0 4 L Free Trial “Yerzion For Windows. DesignFOIL is your
Max. Camber Pos. {(0-9): 04 3 analysis expert.
. v, DesignF OIL. com
Thickness (0-89):12 4 D Thickness Measurement
# Points (10-1000); 100 4 v Precizion optical gauging systems Unigque multi-layer film
’ and tubing
Puoint Distribution: 1|4 3 vy, Lumetrics. coms
. P Make Your Own Wind Power
Point Size: 0 4 J d Full Instructions - Make Your Cwyn Electricity & Save Your
Zoom: 400 4 J 3 Money |
wmn efficientplanet. com
H-Offset 04 4 Ads by Goog
Y-Offzet 04 3
Reset Credits | Show Points
Rysunek 6.2.3 Serwis internetowy — generator wspoétrzednych 4-cyfrowych profili NACA
Gdy ustawisz na tej stronie odpowiednio parame- N
try:
- Maximum Camber. ugiecie szkieletowej C
(1-sza cyfra);
. L . Skopiuj do schowka catg
- Max. Camber Pos: pozycja ugiecia szkie- zawartosé tego pola
Airfoil: MACAZ21E MACAZZ1S b

letowej (2-ga cyfra); -

0.999334067617257 0.00

-

Maximum Camber (0-9). 2 4

Thickness: grubosc¢ profilu (dwie ostatnie
cyfry).

Max. Camber Pos. (0-9) 2

0.9931005446882009 0.0
0.997878771184988 0.00

Thickness (0-99): 15

1

-

0.9961698937602841 0.0
0.99387551 68460636 0.0

# Points (10-1000% 100 4 y [0.2812077018196363 0.0
0.9881 360657825408 0.0
Point Distribution: 1 4 0.0845022802281503 0.0

Point Size: 0 4 | | » [0.980291069217146 0.00

i nacisniesz przycisk Show Points, w polu po
prawej stronie ekranu zobaczysz wspotrzedne.
Wygenerowano je dla profilu o dlugosci cieciwy =

-

0.975809207 4876676 0.0

Zoor: 400 4 0.9707610179444421 0.0

-

. 0.9652512690862581 0.0
V. . H-Offset 0 4 3
1.0 (PO 100 pkt na obrys) 0.9592851718311665 0.0
Y-Ciffset 0 4 » [0.9528693761813007 0.0
Reset Credits | Show Points i< b3

Rysunek 6.2.4 Wygenerowane wspoétrzedne profilu NACA 2215

Zaznacz calg zawartos¢ pola tekstowego ze wspétrzednymi ([criHA]) i skopiuj jg do schowka ([ctriHc]).
Co dalej zrobi¢ z tymi wspotrzednymi? Bedziemy pracowicie rysowaé w Inkscape ten profil, "punkcik po punkci-
ku"? Na szczescie nie — istnieje szybsza droga.
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Otworz arkusz kalkulacyjny, ktéry przygotowatem specjalnie tym celu (Source\Tools\Airfoil.xIs z pliku source.zip,
por. str. 15 — Rysunek 6.2.5):

E3 Microsoft Excel - Profil.xls

Pli. Edvcja widok ‘Wstaw Format Marzedzia Dane Okno  Pomog

Tu wklej zawar-

tos¢ pola zefl B MW & &0 |23y F 2(0 -8 U =89 % w3
wspoirzednymi E01 =] = ="L’ & PODSTAWTEKST(C201,"#0.000");,"",".") & ", 8PODSTAWTEKST(D201; "W g1pq skopiuj
profilu, skopiowa- A [ B [ ¢ | o | E [/ | |obliczone wyra-
n3 z Internetu Dhugosé cieciwy: 100 senie SVG

2

| 3 |NACA2215 Separator X Y SVG

| 4 |0.999834057617257 0.0016285512016576529 18/ 99.983407 | 0.152855M 99,983 0,163

| 5 |0.9991005445852009 0.00179506384301593067 19)99.910054 | 0.179506|L 98.910,0.180 |

| 6 |0.997875771184968 0.0020720146130770445 18/ 99.767677 0.207201|L 89.788.0. ¥ Wy

| 7 |0.9961698937602941 0.002458656672385315 19)99.616989 | 0.245566(L 99.617 0.

| 8 |0.9939755163460636 0.0029539055390286554 19)99.397552| 0.295391 (L 99.398 0, . =i

| 9 |0.9912977015196363 0.003556392395415317 19 99.12077 0.355639|L89.130.0, (B W

| 10 |0.9551389657525409 0.004254439921825124 19 98.813097 | 0426444)L 98,8140  WHeispecisinie. .

| 11 |0.9845022502281593 0.005076104309409857 19 96.450228 0.50761(L 984600, .

| 12 |0.930391059217145 0.005989169701933561 18 98.039107 0593917|L 680380, | -

| 13 |0.975809207 4876676 0.007001 166231930256 19/97.580021 D.700117|L97 681 0 »

| 14 |0.9707610179444421 0.0031093304910779 19/ 57.076102| 0.610936|L 97.076 0,  eeyst zawartose

| 15 |0.9552512590862651 0.00931057 41566535331 18/ 96.525127 | 0931087 |1 86,626 -0 15 yueroy komentars

| 16 |0.9592651718311665 0.0105024965564385275 19/95.928517 1.0B025|L95829.1, —

| 17 |0.9528653761913097 0.01198089960962534 1995286835 1.19809|L 95.287 -1. & Formatui kemérki. .

| 18 |0.9460069673642276 0.013442556373776005 19)94.600697 | 1.344256(L 94601 -1, wiybierz 2listy...

| 19 |0.938707 4514586589 0.014983775319441795 15| 93.670746 1 49837E(L 93671 1. (@, Hipertacze...

20 |0.9309765007320897 0.0155007 25034973145 19| 93.09765 1.650073|L93.098,-1:

44> M} Java |«

| Rysuj - NNCOOEA4E »-ZL-A-=E=584a.

Gotowy o [ [ e e

Rysunek 6.2.5 Arkusz kalkulacyjny — przygotowanie wyrazenia SVG

Teraz przetgcz sie do Inkscape, i: narysuj w nim dowolng linie prostg. Nastepnie przetgcz sie na tryb selekciji i
otwérz okno edytora XML (Edit>XML Editor...)

" C:\Documents and Settings\witold. jaworskilMoje dokumenty\Prywatne\WM\Dothki\Wyjas'nienia\Prufile\ProfilZ.svg [Z|[E|[‘S__<|
File Edit Yiew Laver Object Path Text Effects ‘Whiteboard Help

EDBE& NE o Dl Q@@ DaE @& BTEHE| & B
: ¢, 4 = | LB = =T |14 545 |v |36 084 |v |83 305 |‘, & Hm ’px_:| Affect: ) »
[ o [ - [ o[ A e

[
+

7

¢ $ kﬁ
|Dodana linia prosta

Atrybuty podswietlonego
-
@ d 4 @ / elementu (linii prostej)
= <svgisvg id="svgz"> ’

[+ <svgidefs id="defs4"=
= <sodipodi:namedview id="base" >
[ <swgimetadata id="metadata?"=
= <svqigid="laverl">
| <svg:path |d—"path320?"

| LA
Tu zawsze jest
podswietlony element
aktualnie wybrany na
rysunku

Atrybut d linii to 0, skroke-width: 0. 5; skroke-lineca

polecenia rysowania
odcinkéw.

{9200 LLH

4 | [zt

M 14.79455,3.66559 L 97.689521,3,66559

V¥Tu mozna  zmieni¢

zawarto$¢ atrybutu d

Attribute d selected. Press Cerl+Enter when done editing to commit changes.

Rysunek 6.2.6 Linia na rysunku i jej definicja w edytorze XML (SVG)

Wirtualne modelarstwo — wersja 2.0 www.samoloty3d.pl


http://www.samoloty3d.pl/downloads/wm/source.zip

Rozdziat 6 Dodatkowe wyja$nienia 137

WKklej zawarto$¢ schowka (kopie obszaru SVG z arkusza Profil.xls — por. Rysunek 6.2.5) jako nowg wartos¢
atrybutu d' (Rysunek 6.2.7):

" Profil2.svg: XML Editor, (Shift+Ctrl+X)

sHE@E > - - H

V ssvgisvg id="svg2"> Attribute | Yalue
[> <svgidefs id="defs4" >
<sodipodi:namedview id="base"=
[ <svaimetadata id="metadata?">
= wsvgig id="layer1" =
<svgipath |d—"path32tl?"}
i

id path6303
skyle opacity; 1;Fill: none;Fill-opacity; 1; stroke: #000000; stroke-width: 0,5; stroke-lineca

Tu wklej tekst z arku-
sza Profil.xls... >

4 / | [set
|

M 99,933,-0,163 —
L 99.910,-0.180 .. a potem naci$nij

L 99.788,-0.207 ten przycisk!

L99.017,-0.246 3
| oo a8 .0 2ac =

Attribute d selected, Press Cerl+Enter when done editing ko commit changes,

Rysunek 6.2.7 Wartos¢ atrybutu d (wierzchofki linii) przeniesiona z arkusza Profil.xIs

Gdy nacis$niesz przycisk Set, wprowadzisz nowe wartosci do dokumentu Inkscape (Rysunek 6.2.8):

IE «£ 53 57| x 028 |“ |34 213 |“ |100 5265 @ H m px j pffect; T3 »
PR T R B |2J| | I e T | i | LA |I)|:I [ 1 |I2J 1 | IR I |q
.Y

U

Prosta linia zmienita
sie w gotowy profil!

\.“Nl

B g B

sl Rl > -

= esygisvg id="svgZ" >
[ «svgidefs id="defs4"=
<sodipodi;namedview id="base" >
[ «svg:metadata id="rmetadata?" =
= gsvqigid="layerl"=
<svg path id="path3207" =

id path6303
skyle opacity: 1;fil:none;fill-opacity: 1; stroke: #000000; stroke-width: 0.5 strake-lineca

.N.l

.\_.
1

1
|»

g |

Eh 1 M 99,983,-0,163 L 99.91,-0,15 L 99.788,-0,207 L 99,617 ,-0.245 L 99,395,-0,295L 9
=] 9.13,-0.356 L 958.514,-0.426 L 95.45,-0,505 L 95,039,-0,599 L 97.581,-0.7 L 97.076,-
N 0,811 L 96,525,-0.931 L 95.929,-1.06 L 95.2587,-1.198 L 94.601,-1.344 L 93.5871,-1.4
/ < 93 L93,093,-1.66 L 92,282,-1,829 L 91,425,-2,005 L 90,527 ,-2, 187 L §9.59,-2,374 L
— 25 A1% 7 CAR | 97 GOS8 7 TAA| A4 Cdd % 0401 S5 A0S 2 1771 fd 236 3 30718

Fill:
stroke: JJJ_Attribute d selected. Press Cbrl+Enter when done editing to commit changes.

Rysunek 6.2.8 Uzyskany w Inkscape profil NACA 2215

! Inkscape zapisuje dokumenty w standardzie SVG (Scalable Vector Graphics). Sa to w istocie pliki tekstowe, przypominajace troche spo-
sobem zapisu strony HTML. Mozesz je nawet otworzy¢ w zwyklym Notatniku (notepad.exe) i co$ w nich zmieni¢ — pod warunkiem, ze
wiesz, co robisz. Do tego takze stuzy okno XML Editor. Za jego pomocg mozesz zmienia¢ w Inkscape "surowg" zawartos¢ aktualnego
dokumentu. Jest to o tyle prostsze od uzycia notatnika, ze przed zapisem jest sprawdzana poprawnos$é danych.

Copyright Witold Jaworski, 2009 - 2012.



138 Dodatki

W ten sposdb nasza linia nagle zmienita sie w gotowy rysunek profilu NACA 2215! Pozostaje teraz tylko zmienic
jego skale i przesung¢ w odpowiednie miejsce rysunku.

Na koniec warto wspomnie¢ o odmianie profili NACA, z koncowka "T". Sg to wersje 0 zmniejszonym promieniu
noska. Profile "T" majg o 75% zmniejszony promien noska w stosunku do promienia uzytego w serii NACA 00xx
(bez kohcowej litery). Odpowiednio do tego jest takze zmodyfikowany cata ksztatt przedniej sekcji - na "ostrzej-
szg". "T" w zamysle tworcdw mogto to znaczyé tyle, co angielskie "thinner", czyli "cienszy" (albo, réwnie dobrze,
"tapered"). Przyktadem profilu "T" jest NACA 0018T (Rysunek 6.2.9):

I

Rysunek 6.2.9 Profil NACA 0018T ("T" oznacza zmieniony przéd — zmniejszony promien noska)

Nigdzie nie znalaztem opisu, jaki przekrdj miato usterzenie P-40. Przymierzatem do rysunkow fabrycznych (np.
owiewki usterzenia) wiele profili. Ostatecznie doszediem do wniosku, ze byta to wtasnie rodzina NACA 00xxT.
W P-40 wykorzystano "ciehsze" wersje profilu, jaki pokazuje Rysunek 6.2.9:

- usterzenie pionowe, u nasady: NACA 0008T;

- usterzenie poziome, u nasady: NACA 0010T;

- usterzenie poziome, u konca: NACA 0009T.

Tabela 6.2.2 okresla wspétrzedne obrysu profilu NACA 0018 T dla pietnastu punktow. Wykorzystatem je do wy-
znaczenia obrysu profilu. Aby uzyskaé z tych wspétrzednych cienszg wersje, wystarczy przeskalowacé je w kie-
runku pionowym. Na przyktad, po "Scisnieciu” NACA 0018T o 50% uzyskamy NACA 0009T, wykorzystywany w
koncéwce usterzenia poziomego.

Tabela 6.2.2 Wspétrzedne profilu NACA 0018T (ciensze wersje profilu sa uzywane w usterzeniach).

X 0] 125 25 5 75 10 20 30 40 50 60 70 80 90| 100

Yg| 0.00| 1.87( 2.83| 4.28| 5.41| 6.32| 8.46( 9.00| 8.62| 7.67| 6.44| 5.09( 3.65| 2.05| 0.00

Yd| 0.00| -1.87| -2.83| -4.28| -5.41| -6.32| -8.46| -9.00( -8.62| -7.67| -6.44| -5.09| -3.65| -2.05| 0.00
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Skorowidz

e Nazwy polecen, skroty klawiatury, podane w skorowidzu, dotyczg Blendera, o ile w hasle nie jest zazna-

czone inaczej ("(GIMP)", "(Inkscape)").

Add Layer

polecenie z menu Layer (Inkscape), 87
Add Tab

polecenie z menu przybornika (GIMP), 54
Alpha to Selection

polecenie z menu Layer (GIMP), 39, 74
Anchor Layer

polecenie z menu Layer (GIMP), 75, 76, 77, 78

B

barwa
linii (Inkscape), 91
blokowanie
zmian na warstwie (Inkscape), 86
btedny
ksztatt chtodnicy, 121
ksztatt kadtuba, 112, 121
ksztatt kotpaka ($migta), 121
ksztalt ptata, 124
Brushes
zaktadka (GIMP), 70
zaktadka formy narzedzia (GIMP), 54, 68

C

Canvas size

polecenie z menu Image (GIMP), 61
Change Foreground Color

okno edycji aktualnej barwy (GIMP), 68
chtodnica

btedny ksztatt, 121
cigciwa

profilu lotniczego, 133, 134
Clark Y

profil (lotniczy), 133
Crop to Selection

polecenie z menu Tools (GIMP), 58
Ctrl-H (GIMP), Patrz Anchor Layer
Ctrl-Z (GIMP), Patrz Undo

D

deformacja

zdje¢ (poprawianie), 113
Delete Current Layer

polecenie z menu Layer (Inkscape), 88
Delete Layer

polecenie z menu Layer (GIMP), 67
Document Properties

okno (Inkscape), 83
dodawanie

zaktadki w przyborniku GIMP, 54
nowej warstwy (GIMP), 66
nowej warstwy (Inkscape), 87

E

edycja
linii (Inkscape), 93
linii krzywych (Inkscape), 94
punktow (tryb) (Inkscape), 93, 94
elipsa
rysowanie (Inkscape), 100
Eraser
polecenie z menu Tools (GIMP), 21, 70, 74

F

F (GIMP), Patrz Free select
Sill
wypetnienie obrysu (Inkscape), 91
Fill and Stroke
panel (Inkscape), 91
Flip Horizontally
polecenie z menu Image (GIMP), 25, 30
Free Select
polecenie z menu Tools (GIMP), 29, 72

G

gabarytowy

rysunek (P-40B/C), 34
geometria

profilu lotniczego, 133
gladki

wezet (Inkscape), 95
gléwne

okno (GIMP), 51

okno (Inkscape), 81
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Gotingen
profile (lotnicze), 134
Grayscale
polecenie z menu Image (GIMP), 64
grubosé
linii (Inkscape), 91
guides
linie (Inkscape), 89
linie pomocnicze (GIMP), Patrz linie,pomocnicze
linie pomocnicze (Inkscape), 89
gumka
narzedzie w GIMP, 21, 70, 74

Import
polecenie z menu File (Inkscape), 84, 106

J

Jackiewicz, Jacek
nazwy rysunkow, 21
pochodzenie rysunkéw, 18

poréwnanie rysunkow, 44

K

kadtub
btedny ksztalt, 112, 121
kadrowanie
obrazu, 58
kolor
zmiana aktualnego (GIMP), 68
zmiana trybu (GIMP), 64, 68, 73
kolory
wlaczenie (GIMP), 64, 68, 73
kotpak $migla
btedny ksztalt, 121
kreskowanie
linii (Inkscape), 91
krzywa
odwzorowanie tuku (Inkscape), 97
styczne do (Inkscape), 94, 95

L

Layer to Image Size
polecenie z menu Layer (GIMP), 61
Layers
polecenie z menu Layer (Inkscape), 86
zaktadka (GIMP), 62
zaktadka okna gtéwnego (GIMP), 38, 64

Wirtualne modelarstwo — wersja 2.0

Lens Distrotion
filtr obrazu (GIMP), 117
linia
edycja wierzcholkow (Inkscape), 111
linie
barwa (Inkscape), 91
dodawanie wezta (Inkscape), 96
edycja (Inkscape), 93, 94
grubos¢ — zmiana (Inkscape), 91
kreskowane (Inkscape), 91
krzywe (Inkscape), 94
obrys (stroke Inkscape), 91
obrysy zamkniete (Inkscape), 90
pomocnicze (GIMP), 20, 59
pomocnicze (Inkscape), 89
proste (GIMP), 68
proste (Inkscape), 90, 93
rysowanie prostych (Inkscape), 90
styczne do krzywej (Inkscape), 94, 95
usuwanie wezta (Inkscape), 96
zamykanie obrysu (Inkscape), 90
LZw
metoda kompresji obrazu, 57

L

tuk
odwzorowanie krzywa (Inkscape), 97
Lukasik, Mariusz
nazwy rysunkow, 21
pochodzenie rysunkow, 18
poréwnanie rysunkow, 44

M

menu
przybornika (GIMP), 53
Tools (GIMP), 52

Move
polecenie z menu Tools (GIMP), 76

N
NACA
profile lotnicze, 134
NACA 2215
profil (lotniczy), 134
narzedzia

pedzel (GIMP), 68

wybor ksztaltu (GIMP), 70
wybor rozmiaru (GIMP), 70
zaktadka opcji (GIMP), 70
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nazwa

zmiana dla warstwy (GIMP), 63

zmiana dla warstwy (Inkscape), 86
nazwy

plikéw rysunkow, 21
New Layer

polecenie z menu Layer (GIMP), 66, 73
None

polecenie z menu Select (GIMP), 71, 72
nowe

warstwa (GIMP), 73

obiekt
ramka selekcji (Inkscape), 101
wylaczenie wypehnienia (Inkscape), 92
wypetienie — zmiana (Inkscape), 92
zmiana przekoszenia (Inkscape), 103
zmiana skali (Inkscape), 102
obraz
kadrowanie, 58
obrot (GIMP), 75
obrot 0 90° (GIMP), 31
okno (GIMP), 52
otworz (rastrowy w Inkscape), 84
otworz jako warstwe (GIMP), 25, 36, 64
przekoszenie (GIMP), 27, 77
przesunigcie (GIMP), 76
rastrowy w Inkscape, 106
skalowanie (GIMP), 78
usuwanie czesci (GIMP), 21, 70, 74
zmiana rozmiaru (GIMP), 61
zmiana rozmiaru (Inkscape), 83
obroét
obiektu (Inkscape), 107
obrazu (GIMP), 75
obrazu o 90° (GIMP), 31
o$ (GIMP), 75
0§ (Inkscape), 101
prostowanie rysunku, 23
obrys
profilu lotniczego, 133
okno
gtéwne (GIMP), 51
gtéwne (Inkscape), 81
obrazu (GIMP), 52
Save Image (GIMP), 56
Set Image Canvas Size (GIMP), 61
okrag

rysowanie (Inkscape), 100
Opacity
kontrolka z panelu Layers (Inkscape), 86
kontrolka z zaktadki Layers (GIMP), 62
nieprzejrzystos¢ (GIMP), 65
Open
polecenie z menu File (GIMP), 55
polecenie z menu File (Inkscape), 82
Open as Layers
polecenie z menu File (GIMP), 25, 36, 64
ostry
wezel (Inkscape), 95
08
obrotu (GIMP), 75
obrotu (Inksacpe), 101
przekoszenia (Inksacpe), 101
otwarcie
obrazu w GIMP, 55

obrazu w Inkscape, 82

P

P (GIMP), Patrz Paintbrush

Paintbrush

polecenie z menu Tools (GIMP), 68
paleta

narzedzi (GIMP), 53
pedzel

narzedzie (GIMP), 68
plany

unifikacja rozmiarow, 43
pliki

nazwy rysunkow, 21
ptat

bledny ksztalt, 124

sprawdzanie prostopadtosci, 32
pomiar

proporcji rysunku, 35
pomocnicze

linie (GIMP), 20, 59

linie (Inkscape), 89
poréwnanie

rysunkow,nawzajem, 25, 26
powickszanie

widoku (GIMP), 60

widoku (Inkscape), 85
pozostatosci

po transformacji (GIMP), 28
profil (lotniczy)

cigciwa, 133
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Clark Y, 133

geometria, 133

Gotingen (Uniwersytet), 134

NACA, 134

NACA 2215, 134

obrys gorny i dolny, 133

rysowanie, 135

szkieletowa, 133

wspotrzedne, 134
prostokat

rysowanie (Inkscape), 99
prostopadiosé

sprawdzanie dla plata, 32
prostowanie

zdjecia, 118, 119, 120
przejrzystosé

warstw (GIMP), 65

zmiana dla warstwy (GIMP), 62

zmiana dla warstwy (Inkscape), 86
przekoszenie

obiektu (Inksacpe), 103

obrazu (GIMP), 27, 77

0§ (Inkscape), 101
przeliczanie

wymiaréw samolotu, 35
przerzucenie

W poziomie, 25, 30
przesunigcie

obrazu (GIMP), 76

osi obrotu (GIMP), 75

osi obrotu (Inkscape), 101

osi przekoszenia (Inkscape), 101

widoku (GIMP), 60

widoku (Inkscape), 85
przybornik

ikon narzedzi (GIMP), 51

ikon narzedzi (Inkscape), 81

menu (GIMP), 53

okno (GIMP), 53
punktow

tryb edycji (Inkscape), 93, 94

R

R (GIMP), Patrz Rectangle select, Patrz Rectangle select
ramka

selekcji (Inkscape), 101
Rectangle Select

polecenie z menu Tools (GIMP), 58, 71

Reverse Layer Order

Wirtualne modelarstwo — wersja 2.0

polecenie z menu Layer (GIMP), 38
RGB

polecenie z menu Image (GIMP), 64, 68, 73
Rotate

polecenie z menu Tools (GIMP), 75
Rotate 90°

polecenie z menu Image (GIMP), 31
Rotate 90° CW

polecenie z menu Object (Inkscape), 107
rozmiar

zmiana dla obrazu (GIMP), 61

zmiana dla rysunku (Inkscape), 83

zmiana dla warstawy (GIMP), 61
rysowanie

elipsy (Inkscape), 100

krzywych (Inkscape), 97

linii (GIMP), 68

linii (Inkscape), 90

obrysow zamknigtych (Inkscape), 90

obszaru wyboru (GIMP), 73

okregu (Inkscape), 100

profilu lotniczego, 135

prostokata (Inkscape), 99

prostych (GIMP), 68

selekcji (GIMP), 74
rysunek

gabarytowy (P-40B/C), 34

prostowanie (obrot), 23

sprawdzanie, 20, 21

techniczny (tradycyjny), 21

wygiecie podczas skanowania, 25
rysunki

do przygotowania, 43

Jacek Jackiewicz (pordwnanie), 44

Mariusz Lukasik (poréwnanie), 44

poréwnanie,nawzajem, 25, 26

S
Save As
polecenie z menu File (GIMP), 56
Save Image
okno (GIMP), 56
Scale

polecenie z menu Tools (GIMP), 78
selekcji

ramka (Inkscape), 101
Set Image Canvas Size

okno (GIMP), 61
Shear
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polecenie z menu Tools (GIMP), 27, 77
Shift-Ctrl-M (Inkscape), Patrz Transform
Shift-E (GIMP), Patrz Eraser
Shift-R (GIMP), Patrz Rotate
Shift-S (GIMP), Patrz Shear
Shift-T (GIMP), Patrz Scale
skalowanie

obiektu (Inksacpe), 102

obrazu (GIMP), 78

srodek (GIMP), 39
skanowanie

wygiecie rysunku, 25
sprawdzanie

rysunku, 20, 21
stroke

linia obrysu (Inkscape), 91
styczne

do krzywej (Inkscape), 94, 95
symetryczny

wezetl (Inkscape), 94
szaro$ci

odcienie (GIMP), 64
szkieletowa

profilu lotniczego, 133

S
srodek
skalowania (GIMP), 39
T
Tools
menu (GIMP), 52
tradycyjny

rysunek (techniczny), 21

Transform

polecenie z menu Object (Inkscape), 102, 103

transformacja
pozostatosci (GIMP), 28
zatwierdzenie (GIMP), 75, 76, 77, 78

U

ukrywanie

zawartosci warstwy (GIMP), 63

zawartosci warstwy (Inkscape), 86
Undo

polecenie z menu Edit (GIMP), 69, 70
unifikacja

rozmiarow planow, 43

usuwanie

warstwy (GIMP), 67
warstwy (Inkscape), 88
z obrazu w GIMP, 21, 70, 74

W

warstwa
blokowanie (Inkscape), 86
dodanie (GIMP), 73
nowa (GIMP), 66
nowa (Inkscape), 87
osadzenie wyboru (GIMP), 75, 76, 77, 78
otworz obraz w nowej (GIMP), 25, 36, 64
przejrzystos¢ (GIMP), 65
ukrywanie (GIMP), 63
ukrywanie (Inkscape), 86
usuwanie (GIMP), 67
usuwanie (Inkscape), 88
zarzadzanie (GIMP), 38, 62, 64
zarzadzanie (Inkscape), 86
zmiana nazwy (GIMP), 63
zmiana nazwy (Inkscape), 86
zmiana przejrzystosci (GIMP), 62
zmiana przejrzystosci (Inkscape), 86
zmiana rozmiaru (GIMP), 61
zmien kolejnos¢ (GIMP), 38
wczytanie
obrazu rastrowego (Inkscape), 84
wezet
dodawanie (Inkscape), 96
gtadki (Inkscape), 95
ostry (Inkscape), 95
symetryczny (Inkscape), 94
usuwanie (Inkscape), 96
widok
powickszanie (GIMP), 60
powigkszanie (Inkscape), 85
przesuwanie (GIMP), 60
przesuwanie (Inkscape), 85
wierzcholek, Patrz wezet (w Inkscape)
wierzchotki
edycja (Inkscape), 111
wspotrzedne
profilu lotniczego, 134
wybor
narysowanym obszarem (GIMP), 39, 74
obszarem dowolnym (GIMP), 29, 72
obszarem prostokatnym (GIMP), 58, 71
osadzenie w warstwie (GIMP), 75, 76, 77, 78
rysowanie obszaru (GIMP), 73
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uzycie uchwytow obszaru (GIMP), 40

wylaczenie (GIMP), 71, 72
wycofywanie

zmian (GIMP), 69, 70
wylaczenie

wypelnienia (Inkscape), 92
wymiary

samolotu — przeliczanie (GIMP), 35
wypetnienie

obiektu (Inkscape), 91, 92

V/

zapisanie
obrazu GIMP, 56

zarzadzanie
warstwami (GIMP), 38, 62, 64
warstwami (Inkscape), 86
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zatwierdzenie
transformacji (GIMP), 75, 76, 77, 78
zdjecia
deformacja (poprawianie), 113
efekty uboczne prostowania, 120
problemy z analiza, 123
prostowanie deformacji, 117, 118, 119
uzycie po wyprostowaniu, 120
znieksztalcenie, 115
zmiana
przekoszenia obiektu (Inkscape), 103
skali obiektu (Inkscape), 102
zZmiany
wycofywanie, 69, 70
znieksztatcenie

zdjecia, 115
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Stownik

GPL, licencja — General Public Licence, udostepniajgca produkt za darmo wszystkim odbiorcom. Licencja ta
jest sformutowana w ten sposéb, aby uniemozliwi¢ komercyjne rozpowszechnianie produktu.

heksadecymalna, notacja liczb — sposob notacji liczb, oparty na kolejnych potegach liczby 16, a nie 10 (zapis
decymalny). Liczby od 1 do 16 sg w nim zapisywane jako: 0,1,..9,A,B,C,D,E,F. W zapisie heksadecymalnym
(szesnastkowym) ,12” = 116 + 2, czyli decymalnie 18. Podobnie liczba 4F to 4*16 + 15 = 79 decymalnie. Zapis
szeshastkowy jest szeroko stosowany przy tworzeniu oprogramowania.

material — to w Blenderze zestaw cech, uzywanych przy nanoszeniu obiektu na ostateczny obraz (renderowa-
niu). Cechy materiatu to: barwa, potyskliwos¢, tekstura, i dziesiatki innych parametréw. Z materiatem moze by¢
zwigzanych wiele tekstur (nieréwnosci, barwy), zmieniajgcych "ogolne" wtasciwosci materiatu dla pojedynczych
pikseli renderowanego obrazu.

nadir — punkt potozony na powierzchni nieba po przeciwnej stronie niz zenit. (W normalnych warunkach nadir
jest zastoniety przez Ziemie.)

rastrowy, obraz — popularna metoda reprezentacji, polegajaca na zapisie obrazu jako zbioru kolorowych lub
czarno-biatych punktéw (pikseli). Tak jest np. wyswietlany obraz na ekran telewizyjnym, monitorze komputera.
Wada reprezentacji rastrowej jest pogorszenie jakosci obrazu w duzych powiekszeniach — gdy zaczynajg byc¢
wyraznie widoczne pojedyncze piksele. Zaletg jest stosunkowo prosty algorytm wyswietlania zawartosci. Istnieje
wiele réznorodnych sposobéw zapisu (formatéw) przechowywania obrazéw rastrowych w plikach. Najpopular-
niejsze to *jpg, *.png, *.bmp, *tif.

renderowanie (ang. rendering) — w tej ksigzce oznacza tworzenie ostatecznego obrazu (lub sekwencji obra-
z6w - animacji) przygotowanej wczesniej tréjwymiarowej sceny. W pierwszych wersjach Autodesk 3D Studio
(poczatek lat 90-tych XX wieku) byto przettumaczone na polski jako powlekanie, ale ta nazwa sie nie przyjeta.

shader (ang.) — model matematyczny, stosowany do wyznaczania sposobu odbicia $wiatta przez powierzch-
nie. W Cycles shadery sg reprezentowane przez pojedyncze wezty lub grupy weziéw.

shear (ang.) — przekoszenie (okreslane takze jako "Scinanie"). Transformacja obrazu w GIMP. Przeksztatca
ksztatt prostokata w rgb (przeciwlegte boki zachowujg réownolegtosé).

tekstura — obraz (zazwyczaj rastrowy), naktadany na tréjwymiarowg powierzchnie. Stosowany w grafice kom-
puterowej do "urealniania" obiektéw (nieregularnosci barw, napisy, itp.). Zastosowanie tekstur wykracza poza
odwzorowanie barw — sg stosowane takze do zamodelowania drobnych nieréwnosci powierzchni obiektéw
(tzw. bump maps).

True Type — sposéb zapisu wzordéw czcionek, wykorzystywanych w grafice komputerowej. Metoda opracowa-
ny w latach osiemdziesigtych przez Adobe. Czcionki True Type opisujg ksztatt znakéw w sposdb wektorowy —
za pomocg wypetnionych obszaréw, ograniczonych za pomoca linii tamanych i krzywych Beziera. Dzieki temu
wygladajg poprawnie na wydruku i na ekranie — nawet w duzym powiekszeniu.

wektorowy, obraz — metoda reprezentac;ji, polegajgca na zapisie obrazu jako zbioru kolorowych linii i obsza-
réw. Kazdy element obrazu ma okreslone wspotrzedne i ksztatt (prosta, tuk, koto, krzywa Beziera, ...). W ten
sposob sg zapisywane stworzone na komputerze rysunki techniczne. Zaletg reprezentacji wektorowej jest za-
chowanie doktadnosci przy dowolnym powiekszeniu. Wadg jest ztozony algorytm wyswietlania (gdyz oznacza
przeksztatcenie na postac rastrowg). Jednym ze sposobdw zapisu danych wektorowych jest format *.svg, sto-
sowany m.in. przez Inkscape.
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wireframe (pol.: siatka?) — oznacza sposob reprezentacji modelu w ktérym nie rysowane sg zadne $ciany,
tylko krawedzie fgczgce poszczegodline wierzchotki. Jest ich zazwyczaj duzo i sg cienkimi liniami. Stgd obrazowo
w literaturze anglojezycznej taka reprezentacja jest nazywana "druciang siatkg" czyli "wireframe".
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Szczegétowe zasady udostepnienia tej publikaciji

-

L. E G A L C O D E
|. Postanowienia ogélne.
Utwor (zdefiniowany w punkcie Il. e. Licencji) jest udostepniony na warunkach niniejszej publicznej licenc;ji
(Creative Commons Public License, ,CCPL” lub ,Licencja”). Utwor udostepniany na warunkach niniejszej licen-
cji podlega ochronie na podstawie Ustawy z 4 lutego 1994 r. o prawie autorskim i prawach pokrewnych
(Dz.U.00.80.904.). Zabronione jest jakiekolwiek korzystanie z Utworu, na warunkach innych niz okreslone w
niniejszej licenciji lub prawie autorskim.
Kazdy kto w jakikolwiek sposdb skorzysta z uprawnien objetych niniejszg licencja (Licencjobiorca), w momencie
wykorzystania odwiadcza w sposdb dorozumiany, ze akceptuje wszystkie postanowienia licencji.

Il. Definicje.

"Utwor Zbiorowy" — w rozumieniu niniejszej licencji oznacza utwér, taki jak wydanie periodyczne, antologia lub
encyklopedia, stanowigcy catos$¢ sktadajgcy sie z odrebnych i niezaleznych utworéw. Dla celéw niniejszej licen-
cji utwor spetniajgcy cechy Utworu Zbiorowego nie jest uwazany za Utwoér Zalezny.

"Utwor Zalezny" — w rozumieniu niniejszej licencji oznacza utwér powstaty na bazie Utworu, lub tez Utworu i
innych chronionych prawem autorskim utwordw, taki jak ttumaczenie, reprodukcja artystyczna, streszczenie,
skrécona wersja, lub jakakolwiek inna forma w ktérej nastepuje przerobienie, przeksztatcenie lub adaptacja
Utworu, za wyjatkiem utworu ktéry spetnia cechy Utworu Zbiorowego i nie jest, dla celdow licencji, uwazany za
Utwor Zalezny. Dla unikniecia watpliwosci w przypadku utworu muzycznego synchronizacja Utworu z obrazami
wizualnymi prowadzi do powstania Utworu Zaleznego w rozumieniu niniejszej licenciji.

"Licencjodawca" — oznacza osobe fizyczng lub prawng, ktéra udostepnia Utwoér Pierwotny na podstawie niniej-
szej licenciji.

"Twérca" — oznacza osobe fizyczng, ktdra stworzyta Utwor lub osobe prawng, na ktérej rzecz powstaty autorskie
prawa majagtkowe w sposob pierwotny.

"Utwor" — oznacza chroniony prawem autorskim utwér udostepniany na podstawie niniejszej licenciji.
"Licencjobiorca" — oznacza osobe fizyczng lub prawng korzystajaca z uprawnien okreslonych niniejszg licencja,
ktora nie naruszyta uprzednio warunkdéw niniejszej licencji w odniesieniu do Utworu, lub ktéra mimo uprzedniego
naruszenia uzyskata wyrazng zgode autora na wykonywanie uprawnien przyznanych licencja.

"Uniform Resource Identifier" (URI) — oznacza internetowy adres zbioru informacji na temat zarzadzania pra-
wami w rozumieniu art. 6 pkt 12 Ustawy o prawie autorskim i prawach pokrewnych, okreslajgcego warunki ko-
rzystania z Utworu zawarte w niniejszej licencji.

lll. Dozwolony uzytek.

Zadne postanowienie niniejszej licencji nie zmierza do ograniczenia, wytgczenia lub zawezenia uprawnien wy-
nikajgcych z dozwolonego uzytku, wyczerpania prawa lub innych ograniczen praw wytgcznych podmiotu tych
praw, przystugujgcych mu w mysl prawa autorskiego lub innych znajdujgcych zastosowanie ustaw.

IV. Uprawnienia.

Licencjodawca udziela niniejszej licencji, ktéra jest licencjg nieodptatng, niewytgczng, na czas nieoznaczony,
ktorej stosowanie nie jest ograniczone terytorialnie, do korzystania z Utworu w nastepujgcy sposéb:
Zwielokrotnianie Utworu, wtgczanie Utworu do jednego lub wiecej Utworéw Zbiorowych, zwielokrotnianie Utwo-
ru jako czesci Utworu Zbiorowego,

Rozpowszechnianie zwielokrotnionych egzemplarzy lub nosnikéw, na ktérych Utwor jest zwielokrotniony, pu-
bliczne odtwarzanie, publiczne odtwarzanie drogg cyfrowg Utworu oraz Utworu jako czesci Utworu Zbiorowego.

Wirtualne modelarstwo — wersja 2.0 www.samoloty3d.pl



Rozdziat 6 Dodatkowe wyja$nienia 149

Powyzsze uprawnienia Licencjobiorca moze wykonywaé¢ na wszystkich rodzajach nosnikéw, we wszystkich
rodzajach srodkéw przekazu, oraz we wszystkich aktualnie znanych formatach. Powyzsze uprawnienia obejmu-
ja takze uprawnienie do dokonywania drobnych, technicznych modyfikacji Utworu koniecznych do dostosowania
wykonywania uprawnien do réznych srodkéw przekazu, nosnikéw lub formatow. Wszystkie prawa wprost nie
objete licencjg uwaza sie za nieudzielone, w szczegdlnosci te prawa, ktore okreslone sg w punkcie V. 4.i V. 5.
Licencji.

V. Ograniczenia.

Uprawnienia przyznane w punkcie V. licencji podlegajg nastepujgcym ograniczeniom:

Licencjobiorca moze rozpowszechniaé, publicznie odtwarza¢ Utwér, pod warunkiem dotgczenia kopii niniejszej
licenciji, lub tez Uniform Resource Identifier niniejszej licencji, do kazdego egzemplarza Utworu, rozpowszech-
nianego przez Licencjobiorce, takze w razie publicznego odtwarzania i publicznego odtwarzania drogg cyfrowa.
Licencjobiorca nie moze oferowaé zadnych uprawnierh do Utworu ani tez narzucaé zadnych ograniczen, ktore
zmieniajg lub ograniczajg warunki zawarte w niniejszej licenciji.

Licencjobiorca nie moze udziela¢ sublicenc;ji.

Licencjobiorca nie moze zmienia¢ lub usuwaé oznaczen Utworu odnoszacych sie do niniejszej licencji oraz za-
wartej w niej klauzuli uchylenia sie od odpowiedzialnosci.

Licencjobiorca nie moze rozpowszechnia¢, publicznie odtwarzaé, publicznie odtwarza¢ droga cyfrowg Utworu
przy uzyciu srodkéw technicznych pozwalajgcych kontrolowa¢ dostep lub uzycie Utworu, w sposéb sprzeczny z
postanowieniami niniejszej licenc;ji.

Powyzsze zastrzezenia majg takze zastosowanie do Utworu jako czesci Utworu Zbiorowego, przy czym nie jest
wymagane aby Utwér Zbiorowy niezaleznie od Utworu byt przedmiotem niniejszej licenciji.

W przypadku tworzenia Utworu Zbiorowego Licencjobiorca, na zgdanie jakiegokolwiek podmiotu uprawnionego,
zobowigzany jest usungé wszystkie mozliwe do usuniecia oznaczenia, o ktérych mowa w pkt. V. 3., zgodnie z
takim zgdaniem.

Licencjobiorca nie moze wykonywac zadnych udzielonych w punkcie IV. Licencji uprawnien w jakikolwiek spo-
séb, ktéry skierowany jest na uzyskanie korzysci majgtkowej lub pienieznego wynagrodzenia.

Wymiana Utworu na inne chronione prawem autorskim utwory przez wymiane cyfrowg plikéw, lub tez w inny
sposob, nie jest w rozumieniu niniejszej licencji sposobem, ktoéry skierowany jest na uzyskanie korzysci majat-
kowej lub pienieznego wynagrodzenia, tylko i wytgcznie wtedy, gdy w zwigzku z wymiang utwordw nie pobiera
sie zadnego wynagrodzenia.
W przypadku rozpowszechniania, publicznego odtwarzania, publicznego odtwarzania drogg cyfrowg Utworu, lub
Utworu Zaleznego, lub Utworu Zbiorowego, Licencjobiorca zobowigzany jest zachowac¢ w stanie nienaruszonym
wszystkie oznaczenia zwigzane z prawno-autorskg ochrong Utworu oraz zapewni¢, stosownie do mozliwosci
uzywanego nosnika lub srodka przekazu, oznaczenie:
- nazwiska Twércy Utworu;
- nazw innych podmiotéw (np. instytucji sponsorujgcej, wydawcy), jesli Twoérca Utworu lub Licencjodawca
wskazali w oznaczeniach zwigzanych z prawno-autorskg ochrong Utworu lub w warunkach korzystania
z Utworu lub w inny przyjety sposdb, te podmioty jako uprawnione;
- tytutu Utworu;
- w niezbednym mozliwym zakresie, Uniform Resource Identifier odsytajgcego do oznaczen zwigzanych
z prawno-autorskg ochrong Utworu;
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Wszystkie oznaczenia powinny by¢ uwidocznione w jakikolwiek mozliwy sposéb, przy czym co najmniej w tych
wszystkich miejscach, gdzie uwidocznione sg inne poréwnywalne prawno-autorskie oznaczenia i w sposob co
najmniej tak wyrazny jak inne poréwnywalne prawno-autorskie oznaczenia.

VL. Klauzula uchylenia sie od odpowiedzialnosci.

JEZELI STRONY NIE POSTANOWIA W ODREBNYM PISEMNYM POROZUMIENIU INACZEJ,
LICENCJODAWCA UDOSTEPNIA UTWOR W TAKIEJ FORMIE W JAKIEJ ZAPOZNAL SIE Z NIM
LICENCJOBIORCA, | NIE UDZIELA ZADNYCH DODATKOWYCH REKOJMI ANI GWARANCJI, WYRAZNYCH
LUB DOROZUMIANYCH, W TYM, W SZCZEGOLNOSCI DOTYCZACYCH TYTULU, WYKORZYSTANIA
HANDLOWEGO, PRZEZNACZENIA UTWORU DO KONKRETNEGO CELU, CO DO TEGO ZE NIE NARUSZA
ON PRAW INNYCH OSOB, BRAKU JAWNYCH LUB UKRYTYCH WAD, DOKLADNOSCI, WYSTEPOWANIA
LUB NIEWYSTEPOWANIA WAD ZAUWAZALNYCH, JAK | NIEZAUWAZALNYCH.

VII. Ograniczenie odpowiedzialnosci.

W ZADNYM WYPADKU LICENCJODAWCA NIE ODPOWIADA KONTRAKTOWO ANI DELIKTOWO WOBEC
LICENCJOBIORCY, Z WYLACZENIEM ODPOWIEDZIALNOSCI WYNIKAJACEJ Z PRAWA MAJACEGO
ZASTOSOWANIE, ZA ZADNE SPECJALNE, PRZYPADKOWE LUB NASTEPCZE SZKODY WYNIKLE Z
ZASTOSOWANIA NINIEJSZEJ LICENCJI LUB WYKORZYSTANIA UTWORU, NAWET JEZELI
LICENCJODAWCA ZOSTAL POWIADOMIONY O MOZLIWOSCI WYSTAPIENIA TAKICH SZKOD.

VIIl. Wygasniecie stosunku umownego.

Licencja automatycznie wygasa w przypadku jakiegokolwiek naruszenia jej warunkéw przez Licencjobiorce.
Licencje os6b fizycznych lub prawnych, ktére otrzymaty od Licencjobiorcy Utwér Zbiorowy nie wygasajg w takim
przypadku, o ile osoby te nie naruszajg postanowien tych licencji. Punkty Il, lll, VI, VII, VIII i IX obowigzujg nie-
zaleznie od wygasniecia niniejszej licenciji.

Zgodnie z powyzszymi postanowieniami licencja udzielana jest na czas nieoznaczony. Niezaleznie od tego Li-
cencjodawca zachowuje prawo do udostepnienia Utworu na innych warunkach, lub do zaprzestania udostep-
niania Utworu, z tym jednak zastrzezeniem, ze taka decyzja Licencjodawcy nie moze stuzyé obchodzeniu ni-
niejszej licencji (lub tez innej licencji udzielonej na podstawie niniejszej licenciji), ktéra raz udzielona Licencjo-
biorcy w pethym wymiarze obowigzuje dopdki nie nastgpi jej wygasniecie w okolicznosciach opisanych w punk-
cie VIII. 1.

IX. Postanowienia koncowe.

Za kazdym razem gdy Licencjobiorca rozpowszechnia lub publicznie odtwarza drogg cyfrowg Utwor lub Utwor
Zbiorowy, Licencjodawca jednoczesnie oferuje odbiorcom licencje dla Utworu na takich samych warunkach jakie
uzyskat Licencjobiorca niniejszg licencja.
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wiec przy monitorach i tworzyli pierwsze modele,
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